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1
Migrating to FlexNet Manager Suite

2019 R1 On-Premises

Note: This document does not cover upgrading from FlexNet Manager Suite 2014 or later to FlexNet
Manager Suite 2019 R1. For that much simpler process, see FlexNet Manager Suite 2014 Rx (or later) to
2019 R1 Upgrade Guide. Managed service providers (MSPs) undertaking a migration from a multitenant
version 9.2.3 or earlier should combine the advice in this document with specialized insights available in
Installing FlexNet Manager Suite 2019 R1 for a Managed Service.

FlexNet Manager Suite is a powerful and sophisticated tool, which has been extensively rewritten since FlexNet
Manager Platform 9.2, with a new user interface and some significant back-end changes. Therefore migration is
a significant project. Planning your upgrade is made more challenging because there are many different
configurations of the 9.2 product, each of which represents a different starting point to migrate to the 2019 R1
release. This document covers the major starting points, and includes consideration of functionality required
going forward.

This document is intended for use by:

• System engineers responsible for implementing and maintaining the system

• Network and security personnel with responsibility for infrastructure that the system relies on

• Flexera consultants implementing your system.

Assumptions: Readers have completed at least the appropriate training course in FlexNet Manager Suite
administration, and understand basic product concepts. Readers have a technical background and are
experienced with product installations and configuration.

Process Overview
When upgrading to FlexNet Manager Suite 2019 R1, there are several possible starting points, each causing
variations in the process. You may also desire a variety of possible outcomes. Having so many choices can
make a guide like this seem complicated. The following flowchart and description illustrates your choices. To
simplify further, you may wish to highlight the path through the possibilities that applies to your enterprise.
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The discussion that follows references each step in the flow chart by the numbers shown. The process outlined
here has been proven successful, and you need to follow carefully.

Important: Not shown in the flowchart is an initial backup of your database(s) and also of your existing
server(s), using your normal backup procedures. In the unlikely event that you are dissatisfied with the result
of this migration, the only 'roll back' option is to restore these backups.
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1. Upgrading — The starting point

FlexNet Manager Suite 2019 R1 is a single, integrated solution for license optimization, using a web interface
for presentation and interaction from operators. However, you may be coming to this solution from a variety of
starting points, such as:

1. FlexNet Manager Suite 2014 or later. (Since the 2014 release, FlexNet Manager Suite has been based on
web technologies for presentation.) This is a simple upgrade path, for which a simplified document is
available (see FlexNet Manager Suite 2014 Rx (or later) to 2019 R1 Upgrade Guide).

2. FlexNet Manager Platform 9.2 or earlier; or its fore-runner Compliance Manager across many different
releases. Provided that any one of these products is installed on its own (specifically, without a co-
installation of Inventory Manager on the same application server), you may migrate this product directly
to FlexNet Manager Suite 2019 R1 using this guide. If you also had a separate installation of Inventory
Manager on another server, you may choose to upgrade it as part of this project, or to consider its
upgrade separately if you wish, since earlier versions of Inventory Manager can still integrate with FlexNet
Manager Suite.

3. Any of FlexNet Manager Platform 9.2 or earlier or Compliance Manager (any version) installed on the
same application server as Inventory Manager. This is the most challenging case, as FlexNet Manager
Suite now has integrated handling of its own inventory data, and no longer requires the separate
Inventory Manager product. However, it is possible that you may prefer to preserve Inventory Manager for
some of its more fine-grained targeting capabilities.

The following discussion points clarify the issues and options around case 2 (either no Inventory Manager, or
implemented on a separate application server) and case 3 (co-installation on the same application server). (The
question of a shared database is treated separately below.)

2. Is Inventory Manager co-installed?

"Co-installed" here means that Inventory Manager and your previous compliance product were installed on the
same application server. You can usually tell whether Inventory Manager is installed with your earlier
implementation by opening the product in the MMC console. If, along with the FlexNet Manager Platform
node, you see nodes like Managed Device Settings, Discovery and Adoption, and Remote Task Manager in
the console tree on the left, then Inventory Manager is co-installed on the same server. In this case, you will
need to commission a new server (or set of servers, virtual or physical) for FlexNet Manager Suite 2019 R1
alone. Your existing combined server rolls forward as your Inventory Manager (only) server, at least for the time
being, and we will uninstall your old FlexNet Manager Platform from this server in due course.

The rare exception is that you may have Inventory Manager installed, but on a separate server (question 2A). It
will have its own MMC interface on that server with the same kind of nodes in the console tree (but not the
FlexNet Manager Platform node). When Inventory Manager is separately installed like this, you may choose
whether to:

• Defer any upgrade of the Inventory Manager product to a separate project that you will tackle later. In this
case, go directly to step 5.

• Include the upgrade of Inventory Manager in this same project, as documented here. In this case take steps
3 and 4.

If you do not have any implementation of Inventory Manager, your decision tree is simplified, and you race
ahead to step 7 (down the N exit from step 2a).

Details: Identify and Update Inventory Manager Server.

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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3 and 4. Ensure that Inventory Manager is up-to-date.

For the upgrade process, the scripts to assist your process with database separation and clean-up are based on
the schema at 9.2.3. For that reason alone, you need to have Inventory Manager up-to-date before proceeding.

Also from a business perspective, if you plan to carry forward with Inventory Manager as an inventory source
feeding your system (an option we discuss later), you are likely to use release 9.2.3 of Inventory Manager, since
it has additional functionality particularly in relation to Oracle inventory gathering. So it will be convenient to
complete this upgrade as part of the same project.

For these reasons, there is summary guidance for upgrading Inventory Manager included in this document (see
Identify and Update Inventory Manager Server). If you want further information, use the Upgrade Guide
installed with the 9.2 product to guide you.

Once you have done that, you are at the baseline to commence the upgrade to FlexNet Manager Suite 2019
R1.

5. Do both products share a single database?

If, in step 2, you identified that your products were co-installed on the same server, then you do have a shared
database as well, so your answer here is Y.

If you have separate application servers, you may still have them sharing a common database. You could ask
your DBA, or you can check a registry key as described later. Details: Identify and Update Inventory Manager
Server.

The upgrade process requires that a shared database is first split into two. One database is preserved for on-
going operation of Inventory Manager. The other can be upgraded to FlexNet Manager Suite 2019 R1.

Tip: The minimum supported database release is Microsoft SQL Server 2008. You'll also notice that the new
product requires two or three additional databases that were not present in the 9.2 release (typically on the
same database server).

If you are sure that your previous implementation already had separate databases (and on a supported version
of SQL Server), you can skip forward to step 7.

6. Split the databases

Separating the databases is required for the migration process. As well, since you may want to continue with
Inventory Manager functionality for some time, splitting the databases allows for one copy to migrate up to
FlexNet Manager Suite 2019 R1 while the other continues for Inventory Manager. You achieve this by:

• Doing a backup of your current joint database

• Doing a restore to make a second copy with a new name

• Running the scripts provided to clean out from each database the content belonging to the 'other' product.

Details: Splitting a Shared Database.

7. Upgrade your compliance product to FlexNet Manager Suite 2019 R1
If your earlier implementation had two separate servers for your compliance product and for Inventory
Manager, you can apply the software upgrade to your compliance server directly.
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In contrast, if you previously had a single server hosting both compliance and inventory, you now commission
a new application server and install FlexNet Manager Suite 2019 R1 as a fresh installation. (Details are provided
for planning your new implementation.) You can also uninstall the old compliance product from the previously
combined server, which now becomes your Inventory Manager server.

In both cases, you also install an inventory beacon on your central application server. This 'home base'
inventory beacon allows you to continue managing the compliance connections recorded in your database in
your previous implementation. (Inventory beacons on separate servers cannot access legacy connections that
were migrated from your 9.2 Inventory Manager database into your FlexNet Manager Suite 2019 R1 database.
Only the local inventory beacon has database access.)

Full details for this step are included in the chapter Upgrading FlexNet Manager Suite.

8. Roll out your inventory beacon hierarchy

Your old Inventory Manager product possibly used a hierarchy of distribution servers to send out packages and
upload inventory collected by inventory agents installed on managed devices. (Around release 9.0, the
distribution servers were renamed inventory beacons; but to avoid confusion in this document, we will
continue to call them distribution servers.)

Inventory beacons supplied with FlexNet Manager Suite 2019 R1 are completely re-architected, and you should
roll out a new hierarchy of 2019 R1 inventory beacons on separate machines (which can be virtual machines if
you so choose).

Note: Inventory beacons for 2019 R1 are not compatible with earlier distribution servers (including those for
9.2 or later that were called inventory beacons), and cannot coexist on the same computer.

Exactly how you do this depends on your strategy, decided in the following steps. For example, if you want the
fastest possible automated switch-over, you simply replace the distribution server software with FlexNet
Beacon software, as described in more detail in step 12.

Your alternative strategy involves parallel operation of 9.2 inventory gathering with 2019 R1 inventory beacons.
Since these cannot exist simultaneously on the same server, parallel operation requires that you roll out a
parallel machine hierarchy.

Keeping both the old distribution server hierarchy and the new inventory beacon hierarchy operational in
parallel allows for an orderly transition. Later, if you decide to move away from Inventory Manager, you can
decommission and re-purpose the former distribution servers.

Details: Managing Device Migration by Individual Device.

9. Using solely Inventory Manager 9.2 for FlexNet inventory collections?

Broadly, you need to decide what functionality from Inventory Manager you want to preserve, and for how
long. FlexNet Manager Suite 2019 R1 deliberately simplifies management of FlexNet inventory agents on target
devices. Consider this functionality comparison:

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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Inventory Manager 9.2 FlexNet Manager Suite 2019 R1

Choose between client-side policy merging and
server-side policy merging. (Client-side policy
merging was more commonly used for deployment
activities. Any managed devices relying on client-side
policy merging must continue to be managed under
Inventory Manager 9.2.)

Only server-side policy merging is supported (as
appropriate for gathering inventory), and is the
required setting for all FlexNet inventory agents
managed under this system.

Manually configure settings packages for inventory
agents.

Settings are determined automatically, based on
behavioral rules you create.

Manually deploy settings packages to managed
devices.

Inventory agents (on inventoried devices) are
updated automatically.

Create multiple schedules for inventory agents and
data upload.

All FlexNet inventory agents share a single schedule
for local inventory gathering, and there is one
schedule for discovery across the network (but there
are individual schedules for importing inventory data
from each third party system, and for importing each
kind of business data like purchases).

Ability to run custom remote execution commands. Only the specific remote execution tasks required for
inventory are available.

Manually identify target computers for adoption as
managed devices.

Option to automatically install an inventory agent on
any computers that are discovered (and do not
already have an agent installed). This rule-based
'adoption' can be targeted to individual machines or
to subnets.

By comparing product functionality with your requirements, you need to decide whether to:

• Persist with Inventory Manager 9.2.3, using it as an inventory feed into FlexNet Manager Suite 2019 R1, and
not using the FlexNet inventory gathering features in FlexNet Manager Suite 2019 R1 at all. You are
preserving Inventory Manager functionality, shown in the left-hand column above, across your entire
computing estate. This means you are done, and take the Y exit from step 9 to leap forward to the finish line
at step 16. (Otherwise you take the N exit and continue with step 10.)

• Switch entirely to the simplified native inventory gathering incorporated in FlexNet Manager Suite 2019 R1,
using the new rule-based approach. You plan to enjoy the simplified management in the right-hand column
above. You need to make the choice described for step 10 to work out how you will handle this.

• Combine the systems, using distinct features of each in those parts of your enterprise for which they are
best suited. (Technically, this is like the switch-over scenario, except that you make the transition period of
indeterminate length.) You might, for example, use Inventory Manager to manage a set of machine-room
servers for which you demand individual scheduling and custom configurations of the inventory agent;
whereas you might prefer the simplified management of FlexNet Manager Suite 2019 R1 for things like
management or desktop and mobile devices. The current migration process makes it practical to isolate
parts of your present infrastructure for upgrade, and protect other parts to continue with the old system.
Nothing in the process sets a time limit on this kind of parallel operation. Of course, if you plan to extend
this parallel operation, you should consider the impact on other corporate processes, such as acquisition of
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new machines and how these should be targeted for adoption by one system or the other. In the meantime,
if considering parallel operation, you should also continue with both steps 10 and 11 for the appropriate
parts of your environment that are to be migrated to 2019 R1.

10. Migration can be controlled at the level of subnets

This choice is about how much individual control you want over the migration of your computing estate (or
parts of it, if you are mixing the approaches) from the old system to the new system. The simple path is to have
control at the level of each subnet. Particularly if you have first tested the migration in a test environment,
migrating a subnet at a time may represent a good balance of control with resourcing and time. If subnet
granularity is not sufficient for your needs, you can have control that extends down to the level of each
individual device if necessary. The following table clarifies the differences between these two levels of control.

Functionality/tasks Control migration by subnet Control migration by device

Server deployment Deploy aninventory beacon into each
subnet as you target that subnet.
(Because you process a subnet at a
time, a server previously used as a
distribution server in the old system
can be re-purposed as an inventory
beacon in the next subnet. The total
number of servers required is the
number of subnets + 1.)

Deploy inventory beacons in a parallel
hierarchy so that managed devices
can operate through the 9.2
distribution server hierarchy today
and gradually switch over to the new
2019 R1 inventory beacons as they
are updated. In general, this approach
requires as many new inventory
beacons as you have old deployment
servers. (It is not possible to co-install
the FlexNet Beacon software on a
server running the deployment server
code.)

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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Functionality/tasks Control migration by subnet Control migration by device

Migration mode setting Not required; but may be used as a
"starter's gun" to commence migration.
Must be clear (not checked) for this
migration method to proceed. At any
time that migration mode is set,
devices connecting to 2019 R1
inventory beacons successfully report
inventory results through those
inventory beacons into the new
FlexNet Manager Suite database; but
they do so using their settings current
at the moment that migration mode
was disabled (in other words, if they
switch over while migration mode is
disabled, they use settings obtained
from the 9.2 system). Only after the
migration mode is turned off do they
receive an updated policy which aligns
them with the settings in the 2019 R1
version of FlexNet Manager Suite (the
policy updates generally occur within
about 15 minutes of migration mode
being turned off).

Must be selected (checked). In
migration mode, devices must be:

• Already upgraded to the 2019 R1
client

• Identified in a target used to
control migration.

Those managed devices that do not
meet these requirements receive a
404 "Not found" error when they
access a DL on a new inventory
beacon, and fail over to an existing
distribution server.

Once the migration is sufficiently
advanced, you may have sufficient
confidence to allow "all the rest" to
migrate at once, At this point, you
may turn off migration mode. When
this is off, all devices that access the
DL on an inventory beacon receive
their new policy and switch over
(irrevocably) to the new system.

Updating managed
device (agent) version

Choose whether to:

• Update managed devices before
they migrate (permitted, but not
required)

• Allow the 2019 R1 system to
automatically update clients to the
level you specify as part of their
automated migration.

You must upgrade all targeted
managed devices (using your 9.2
technology) before they can be
migrated to the new system. If any of
these managed devices previously
used client-side policy merging, they
must be switched to server-side
policy management before the
upgrade.

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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Functionality/tasks Control migration by subnet Control migration by device

Preparing the managed
devices

No preparation of the 9.2 devices
required.

In addition to the update of the agent
software on all migrating managed
devices, you must decide how these
device are encouraged to try getting
policy from the DL on an inventory
beacon:

• If you do nothing, the final built-in
step in the netselector algorithm (a
randomization across the DLs
available to this device, for load
sharing) causes (on average) an
equal share of managed devices to
attempt the connection to the DL
on the inventory beacon at each
policy request. (For example, if you
have a distribution server and an
inventory beacon accessible in a
subnet, on average 50% of devices
access each of the two servers at
each policy request.) By design, of
course, this randomization is not
deterministic, and is generally not
adequate to ensure that every last
device migrates in a reasonable
time frame.

• Using the 9.2 system before
devices switch over, you can deploy
a device settings package that adds
the MgsInventoryBeaconMatch

netselector algorithm to the
updated devices. This addition
ensures that all devices prioritize
the new inventory beacons above
all old distribution servers, ensuring
that every managed device
attempts to connect to the DL on a
new inventory beacon. (The
response each gets is still
determined by the setting of
migration mode and the targeting
for migration.)

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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Functionality/tasks Control migration by subnet Control migration by device

Preparing the 9.2
distribution system

No preparation of the 9.2 system
required.

For each distribution server in your
9.2 hierarchy:

• Declare an additional download
location (DL) in the MMS 9.2
interface.

• This new DL must use either the
HTTP or HTTPS protocol (other
protocols supported by 9.2 cannot
be used in this case).

• Configure the URL setting for this
DL (even though it is being
declared on a 9.2 distribution
server) so that it points to the
download location on the parallel
inventory beacon that managed
devices are able to access after
they migrate.

This download location acts as a
"double agent" or "mole": it is
specified in 9.2 so that the clients
reporting to 9.2 may find it; but when
contacted for policy updates, it
admits only updated and targeted
devices to the 2019 R1 system (all
others fail over to existing distribution
servers). Once provided with a 2019
R1 policy, devices cannot switch back
to the 9.2 system.

Trigger migration Within each subnet, start migration
simply by changing the DNS alias that
currently points to the local
distribution server to point instead to
the local inventory beacon. (If you were
not previously using a DNS alias to
point to the distribution server, create
one now. It's best practice.) All
managed devices that access the new
DL on the inventory beacon are
updated with their 2019 R1 policy
(subject to migration mode being off,
as described above).

When migration mode is on, and
managed devices have been updated,
declare a target in the web interface
for FlexNet Manager Suite 2019 R1
that includes those devices you want
to switch over. At the next policy
update cycle, targeted devices get
their policy update and commence
reporting to the new system. You can
then repeat the process of declaring a
new target for the next set of devices,
and waiting for these devices to
update their policies.

Migrating to FlexNet Manager Suite 2019 R1 On-Premises
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Functionality/tasks Control migration by subnet Control migration by device

Roll back If roll back is required for any reason in
any subnet, simply switch the DNS alias
back to the 9.2 distribution server. All
devices revert to the old server, and
receive a policy 'update' that reverts
them to their previous settings.

Not available.

For those areas where you will control migration by subnet, read on in step 12. For areas where you choose to
control migration down to the level of individual devices, read on at step 11.

11. Upgrade agents on managed devices to 2019 R1
Use your existing 9.2 Inventory Manager system to upgrade managed devices to the inventory agents supplied
with FlexNet Manager Suite 2019 R1. A package is provided to assist with this.

• If you are eventually migrating your entire estate away from Inventory Manager 9.2, you can upgrade
managed devices indiscriminately if you wish, since the new inventory agent is backward compatible with
the 9.2 Inventory Manager system, and continues to operate through the 9.2 distribution server hierarchy for
the time being.

• If you want parts of your estate (perhaps server rooms) to continue indefinitely under your 9.2 infrastructure,
methods are provided where you can exclude target machines from this upgrade. For example, you can use
an existing security group that identifies these machines (or create a Legacy security group) as an

'exclusion' from the upgrade process.

The upgrade package also updates the managed devices to use the MgsInventoryBeaconMatch netselector
algorithm to recognize and prioritize the inventory beacon(s) deployed with FlexNet Manager Suite 2019 R1,
alongside their existing fail-over list of the old distribution server hierarchy. In migration mode, the inventory
beacons do nothing for unknown devices, and so each manage device calls the inventory beacon, gets nothing,
and fails over to its preferred 9.2 distribution server and continues normal operation in your existing
infrastructure — until notified otherwise!

Important: Managed devices upgraded to the 2019 R1 inventory agent must first be switched into server-
side policy merging.

Details: see Prepare Managed Device Self-Upgrade Package and Distribute Self-Upgrade and Settings
Packages. Now, for these devices, skip to step 13.

12. Switch each required distribution server to an inventory beacon
Include this step only if, at step 10, you chose to migrate (parts of) your computing estate with control at
subnet granularity.

The 'subnet switch-over' approach relies on you exchanging the distribution server within the subnet for an
inventory beacon. (If the subnet contains multiple distribution servers, switch all at the same time to prevent
managed device toggling back and forth as they randomly access different servers.) The server types must be
switched because all your 9.2 managed devices have a local record of the distribution server(s) they can access.
If your migration process 'drops' a distribution server instead of replacing it with an inventory beacon, all
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managed devices that can access only that distribution server are thereby orphaned. You can only recover
those orphans by visiting each one and manually upgrading and redirecting them. You avoid any nasty
surprises simply by doing an in place switch of each distribution server to an inventory beacon. There are two
ways you can achieve this:

• (Strongly recommended.) Use a DNS alias to redirect all requests for the distribution server to the inventory
beacon. Inventory and other uploads instantly switch to the new system. Provided that migration mode is
off, the next cycle of policy updates see all agents updated with their new policies (including all rules
relevant to their assigned subnets and the like). For as long as you maintain the original distribution server in
place, you have an easy roll-back option available if required: simply redirect the DNS alias back to the
distribution server.

• You can do an in-place replacement of the distribution server software with the FlexNet Beacon software
(these two cannot be installed on the same server at the same time). As part of this exchange, you preserve
the same IP address and DNS entry. However, this approach does not provide an easy roll-back option (to
roll back, you would need to uninstall the new software and re-install the old).

Once the inventory beacon is in place (and migration mode is off), as each managed device calls for its latest
policy, it is automatically updated to the latest approved managed device software, and given the policy
needed for the new FlexNet Manager Suite 2019 R1 system. After a decent interval to ensure that all managed
devices (even the notebooks carried by road warriors) have been updated, you arrive at step 16.

13. Target managed devices for staged migration to the new system

You already have [at least some of] your inventory beacons rolled out, and the [selected] managed devices are
ready to connect with those inventory beacons. Now, in your web interface for FlexNet Manager Suite 2019 R1,
you create a rule for a small target group of devices to manage through those inventory beacons. This group
can be as small as one in the first instance, until you satisfy yourself that everything works as expected. For
details about targeting from the Inventory Manager side, see Targeting the Inventory Agent Upgrades and
Migration.

Each upgraded managed device, when it next 'phones home', tries to connect to an inventory beacon as top
priority. As already noted, in migration mode the inventory beacon rejects any devices that are not specified in
its target, and those rejected devices fail over to the existing hierarchy of distribution servers, and continue
operations under 9.2 as always. When the pilot device(s) contact the inventory beacon, they are automatically
issued a new policy that switches them out of the distribution server hierarchy, and into the inventory beacon
hierarchy. From the next scheduled inventory collection, these devices start reporting their inventory directly to
FlexNet Manager Suite 2019 R1. For details of targeting from the FlexNet Manager Suite side, see Create a
Roll-out Target.

At this early stage, be very detailed in assessing the behavior of the pilot managed device(s). It is still possible
to roll back to the 9.2 system, but this becomes more time-consuming as more devices migrate. As a
protection against accidental regression, the system does not normally allow a device reporting through
FlexNet Manager Suite 2019 R1 to switch back to Inventory Manager, and over-riding these safeguards
required direct intervention.

14. Loop until done

You can continue to target pilot devices at any level you choose so that groups of managed devices are
switched progressively into the new system. If you were conservative about your rule targeting, you can
continue to expand the targeting until it includes all desired managed devices. When you are satisfied with
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progress, you can switch to operations mode, so that any managed device attempting to contact the inventory
beacon is now switched over. (Note that the devices in the Legacy security group never come knocking on an
inventory beacon, but continue operating as part of your Inventory Manager infrastructure, unaffected by the
changes.) There is a single check box that switches from migration mode into operations mode, which
automatically welcomes all remaining visiting devices into management by FlexNet Manager Suite 2019 R1.

15. Decommission or re-purpose redundant Inventory Manager servers

When you are satisfied that all the managed devices previously reporting to a given distribution server have
begun reporting into FlexNet Manager Suite 2019 R1, you can decommission that distribution server (by
uninstalling the DS software). If desirable, you might re-purpose this server hardware to become your next
inventory beacon, rolling it into the migration process back at step 8. Eventually, if you are not preserving any
Inventory Manager 9.2 functionality, even your central inventory server may be re-purposed.

16. Done!

Your new FlexNet Manager Suite 2019 R1 system is fully operational, with (optionally) some parallel use of
Inventory Manager 9.2.3 for specialized management of inventory agents with specialized schedules or custom
configurations. A final topic highlights a few manual clean-up actions (see Finishing Off).

Design the Final Topography
Whereas in release 9.2 or earlier, Inventory Manager and FlexNet Manager Platform (or earlier compliance
product) might be installed on a single server (and so thought of as 'combined'), it is important now that you
approach migration thinking of completely separate products. In particular, it is vital to mentally separate two
ways of handling inventory:

• FlexNet Manager Suite 2019 R1 has its own direct inventory-gathering capacity (and may require a separate
"inventory server" to handle this); but as outlined in Process Overview, this is completely independent of the
9.2 Inventory Manager product.

• You may also wish to continue operation of the 9.2 Inventory Manager solution (always referred to a
Inventory Manager in this document) as a separate inventory source for import into FlexNet Manager Suite
2019 R1. If you do this, Inventory Manager is "just another inventory source" along with Microsoft SCCM and
any other inventory sources you may use.

At this stage of the design, the focus is entirely on the implementation of FlexNet Manager Suite 2019 R1,
independent of Inventory Manager. So proceed now to design your FlexNet Manager Suite 2019 R1
implementation.

Determine whether to implement a single server or multi-server solution, based on projected scaling. Please
refer to the following diagram, where each blue box represents a potentially separate server, and where all are
given the names referenced throughout this document.

Note: Both the inventory server (or in smaller implementations the processing server, or the application
server in a single-server implementation) and the inventory beacon(s) are expected to be members of Active
Directory domains. (For test environments, consultants may see article 000017145 How to run FlexNet
Manager Suite processing server on a workgroup computer.) If you implement a multi-server solution
(separating the web application server, the batch server, or the inventory server), it is strongly recommended
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that all are members of the same Active Directory domain.

There are six different kinds of server functionality in FlexNet Manager Suite. Your implementation may merge
all this functionality onto a few servers; or for very large implementations, you may need six or more separate
(virtual or physical) servers. In all cases, it is important to understand the functionality of these separate
components that make up a working system:

• At least one inventory beacon, and typically more for a complex infrastructure

Tip: When you are migrating from 9.2 or earlier, it is mandatory to install an inventory beacon on the
batch server (defined shortly). This inventory beacon (alone of all beacons) has access to the database,
where migrated connections are stored.

• An inventory server, which can also be duplicated across multiple servers if you are gathering FlexNet
inventory for many tens of thousands of devices (see below)

• One (and only one) batch server (also known as a reconciliation server) that imports third-party inventory,
integrates FlexNet inventory, incorporates business-related information, and reconciles everything to
calculate your license position

Tip: Currently MSMQ limits the hostname of the batch server to 15 characters (excluding the domain
qualifier).

• The database server (where the five underlying databases may also be split across separate database servers
if required)

• The web application server that handles presentation of the interface

• A server for the business reporting option (powered by Cognos), where applicable.

Tip: If the Cognos content store is installed on an SQL Server installation later than 2012, it should be run
in SQL Server 2012 compatibility mode.

Tip: If you previously had separate servers for FlexNet Manager Platform and Inventory Manager, you can
start with your FlexNet Manager Platform server and upgrade it to the new system, where it can function as
any of the servers described above (or indeed, for the combined servers as described next, if yours is a smaller
implementation). Similarly, if you had a separate database server in your previous implementation, that same
database server may host the new databases shown in the diagram.

All system servers require a 64-bit operating system. The database server (alone) may have a 32-bit operating
system, but a 64-bit operating system is recommended.

In more moderately-sized implementations (the vast majority), a typical implementation might have a separate
database server and Cognos server, and combine the remaining three central functions as a single "application
server", as shown in the diagram. As scaling dictates, you can combine or separate the web application server,
the batch server, and the inventory server in any combination required. The logical separation of presentation
from processing need not drive hardware requirements. Scaling considerations may include the following:

• Typically the first candidate for replication is the inventory beacon. This is often driven by network
considerations as much as by simple scaling considerations.
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• If your system manages more than 50,000 devices reporting FlexNet inventory alone (ignoring for the
moment inventory through other third-party tools), the inventory server should be separated onto its own
device. You can expect to duplicate a separate inventory server for (roughly) every 50,000 devices reporting
FlexNet inventory.

• If you manage inventory from more than 100,000 devices, the batch server (or reconciliation server) may be
separated from the web application server and installed separately.

Tip: When you implement your web application server as a separate server, you must configure one or two
network shares that all servers can access to share uploaded data between them. The shared drives are
identified during the installation process. For details, see Configure Network Shares for Multi-Server.

The diagram shows that:

• FlexNet inventory (from the FlexNet inventory agent) is uploaded to the inventory database by the inventory
server, and then separately imported to the compliance database

• Third-party inventory imported from other tools is loaded by the batch server and stored directly in the
compliance database

• Some time-based data is copied to the data warehouse database, and reports may combine trend data from
here with current data from the compliance database

• Some data is copied to the snapshot database to improve presentation performance

• The web interface automatically displays a mixture of data from the snapshot database and the compliance
database, as appropriate; and data manually input through the web interface is written back to the
compliance database

• While Flexera Analytics can be installed on your application server, for performance reasons Flexera Analytics
is best installed on a separate server (it has high memory use requirements).
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Note: All servers shown inside the data center should be within a single time zone. This is particularly
important if you are using Flexera Analytics, since the Flexera Analytics Operational Dashboard combines
time-based data from the database server(s) and the Cognos server.

Your previous combined server

If your previous implementation had FlexNet Manager Platform and Inventory Manager co-installed on the
same server, you should plan for this server to roll forward as your Inventory Manager 9.2.3 implementation.
This path minimizes disruption. Even when you are planning eventually to decommission Inventory Manager
and rely entirely on the functionality in FlexNet Manager Suite 2019 R1, plan for this server to continue
operations through the transition period.

Choose your web servers per device

Web protocols are used for data transfer within the FlexNet Manager Suite infrastructure. Two alternatives are
supported, and can be mixed and matched within the infrastructure of inventory beacons and servers:

• Microsoft IIS. Choose this alternative when any of the following apply:

◦ The host server is one of your central application servers (web application server, batch server, or
inventory server, or combinations as applicable). No web server is required on a stand-alone database
server. When you install the recommended inventory beacon on the same device as the central batch
server, that beacon also uses IIS (whereas other free-standing beacons on separate devices still have a
choice).

◦ When a particular inventory beacon is collecting inventory from (and passing back recommendations to)
FlexNet Manager for SAP Applications, that inventory beacon must use IIS.

◦ When you require Windows Authentication to allow transfer of data (for example, a parent inventory
beacon might typically use Windows Authentication if it receives data from a child in your DMZ outside a
firewall).

◦ When you require the use of the HTTPS protocol to encrypt data transfers.

• FlexNet self-hosted web server. Choose this alternative when none of the previous cases apply, and:

◦ You want simple administration of the web server.

◦ You want to minimize the installations on your inventory beacon, so that you do not need to install
Microsoft IIS.

◦ Anonymous access, and use of the HTTP protocol, are adequate (for example, within your secure LAN).

Note: After installation, more information about these web server options and how to configure them is
available in the online help under Inventory Beacons > Local Web Server Page > Configuring Direct
Inventory Gathering.

Placement of inventory beacons

For more details about placing inventory beacons within your network, see Considerations for Inventory
Beacons.
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Output

Prepare a block diagram of the actual servers for your implementation. Start with the central collection of
servers, depending on the scale of your implementation.

Don't forget the inventory beacons you intend to deploy. You should include an inventory beacon on your
batch server (or processing server, or application server, depending on your scaling decisions), as this is a
requirement to carry forward management of connection strings that were set up previously on your old
Inventory Manager system. Thereafter you may choose to deploy a hierarchy of inventory beacons (perhaps
mirroring your hierarchy of distribution servers used in your old system), ensuring that every targeted device
will have access (preferably high-speed LAN access) to an inventory beacon. One or more of these inventory
beacons may be used for 'bootstrapping' your managed devices that attempt to switch over to the new
system.

Label each block in your diagram with:

• The server type, either 'inventory beacon' or as named in the diagram above (for ease of reference in
following instructions)

• The actual server name and IP address

Tip: Keep in mind that an underscore character is not valid in a host name referenced by a DNS. If you
have a host name that includes an underscore, you may need to set up a DNS alias for the server; or else
use its IP address during the installation process.

• Which web server will be installed on each of these hosts

• For inventory beacons, whether they will be used for bootstrapping.

Tip: The DNS name and IP address of the inventory beacons used for bootstrapping must be known in
advance of the inventory beacons themselves being deployed in the processes that follow.

Add to this diagram the additional server(s) being rolled forward for Inventory Manager 9.2.3 (either in the
transition period, or longer term).

Additional details will be added later.

Considerations for Inventory Beacons
The inventory beacons in your network may be arranged in ways that meet your requirements. For example:

• You may use a flat arrangement where each inventory beacon communicates directly with the central
application server

• You may arrange them in a hierarchy, where the top-level inventory beacon(s) communicate with the
central application server, and further inventory beacons are arranged as 'children' that communicate with
the inventory beacon(s) above them in the hierarchy.

There are no formal limits to the structure of this hierarchy. It may contain as many levels as you require.
However, good network design typically means that your hierarchy has two or three (or rarely, four) levels.

The following considerations should assist in your network planning.
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Fan-out

These are general guidelines. You should adjust expectations based on experience in your own environment:

• Provide one inventory beacon for every 20,000 (or so) devices with the locally-installed FlexNet inventory
agent. In general, policy downloads, and inventory and usage file uploads, place negligible demands on
CPU, memory and disk space on the inventory beacon. However, you may be constrained by other network
throughput limitations, and by factors such as network proximity of the installed FlexNet inventory agents
to at least one local inventory beacon. Here are some typical network load figures per device interacting
with an inventory beacon:

Task Network load

Inventory upload 10-200 KB per upload (low range for desktops and the like, higher
range for UNIX-like servers)

Usage file uploads 5-20 KB per day (or zero when you are not tracking usage)

Policy update 10-100 KB per policy update (only occurs when policy is changed)

Remember: You cannot specify particular allocations of devices to inventory beacons: the FlexNet
inventory agent is a state-based tool that manages itself to match its downloaded policy, and as part of
its self-management, it chooses which inventory beacon to use for data uploads and policy downloads.
The default algorithm looks first for an inventory beacon in the same site as the inventory device, then for
the best ping response time, with a randomizing tie-breaker. Therefore the above guideline is about the
quantitative planning; and you should use other factors to determine the placement of inventory beacons.
These other factors include your network topology, including placement of firewalls, or having multiple
domains without cross-trust, and the like. Any isolated subnets or the like require a dedicated inventory
beacon so that all installed FlexNet inventory agents have full network access to at least one inventory
beacon.

• An inventory beacon may also gather inventory from other systems, such as importing inventory gathered
by Microsoft SCCM or IBM's ILMT ('third-party inventory'). Since you control the schedule for the collection
of third-party inventory, you can stagger the times for different kinds of inventory; and a result, one
inventory beacon can easily handle multiple third-party inventory sources.

• Similar considerations apply to the collection of any business information through an inventory beacon.
Arrange the schedules for business importer operations to spread the load on the relevant inventory
beacon.

• If you are arranging a hierarchy of inventory beacons in a very large system, you should limit the fan-out
from a parent inventory beacon to less than 100 child inventory beacons.

Minimum of one per subnet

It is best practice to deploy at least one inventory beacon into each separate subnet that contains target
devices for which you may want an inventory beacon to execute discovery and inventory gathering. Being
within the target subnet allows the inventory beacon to reliably use ARP or nbtstat requests to determine
the MAC address of a discovered device (reliability of these results is reduced across separate subnets). If you
do not place an inventory beacon in each subnet:

• It is possible that, across subnet boundaries, only an IP address can be found for a device (that is, the
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device data is missing both a MAC address and a device name).

• In this case, a central record is created for the discovered device, but because IP addresses may be dynamic
(unreliable identifiers), this record is not matched (or merged) with more complete records (those which
also contain either or both of the MAC address and a device name).

• As a consequence, on data import you may produce multiple discovered device records with duplicate IP
addresses:

◦ One record may be complete (for example, automatically created by FlexNet Manager Suite from
inventory when it could not find an existing, matchable discovery device record to link to the inventory
device record)

◦ One or more others may be discovery records that are missing identifying data as discussed.

• Since these complete and incomplete records cannot be merged automatically, you are left with a manual
task to clean up the incomplete duplicates.

• What's worse, even after that manual clean-up, if the situation persists and an applicable discovery rule is
re-run, the incomplete record is recreated.

You avoid all these risks by simply having a local inventory beacon in the same subnet as target devices. Being
in the same target subnet means that the inventory beacon can provide both the IP address and the MAC
address, which is sufficient for matching discovered device records. If you must do discovery across subnet
boundaries without a local inventory beacon, ensure that there are full DNS entries visible to the inventory
beacon for all devices you intend to discover. This allows the inventory beacon to report both an IP address
and a device name or fully-qualified domain name (FQDN), which combination is again sufficient for record
matching.

Bridging to IPv6 subnets

All inventory beacons can operate within subnets configured to use either IPv4 or IPv6 addressing; and
FlexNet inventory agent can also handle all data transfers within either environment. However, the link to the
central application server must use an IPv4 network protocol. The need to support the IPv4 protocol at the
top level of the architecture, and the IPv6 protocol at the low level with the local FlexNet inventory agent,
means that at least one inventory beacon must be a dual-stack server that provides the bridge between the
two protocols, as shown in the following architectural sketch:
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Reading from top to bottom, this sketch shows:

• Your application server (or in larger implementations, multiple servers) continue(s) to support HTTP or
HTTPS communications over an IPv4 network layer.

• Within IPv4 zones of your network, you may deploy as many inventory beacons as required, either as a flat
layer where each communicates directly with the application server, or in a hierarchy, as dictated by your
network requirements. Of course, these inventory beacons provide full functionality, supporting all forms of
FlexNet inventory gathering from target inventory devices within the IPv4 network (for simplicity, these
devices in the IPv4 zone are not shown in the sketch above).

• At least one inventory beacon must be a dual stack device that supports both IPv4 and IPv6 network layers.
It does not matter whether this is achieved using two Network Interface Cards (NICs) or a single
configurable NIC. The IPv4 interface links upward to its parent (whether that be to another inventory
beacon in the hierarchy or directly to the application server). The IPv6 interface links downward to those of
its child devices that are in the IPv6 zone (of course, other devices in the IPv4 network could also
communicate through this inventory beacon, given its dual stack architecture). As shown, these IPv6
children may optionally include a further hierarchy of inventory beacons (which child inventory beacons
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would then be operating entirely within the IPv6 network).

• Eventually, target inventory devices within the IPv6 zone that have locally installed FlexNet inventory agents
communicate with at least one inventory beacon in the same zone; or where the lightweight FlexNet
Inventory Scanner has been run on a target device, this can also communicate with the inventory beacon.

There are further restrictions and requirements to add to these general sketches:

• All inventory beacons operating within an IPv6 network (whether as single-stack IPv6 devices or dual-stack
IPv4 and IPv6 devices) must utilize Microsoft IIS as the web service. The simple alternative self-hosted web
server does not support the IPv6 protocol.

• Inside an IPv6 network, an inventory beacon cannot import Active Directory details. However, a dual-stack
inventory beacon that can communicate with a domain name server (DNS) over IPv4 can still import Active
Directory data. Alternatively, an inventory beacon co-installed on your central application server (which by
definition must have IPv4 available to it) can still access a DNS on IPv4 and import Active Directory data.

• Inside an IPv6 network, an inventory beacon cannot do any of the following:

◦ Import inventory from third-party sources

◦ Import business data from other systems (such as your purchasing or HR systems)

◦ Communicate with SAP systems in your IPv6 environment

◦ Perform any inventory beacon-based discovery or remote inventory collection across the IPv6 subnet,
including VMware host scans (such as required for special 30-minute scans for IBM PVU license
management)

◦ Adopt target inventory devices that can communicate only on an IPv6 subnet (instead, use third-party
deployment to install the FlexNet inventory agent on target devices within an IPv6-only subnet).

However, once again, a dual-stack inventory beacon that can communicate with a DNS over IPv4, and
contact the various sources also exclusively over IPv4, still supports all the above functionality on the IPv4
side. This is also true of an inventory beacon co-installed on the application server.

Take these factors into account when planning the distribution of your inventory beacons around your
network. Details about installing the individual inventory beacon are available in Configure Beacon
Connections.

Prerequisites and Preparations
Please ensure that you have worked through every one of the following topics.

Locate License Details
A license file for your existing product(s) was sent to you with your original order confirmation. (While you are
under a maintenance agreement, this same license entitles you to this system upgrade.) You will require your
license file when you start from a single server combining Inventory Manager with FlexNet Manager Platform
(or its predecessor Compliance Manager), and migrating to a multi-server implementation.
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Important: If you are updating from Inventory Manager 9.0 or earlier to Inventory Manager 9.2.3 as part of
this overall upgrade process, you must obtain a new license file, as the format of the license file changed
between these releases. You will also require a new license file if you are purchasing additional options, such
as FlexNet Manager for Datacenters.

In all other cases, locate your license file(s), originally dispatched with your order confirmation.

If you cannot locate the license file, please contact the Flexera order processing team, and ask for a new copy
of your license file.

Enable MTS and MSMQ
Microsoft Task Scheduler (MTS) must be enabled on your central application server. If you have a multi-server
implementation, Microsoft Task Scheduler must be enabled on at least the batch server and the inventory
server. If Microsoft Task Scheduler is disabled, the PowerShell configuration script fails when attempting to
create a scheduled task folder, and of course the scheduled task required for server operation are not created.
To correct this, enable Microsoft Task Scheduler, and re-run the Config.ps1 configuration script.

Microsoft Message Queuing (MSMQ) is a messaging service widely available as a component of various
Microsoft operating systems. It allows applications running in separate processes, even on separate servers, to
enjoy failsafe communications. MSMQ is used as foundational infrastructure for the batch scheduler and
batch processor on the central application server (or, in larger systems, the batch server) of FlexNet Manager
Suite. Its operation is mandatory on all central servers (whether a single server, or scaled up to separate web
application server, batch server, and inventory server) to allow the interactions necessary for batch processing
tasks. Where the database server is separate, it is not required on the database server.

FlexNet Manager Suite makes use of the standard facilities of MSMQ, with no customization required. For
example, MSMQ may make use of the following ports in operation:

• TCP: 1801, and 389 for version 3.0 and later

• RPC: 135, 2101*, 2103*, 2105* (Port 135 is queried to check availability of the remaining ports. The port
numbers marked * may be incremented by 11 if the initial choices are not available when MSMQ initializes.)

• UDP: 3527, 1801.

FlexNet Manager Suite makes no special demands on, nor adjustments to, the use of ports for MSMQ, and
uses whatever ports are operational. Please check Microsoft documentation for more information about when
various ports are required (for example, https://support.microsoft.com/en-us/kb/178517).

The system requirements for integration with MSMQ are:

• In a multi-server implementation, each server must know the URL of all others (or, on a single-server
implementation, localhost may be used). This is normally configured by the PowerShell configuration

script, described later.

• MSMQ imposes a 15-character limit on the batch server hostname (as noted in the section on design, and
elsewhere).

• A single service account should be used in common across all central servers to facilitate the operations of
MSMQ. This is also noted in the following section on accounts.

Where MSMQ is already operational on your central servers, no customization is required. Where MSMQ has
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been disabled or removed:

• When the feature is not installed or is not enabled, the PowerShell configuration script (described later) will
attempt to install (if necessary) and enable the Windows feature. This requires that the installing user (see
section on accounts, below) has sufficient permissions to allow these actions if required. It also requires
that the Windows CAB files are still available to the server.

Tip: After installing MSMQ, the PowerShell configuration script attempts to create the message queue. If
the installation process requires a reboot, this attempt fails, and the script reports Message Queueing
has not been installed on this computer. If you see this message, reboot the server and re-run
the same PowerShell configuration script.

• Alternatively, if the CAB files are still in place, an administrator can manually enable the Windows feature
before running (or re-running) the PowerShell configuration script.

• Where CAB files have been removed as part of server hardening for security, MSMQ must be installed
following the instructions from Microsoft available through MSDN. The PowerShell scripts can be run (or
re-run) thereafter.

FlexNet Manager Suite has been tested with multiple versions of MSMQ, up to and including version 6.3,
which is part of Windows Server 2012 R2.

Identify (or Set Up) Accounts
You may have accounts correctly configured from your previous implementation. If you need to adjust, here
are the details.

For installation and operation, FlexNet Manager Suite requires several different sets of account privileges.
While it is possible to load a single account with all these privileges, this is typically unacceptable in secure
environments, which require a separation of concerns between interactive login accounts for installation and
maintenance, and operational service accounts (usually with long-term and closely-guarded credentials).

The following tables list the various privilege levels, their purpose within FlexNet Manager Suite, and a
suggested set of Active Directory accounts allowing for that separation of concerns. The three account types
described are:

• A database administrator (typically this is an existing database administrator within your enterprise)

• An installing system administrator (account details must be made available to db-admin)

• A service account for normal operations (account details must be made available to db-admin).

Tip: Where privileges are controlled by Active Directory Group Policy Objects (GPOs), ensure that the
accounts and group(s) are added to the appropriate GPO settings prior to attempting installation. A
suggested practice when creating the databases is to assign the installing administrator account (fnms-
admin) and the service account (svc-flexnet) to an Active Directory group (suggested: FNMS
Administrators) in order to grant them appropriate privileges; so you may choose to manage other rights
through that group. Also note that these accounts and their privileges must remain active for the lifetime of
the FlexNet Manager Suite environment.
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Table 1: Database administration privileges — suggested AD account: db-admin

Privileges Required on Purpose

Database administrator, with db_owner rights
on all operations databases related to FlexNet
Manager Suite (compliance data, warehouse
data, snapshot data, and inventory data).

Database servers Provides the following accounts
with database access rights as
described.

Member of the public database role in the
model database on the database server.

Database servers Required so that the account can
run scripts that check the
database compatibility level.

SELECT rights to the following tables in the
msdb database:

• dbo.sysjobs

• dbo.sysjobsteps

• sysjobs_view.

EXECUTE rights to the stored procedures from
the msdb database used in the database
scripts, including:

• sp_add_job

• sp_add_jobserver

• sp_add_jobstep

• sp_add_jobschedule

• sp_delete_job.

Database servers Only required if an existing
installation of FlexNet Manager
Suite 2015 or earlier is being
migrated to a later release.

Tip: If you are installing Flexera Analytics (powered by Cognos) as part of your implementation, you also
need a SQL Server account with read/write access to the Content Store database required by Cognos. The
Flexera Analytics installer asks for the login name and password for this account (for details, including
character set restrictions, see Installing Flexera Analytics).
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Table 2: Installing administrator privileges — suggested AD account: fnms-admin

Privileges Required on Purpose

Membership in the db_owner role
on all operations databases
(compliance data, warehouse
data, snapshot data, and
inventory data).

Database server. Post-installation, for continuing
administration, this account can
be reduced to the same privileges
as for the service account
(described below). However, the
standard installation scripts set
some database properties
(ARITHABORT,
QUOTED_IDENTIFIER) that can
only be configured by an account
with db_owner privileges.
Therefore the installing account
needs membership in the
db_owner role at least
temporarily during installation.

Local administrator • Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• All inventory beacons.

Installs and configures software
on all servers. On inventory
beacons, interactive login to the
inventory beacon interface also
requires local administrator
privileges (that is, on inventory
beacons this is an operational
account as well as being required
for setup).

Set the execution policy for, and
execute, PowerShell scripts

Central application server(s)
(including, where separated, web
application server, batch server,
and inventory server).

PowerShell scripts are used to
complete the configuration of
central servers during
implementation. Includes an
attempt to enable Microsoft
Message Queuing, where this is
not already enabled.

Create tasks in Windows Task
Scheduler

• Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• All inventory beacons.

Runs PowerShell scripts during
installation that create scheduled
tasks.

Internet connection to
https://flexerasoftware.

flexnetoperations.com

A central server (with network
access to all other central
application servers in a multi-
server implementation).

Retrieve installers for
implementing FlexNet Manager
Suite and the license from Flexera
for its operation.
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Privileges Required on Purpose

Internet connection to
https://www.managesoft.com

(Typically granted through
membership in the FNMS

Administrators security group
in Active Directory.)

The batch server (or, in smaller
implementations, the processing
server or application server).

Maintenance or unscheduled
collection of the Application
Recognition Library, the SKU
libraries, and the Product Use
Right Libraries.

Table 3: Service account privileges — suggested AD account: svc-flexnet

Privileges Required on Purpose

Membership in the following fixed
database roles:

• db_ddladmin

• db_datawriter

• db_datareader.

In addition, the account requires
you to GRANT EXECUTE

permissions on all operations
databases (compliance data,
warehouse data, snapshot data,
and inventory data).

Tip: In less stringent
environments, it may be
convenient to give this
account membership in the
db_owner role for the
operations databases, which
supersedes all of the above.

Database server Normal operation (which includes
execution of SQL stored
procedures).
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Privileges Required on Purpose

Logon as a Service, and run all
FlexNet services

Tip: Admin access for this
account is convenient, and
typically granted through
membership in the FNMS

Administrators security
group in Active Directory;
otherwise read, write, and
execute permissions are
required on all folders
containing FlexNet
installations, FlexNet data,
and FlexNet log files.

• Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• All inventory beacons.

Runs all system operations,
including batch services and web
services.

Important: In a multi-server
implementation, the same
service account must be used
on all central servers, and it
must be a Windows domain
account. This is required for
proper functioning of
Microsoft Message Queueing
between the servers. (A distinct
service account may be used
for inventory beacons.)

Logon as a Batch Job • Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• All inventory beacons.

When the service account runs a
batch job, this setting means the
login is not an interactive user.

Tip: This is particularly
important on the batch server
(for authorization details, see
Authorize the Service
Account).

Run scheduled tasks as a service
account.

• Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• All inventory beacons.

Runs scheduled tasks within
normal operations.

Run IIS application pools as a
service account

• Central application server(s)
(including, where separated,
web application server, batch
server, and inventory server);

• Those inventory beacons that
are running IIS

Normal operations
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Privileges Required on Purpose

Internet connection to
https://www.managesoft.com

(Typically granted through
membership in the FNMS

Administrators security group
in Active Directory.)

The batch server (or, in smaller
implementations, the processing
server or application server).

Scheduled collection of the
Application Recognition Library,
the SKU libraries, and the Product
Use Right Libraries.

Tip: While the table above lists a single service account svc-flexnet on your application server(s) and
inventory beacons, this may be adequate only in environments where security is not a significant concern.
For greater security, consider a separate service account for each inventory beacon that has the permissions
listed above on the inventory beacon, but no permissions on your central application server(s).

Note: At implementation time, all services are configured with the correct password using the PowerShell
scripts provided. If at any time the password on the service account is forced to change, the services will
cease to operate. To ensure service continuity, you may either (a) allow the service account password to
never expire (as normal for Windows service accounts), where permitted by your corporate policies; or (b)
review the accounts listed in Password Maintenance.

In addition to the three core accounts described in the tables, your implementation may require additional
accounts for special circumstances.

For example, if you are using adapters to connect to other systems and import data, you need appropriate
accounts. For details, see documentation for the adapters you need, such as the FlexNet Manager Suite 2019
R1 Inventory Adapters and Connectors Reference PDF, available through the title page of online help after
installation.

Tip: There may be several accounts needing to log in directly to the application server for tasks related to
FlexNet Manager Suite, such as manipulating log files, scheduling tasks, and the like (this excludes access
through the web interface, which is not relevant to this discussion.) It is often convenient for these accounts
to have the same database permissions as the services account on all components of the operations
databases: compliance data, warehouse data, snapshot data, and inventory data. A suggested method is to
create either a local or Active Directory security group (such as FNMS Administrators) and add all such
accounts to this group. Then you can, for example, set these permissions by opening each database in
Microsoft SQL Server Management Studio, and granting the appropriate privileges to the security group. The
procedures are detailed in the topics covering database creation. Accounts to list in the security group
minimally include:

• The operational service account (suggested: svc-flexnet)

• The installing administrator account (suggested: fnms-admin) for post-installation on-going

administration (remembering that db_owner membership is required temporarily during installation, as

described in Identify (or Set Up) Accounts)

• Any operational account needing to log in to a central inventory beacon installed on your batch server
(remember that, since the inventory beacon requires administrator privileges to run, this account is both a
local administrator on the batch server and a db_owner)
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• Any future back-up administrator accounts needed for the application server.

Isolate the System
You need to protect your data from operational changes during the upgrade.

Since your previous implementation receives inputs from operators and through scheduled tasks, all these
should be blocked before you migrate.

To isolate the system:

1. Send out the notification (such as email), as required by your corporate processes, to alert operators that
the system is going down for maintenance.

2. Log in to the server as a system administrator.

3. Shut down Microsoft IIS as the most efficient way to prevent any operator from logging in, or any files
from being uploaded. Use your preferred method. For example, using the user interface on Windows
Server 2008:

a. Click Start, right-click on Computer, and select Manage from the context menu.

The Server Manager dialog opens.

b. In the left-hand navigation bar, expand Roles > Web Servers (IIS), and select Internet
Information Services.

The IIS page is displayed.

c. In the Actions panel on the right, select Stop.

A message like Attempting to stop... appears. Note that it can take some time before the
service is stopped.

4. Shut down all related Windows Scheduled Tasks. For example:

a. Ensure that your Server Manager dialog is still open.

b. In the left-hand navigation bar, expand Configuration > Task Scheduler > Task Manager
Platform, and select the ManageSoft folder.

c. Select all of the relevant tasks in the list (click the first, shift+click the last), and in the Actions
pane, in the Select Item section, click Disable (or right-click the selection, and click Disable).

d. Close the dialog.

Check Database Collation Sequence
All databases for this system require the correct collation sequence, both case insensitive and accent sensitive.

This is easiest if they are installed on one or more database instances that have this as the default collation
sequence. If you are carrying forward the database instance that previously supported your 9.2
implementation, this already complies with the appropriate collations sequence. For any new DB instance, use
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this process to check the collation sequence.

To validate the server's default database collation sequence:

1. In SQL Server Management Studio, locate the SQL Server instance in the Object Explorer pane.

2. Right-click the server, and select Properties from the context menu.

3. On the server Properties dialog, select the General tab, and check the current collation sequence.

If the collation sequence includes the codes _CI_AS (for example, SQL_Latin1_General_CP1_CI_AS),
you may proceed with the installation.

Tip: Other suffixes like _KS or _WS are optional.

If the server's default collation does not include _CI_AS, you can set the collation sequence for each
database, as you create it, by right-clicking the new database, selecting Properties from the context
menu, and choosing the collation on the Options tab. Remember that the collation sequence must be
identical for:

• The compliance database (suggested name: FNMSCompliance)

• The reporting snapshot database (suggested: FNMSSnapshot)

• The data warehouse database (suggested: FNMSDataWarehouse).

For example, if the first of these has the collation sequence called SQL_Latin1_General_CP1_CI_AS,
then all of them must have the exact same collation sequence. In contrast, the inventory database, when
separate (suggested: FNMSInventory), and the Cognos content store may have different collation
sequences, provided that these also include the same _CI_AS codes. The tempdb database (alone) may
have any collation sequence, since FlexNet Manager Suite creates the required tables here with the
appropriate collation sequence.

Important: If you have not already backed up your database, do so now.

Enable SQL Server CLR
FlexNet Manager Suite requires Microsoft's SQL Server Common Language Runtime (CLR) Integration to be
enabled prior to upgrading for increased performance.

To enable SQL Server CLR:

1. In SQL Server Management Studio, locate the SQL Server instance to be used by FlexNet Manager Suite.

2. Enable Microsoft SQL Server Common Language Runtime (CLR) Integration by executing the following
stored proceedure:

sp_configure 'show advanced options', 1;

GO

RECONFIGURE;
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GO

sp_configure 'clr enabled', 1;

GO

RECONFIGURE;

GO

Note: By default the CLR integration feature is disabled and must be enabled by the DB system
administrator before database creation and installation.

Configure .NET and IIS
ASP.NET needs patching, and IIS configuration must be modified for ASP.NET. As well, you must prevent
WebDAV from blocking functionality.

Detailed steps depend on the operating system and installed software. You must repeat this process in turn
on each of:

• web application server

• batch server

• inventory server

• Flexera Analytics (Cognos) server

• each free-standing inventory beacon (the inventory beacon installed on your central batch server is
covered by the configuration of the batch server).

Note: Inventory beacons have an additional requirement, that PowerShell is at least at version 3.0.
Should you wish to upgrade PowerShell to release 4.0, Microsoft also requires Microsoft .NET Framework
4.5 (or later) on the same server. Take both these matters into account at the same time (see Upgrade
PowerShell on Inventory Beacons for more details).

(If your implementation combines multiple servers into a processing server, or into an application server, then
complete the task once per server.)

Tip: Mark off each server on your block diagram as this process is completed for that device.

To configure .NET and IIS on a server:

1. If the server is running Microsoft Windows Server 2012:

a. Open Windows Programs and Features.

b. Search the list of applications for Microsoft .NET Framework 4.5 (or later). If it is present, skip to
step 4 below.

c. Because Microsoft .NET Framework 4.5 (or later) is not present, follow steps under "To install IIS
and ASP.NET modules on Windows Server 2012 using the UI" in http://technet.microsoft.com/en-
us/library/hh831475.aspx#InstallIIS. Thereafter, continue with step 4 below.
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2. If your server is running Microsoft Windows Server 2008, the original installation was Microsoft .NET
Framework 4, but it may have been upgraded already to 4.5. To check:

a. Open Windows Programs and Features.

b. Search the list of applications for Microsoft .NET Framework, and determine whether it is release 4
or release 4.5 (or later).

• If it is 4.5 (or later), skip to step 4 below.

• If it is 4.0, continue here.

3. If the .NET version is less than 4.5, upgrade Microsoft .NET Framework to version 4.5 or later.

For more details, see https://msdn.microsoft.com/en-us/library/5a4x27ek(v=vs.110).aspx.

4. Open a Command Line window on the current server (for example, Start > search for cmd > run
cmd.exe).

5. Change directory to the Microsoft .NET Framework installation folder.

6. Install ASP.NET (which also registers ASP.NET with IIS when present), for example with the platform-
appropriate commands:

For operating systems up to Windows Server 2008 R2, use:

aspnet_regiis.exe -ir -enable

For Windows Server 2012, use:

dism /online /enable-feature /featurename:IIS-ApplicationDevelopment

dism /online /enable-feature /featurename:IIS-ISAPIFilter

dism /online /enable-feature /featurename:IIS-ISAPIExtensions

dism /online /enable-feature /featurename:IIS-NetFxExtensibility45

dism /online /enable-feature /featurename:IIS-ASPNET45

7. Exit to close the command line window.

If you are currently working on any of:

• Your web application server

• Your batch server

• A free-standing inventory beacon that uses the FlexNet self-hosted web server (and not IIS)

loop back now and restart this process for the next server on your list. For your inventory server and any
inventory beacon using IIS, continue and disable WebDAV on these devices.

Tip: Although from IIS 7.0, Microsoft offered a separate download for improved WebDAV functionality,
the native WebDAV functionality must also be disabled. Otherwise WebDAV intercepts HTTP
processing and blocks FlexNet inventory functionality.

8. You may first check that WebDAV is installed. For example, on Windows Server 2012:

a. Open Server Manager (for example, Start > Administrative Tools > Server Manager).
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b. Select Dashboard, and in the dashboard select Add Roles and Features.

The Add Roles and Features Wizard opens.

c. In the left-hand navigation pane, select Installation Type, and in the main pane, ensure that the
Role-based or feature-based installation is selected.

d. Click Next (or select Server Selection), and select the server you are currently configuring.

e. Click Next (or select Server Roles), and in the Roles panel, expand Web Server (IIS) > Web
Server > Common HTTP Featured (Installed).

f. Observe whether the check box for WebDAV Publishing (Installed) is selected.

If this check box is clear, WebDAV is not installed, and you may click Cancel, then close all
relevant dialogs. If this is not the last server on your list, loop back and restart this process on the
next server. However, if the check box is selected, WebDAV is installed and must be disabled, as
described in the following steps.

9. Open the IIS settings page. For example:

• On Windows Server 2016, open Server Manager (Start > Administrative Tools > Server Manager).
On the Server Manager dashboard, click IIS to reveal the server name in the right-hand pane. Right-
click the server name, and select Internet Information Services (IIS) Manager.

• On Windows 7, navigate to Control Panel > System and Security > Administrative Tools, and
double-click Internet Information Services (IIS) Manager.

10. In the work pane that opens, expand the server name node (if required), expand Sites, and select
Default Web Site.

11. In the Home pane for this site, in the IIS group, locate WebDAV Authoring Rules.

Tip: If it is not present, it is likely that WebDAV is not installed on this server, and your mission is
complete.

12. Right-click the icon, and select Open Feature. A pane opens for WebDAV Authoring Rules.

13. On the right, in the Actions group, there is an option to enable or disable WebDAV.

• If the link currently says Enable WebDAV, do nothing, because your mission is complete.

• If the link current says Disable WebDAV, click the link.

14. Click OK to close all applicable dialogs.

If this is not the last server on your list, loop back and restart this process on the next server.

15. Flexera Analytics requires installation of URL Rewrite.

a. Open a web browser and open https://www.iis.net/downloads/microsoft/url-rewrite

b. Select the Install this extension box, which will download the urlrewrite2.exe file. A selection
of alternate language installers are also available on this page.

c. Run the file which will execute the installation of this extension.

d. Exit the installer.

Migrating to FlexNet Manager Suite 2019 R1 On-Premises

38 Migrating to FlexNet Manager Suite 2019 R1 On Premises | Company Confidential

https://www.iis.net/downloads/microsoft/url-rewrite


16. Flexera Analytics also requires the installation of Application Request Routing.

a. Open a web browser and open https://www.iis.net/downloads/microsoft/application-request-
routing

b. Select the Install this extension box, which will download the ARRv3_0.exe file.

c. Run the downloaded file which will execute the installation of this extension.

d. Exit the installer.

Tip: There is additional configuration of IIS handled by PowerShell configuration scripts described later.

Upgrade PowerShell on Inventory Beacons
PowerShell is used both as part of the installation, and for operation of inventory beacons after installation.

The minimum requirement on inventory beacons is PowerShell 3.0.

You may choose to upgrade PowerShell to version 4.0, but be aware that this release has a prerequisite of
.NET Framework 4.5.

To check and optionally upgrade PowerShell on a candidate server:

1. Within Windows PowerShell, run $PSVersionTable.PSVersion.

This produces output similar to the following:

Major     Minor       Build    Revision

-----     -----       -----    --------

3          0           -1          -1

2. If the Major value is less than 3, download your chosen version and install it.

For example:

• For PowerShell 3.0, see http://www.microsoft.com/en-us/download/details.aspx?id=34595.

• For PowerShell 4.0, see https://www.microsoft.com/en-us/download/details.aspx?id=40855.

Configure Network Shares for Multi-Server
If you have not already done so, use Windows Explorer to configure the network share drives used by your
central servers.

There are two such shares required when you install the web application server on a separate server:

• The data import directory used for handing off any content imported through the web interface of FlexNet
Manager Suite (such as one-off inventory spreadsheets) to the batch server for processing (default value:
%ProgramData%\Flexera Software\FlexNet Manager Platform\DataImport\). It may be on any of

your central servers, as convenient in your implementation; and it may be on any drive and any file path.
You must configure the share manually in Microsoft Windows.
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• The parallel data export folder used to stage data for integration with other systems. This is typically
located as a peer of the above (default value: %ProgramData%\Flexera Software\FlexNet Manager

Platform\DataExport\).

You may implement these shares as you see fit.

For added security, you may set up these shares so that they are available to the minimum number of
accounts (rather than open to all). From the process of setting up accounts, you are already acquainted with
the Active Directory security group FNMS Administrators, which minimally contains the operational service
account (suggested: svc-flexnet), the installing administrator account (suggested: fnms-admin), and any
accounts with interactive logins to any of your central servers. If you wish, you can restrict these network
shares so that they are open only to members of FNMS Administrators, with the group providing full
control for both daily operations and any required maintenance/troubleshooting.

Configure Internet Explorer
Microsoft Internet Explorer requires configuration.

Compatibility mode must be turned off for FlexNet Manager Suite. In addition, when Internet Explorer is used
on a server-based operating system to access FlexNet Manager Suite after setup is complete (for example, if
you are testing from your central application server, or an inventory beacon has a server operating system), its
enhanced security provisions must be turned off on that server, as follows. (Alternatively, use a different
browser.)

Tip: Check release notes for supported versions. For example, Microsoft Internet Explorer releases up to and
including release 9 are deprecated for FlexNet Manager Suite from 2016 R1.

To configure Microsoft Internet Explorer:

1. Open Internet Explorer, and navigate to:

res://iesetup.dll/IESecHelp.htm#overview

2. Follow the instructions displayed there for disabling Enhanced Security Configuration.

3. FlexNet Manager Suite attempts to advise Internet Explorer that the website should not be run in
compatibility mode. You need follow these steps only if you receive an alert asking you to turn off
compatibility mode:

a. In Internet Explorer, press the Alt key to display the Menu bar.

b. Click Tools, then Compatibility View Settings.

c. Make sure Display all websites in Compatibility View and Display intranet sites in
Compatibility View are both clear.

d. Add websites that do require compatibility mode to the list of Websites you've added to
Compatibility View.

There are a number of other configuration requirements for whichever web browser you choose to use:

• URLs to add to your trusted locations
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• Recognition of your central server as an Intranet site, and allowing automatic logon

• Javascript must be enabled

• Cookies must be enabled

• Windows authentication must be enabled

• Font download should be enabled for optimum usability of the site

• Any company proxy servers must allow browsers to access to the web application server.

Details for each of these are included in the first topic in the online help, Configuring Your Web Browser,
available after the product is upgraded.

Drivers for Spreadsheet Imports
It is quite likely that at some stage you will need to import data from spreadsheets or CSV files. For example,
you may have purchase records in spreadsheets, or inventory exported from a hard-to-reach system, or you
may have a record of entitlements from a reseller in a spreadsheet format. Documentation is available for
these different uses, including the chapter Importing Inventory Spreadsheets and CSV files in the FlexNet
Manager Suite 2019 R1 System Reference PDF, available through the title page of online help after installation.

You need a driver update if all of the following conditions apply to your future use of FlexNet Manager Suite:

• You will import data from spreadsheets (the export of data to spreadsheets is not relevant, and the import
of data from CSV [comma-separated values] file is also not relevant)

• The spreadsheets will be Excel spreadsheets in .xlsx format (the earlier .xls format does not require the

driver update; but be aware that this older format limits each spreadsheet to about 65,000 records/rows)

• The .xlsx files will be imported to the batch server (or processing server, or application server in a single

server implementation); or they will be imported to an inventory beacon — obviously, drivers are needed
only on servers (whether a central server or inventory beacon servers) where such imports actually occur, so
that this prerequisite applies only to those relevant server(s).

In these conditions, you must install a 32-bit version of Microsoft Access Database Engine on the relevant
server. The particular release is not important: for example, Microsoft Access Database Engine 2010-32 is
adequate. Drivers are supplied within the Microsoft Access Database Engine.

Important: Only the 32-bit version is supported by the Business Importer mechanism, and this version is
incompatible with the 64-bit version of Microsoft Office products installed on the same machine. This means
that, when you need imports in .xslx format, 64-bit Office cannot be installed on the central batch server
(or application server), or on applicable inventory beacons. Naturally, Office documents including
spreadsheets prepared on other machines running 64-bit Office can successfully be imported. The limitation
is only on co-installation on the same computers.

Download the Materials
Position yourself on a computer that is accessible from all the central servers you will implement, and
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preferably at least some of your inventory beacons.

To download installation and upgrade software:

1. Use your browser to access the Flexera Customer Community.

a. On https://flexeracommunity.force.com/customer/CCLanding, use the account details emailed to
you with your order confirmation from Flexera to log in (using the Login link in the top right).

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the Request Community Access link on the login page to request one. Your
credentials are configured for access to content you have licensed.

b. Select the Downloads tab from the row across the top of the page.

A routing page appears to let you Access Product and License Center, displaying lists of
products from Flexera.

c. In the lists of products, identify FlexNet Manager Platform, and click the Access Above Products
button that is below that product name.

The Product and License Center site is displayed.

d. In the Your Downloads section of the Home page, click the link for FlexNet Manager Platform.

e. In the Download Packages page, click the link for FlexNet Manager Platform 2019 R1 to access
the downloads. (You may need to repeat this action on a second page to access the
downloadable files.)

2. Depending on your login account, a click-through license may appear. If so, review the terms, and click I
Agree.

3. Download the release notes, and review the requirements for the Windows Server computer(s) on which
you will install FlexNet Manager Suite 2019 R1.

Tip: Use your block diagram of the servers to note requirements, and check these off when you
validate that the machines are adequately provisioned. Resolve any issues with server provisioning
before proceeding with the implementation.

4. Download the following archives and save to a convenient (network-accessible) location on this
computer (such as C:\temp\FNMSUpgrade\). You may unzip all these archives here.

• FlexNet Manager Suite 2019 R1 Installer.zip

• Database Migration to FNMS 2019 R1.zip

• Inventory Agent 92 Upgrades to 2019 R1.zip

5. If you are collecting inventory from Citrix XenApp, also download:

• Adapter Tools.zip.

6. If your implementation design includes Flexera Analytics (powered by Cognos), also download:
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• Report Designer for FlexNet Manager Suite.zip (this contains the default report structures

within FlexNetManagerPlatformReportsAndDashboard.zip)

Tip: There are additional downloads required if you are also upgrading your Inventory Manager
installation. These are covered in Identify and Update Inventory Manager Server.
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2
Preparing Inventory Manager

If you do not have any installation of Inventory Manager as part of your current implementation (see the first
topic following for ways of checking), you may skip ahead to the following chapter, Upgrading FlexNet Manager
Suite.

Otherwise, your Inventory Manager system (including the inventory agents installed on managed devices
throughout your enterprise) can be prepared for the migration even before FlexNet Manager Suite 2019 R1 is
installed. Work through the following topics.

Identify and Update Inventory Manager
Server
This process corresponds to steps 2 through 5 in the overall flowchart in Process Overview. Complete all the
following on the central server(s) of your current implementation.

To identify and update your Inventory Manager server:

1. If you have not already done so, back up your server(s) now.

2. If you have been using Flexera Analytics (powered by Cognos) and intend to continue using it with
FlexNet Manager Suite 2019 R1:

a. On your application server (where Inventory Manager runs), open regedit.

b. Navigate to HKLM\SOFTWARE\ManageSoft Corp\Compliance\CurrentVersion\BIDispatchUrl.

c. Take a note of the URL recorded there. You will use it when importing the updated reports
package.

d. Close regedit.

3. Open your existing compliance product in the MMC console.

4. Look for the following nodes in the left-hand console tree:

• Managed Device Settings
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• Discovery and Adoption

• Remote Task Manager.

If any of these nodes is present, Inventory Manager is co-installed on the same server as your compliance
product. This server will roll forward as your Inventory Manager (only) server, at least for the time being.
Check that your server plan includes a new server (or set of servers) for FlexNet Manager Suite 2019 R1.
Also make a note that you must clean your previous compliance product off this server, as described in
the process below. This co-location also means that your two products were using a shared database.
Make a note that you need the process for splitting this database, described in Splitting a Shared
Database. For now, skip to step 6.

5. If you have been managing inventory from computers collected through FlexNet inventory agents, there is
an installation of Inventory Manager on another server. Identify that server (if need be, asking operators
how they have been accessing the inventory). To determine whether your two separately-installed
products were accessing a shared database:

a. Start the registry browser on each of these two servers (compliance and inventory).

b. Browse to the following registry keys:

• For 64-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ManageSoft

Corp\ManageSoft\Reporter\CurrentVersion\DatabaseConnectionString

• For 32-bit operating systems: HKEY_LOCAL_MACHINE\SOFTWARE\ManageSoft Corp\

ManageSoft\Reporter\CurrentVersion\DatabaseConnectionString

c. Compare the values of the Database and Server settings.

If these two values each match across both servers, your two products were using a shared
database. Make a note that you need the process for splitting this database, described in Splitting
a Shared Database.

6. On the server with Inventory Manager installed, in the MMC interface for the product (or combined
products), open the Help menu, and select Help about Inventory Manager.

If the release shown is 9.2.3, you are done with this procedure. Skip forward to Prepare Managed Device
Self-Upgrade Package.
If the release is shown as 9.2, Flexera recommends that you upgrade to release 9.2.3. This upgrade delivers
enhancements consistent with the FlexNet Manager Suite 2019 R1 upgrade, which will be helpful while
these products co-exist (full details are available in the release notes for 9.2.3). Should you choose to do
without those enhancements, technically the 9.2 release is sufficient to move forward with the upgrade of
FlexNet Manager Suite.

If the release is prior to (less than) 9.2, you should upgrade the Inventory Manager 9.2.3 as the foundation
for moving forward with the joint systems.

7. Using your login credentials for Flexera Product and License Center, navigate to the product download
page for FlexNet Manager Platform 9.2.3: https://flexerasoftware.flexnetoperations.com/control/inst/
download?element=5631471.

a. Log in to https://flexerasoftware.flexnetoperations.com.

b. Click FlexNet Manager Platform.

Preparing Inventory Manager

Migrating to FlexNet Manager Suite 2019 R1 On Premises | Company Confidential 45

https://flexerasoftware.flexnetoperations.com/control/inst/download?element=5631471
https://flexerasoftware.flexnetoperations.com/control/inst/download?element=5631471
https://flexerasoftware.flexnetoperations.com/


c. Click FlexNet Manager Platform again on the next page.

d. In the 9.2.3 row, click FlexNet Manager Platform again.

8. Download at least the following:

• Release notes (FlexNet Manager Platform Release Notes.pdf)

• For database migration: Database Migration Scripts 9.2.3 (Database Migration.zip)

• For updates to the Inventory Manager software: Flexera Inventory Manager 9.2.3 Installer (im923.exe)

9. If you have not already done so, login to the Inventory Manager server with a privileged account that:

• Is a member of the domain where Inventory Manager and your database server are installed

• Has Administrator privileges on your Inventory Manager server

• Has Database Owner privileges.

10. Ensure that there is sufficient disk space on your database server to accommodate a complete copy of
your existing database.

Important: This is the space required for the database upgrade process. If you plan to use the same
database server for two products rolling forward, be aware that, in addition to separating the Inventory
Manager and FlexNet Manager Suite databases, the latter product also requires two or three additional
databases:

• Its own inventory database, suggested name FNMSInventory

• FNMSSnapshot, used for performance improvement particularly relating to reports

• FNMSDataWarehouse (this may have been present in the 9.2 implementation, where it was an

option; but in 2019 R1 it is a requirement).

11. If you have not already done so, back up your database (see your SQL Server documentation for
procedures).

12. Ensure that all operators are logged out of Inventory Manager and your compliance product (such as
FlexNet Manager Platform).

13. Unzip the Database Migration.zip archive to a convenient working location on the Inventory Manager
server (such as C:\temp\IMUpdate).

14. Open a Command Prompt window, and navigate to your working copy of the migration folder (such as
C:\Temp\IMUpdate\Database Migration\Inventory Manager).

15. Run the mgsDatabaseUpdate.exe program, using the following syntax:

mgsDatabaseUpdate.exe -i InventoryManagerMigration.xml -nsu -l <logFile>

[-s <serverName>[\<instanceName>]] [-d <databaseName>] [-u <userName>] [-p

<password>]

where:
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-d <databaseName> The name of the database to connect to. If -d is not specified,
ManageSoft is used.

-i

InventoryManagerMigration.xml

This is the configuration file describing the migration tasks, and
is of course mandatory.

-l <logFile> Identifies the path and name of the file to receive a log of the
migration tasks that occurred. If this option is not specified, a log
file called InventoryManager.log is created in the same folder
where the executable is running.

-nsu Run the database update without putting the database into
single user mode. (The steps to perform migration require that
multiple connections are made.)

-p <password> The password for the username specified with -u. This is only
required if the database server is configured to use SQL Server
authentication.

-s <serverName>

or
-s

<serverName>\<instanceName>

The name of the database server to connect to. If -s is not
specified, the value at HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\ManageSoft Corp\ManageSoft \Reporter\

CurrentVersion\DatabaseConnectionString is used. The
registry key is present on the compliance and inventory servers.
(If you have chosen to run this script on the database server
itself, the registry entry is not available, and you must therefore
specify the server name, or use the dot notation [.] to refer to
the current server.)
If the database is in a named instance (and not in the default
database on the server), the instance name must be specified as
well.

-u <userName> The username with which to connect to the database. This is only
required if the database server is configured to use SQL Server
authentication. If not specified, Windows Integrated
Authentication is used to connect to the database server using
the current user’s credentials.

The following command performs the migration using the standard configuration file. Instead of recording
the log in the default log file, it will be written to the mig.log file specified in the command. Because
the upgrade is running from the inventory server, the database server name (and, if required, instance
name) is retrieved from the registry, and Windows Authentication is used to log in as the account name
running the executable.

mgsDatabaseUpdate.exe -i InventoryManagerMigration.xml -nsu -l mig.log

Check messages on the command line to confirm that the database migration was successful. If any error
messages occur, check the log file to troubleshoot the problem. Do not proceed to the next step until the
database migration is successful.
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16. Optionally, re-index the inventory database.

For details, see Re-Indexing a Database.

17. Still logged in on the inventory server, ensure that:

• All processes have completed—open the Windows Task Manager to check. If ndrplag.exe is still

processing tasks, allow it to finish.

• The system is in a stable state (one that will not be modified by processing imports or the like).

• The administration console (MMC interface) is closed.

18. If this is a co-located installation of Inventory Manager and your compliance product on the same server,
keep the former, and remove the latter as follows:

Tip: It is a requirement that you remove the co-located compliance product before updating Inventory
Manager.

a. On the application server, open Program and Features (Control Panel > Uninstall a Program).

b. Uninstall FlexNet Manager Platform (or your earlier compliance product, such as Compliance
Manager), and then close Program and Features.

c. Use Windows Task Scheduler to remove the scheduled task called Execute business importer

connections.

19. Navigate to where you downloaded the Flexera Inventory Manager 9.2.3 Installer (im923.exe), and
double-click the executable.

A setup page for Flexera Inventory Manager appears.

20. In the menu bar, click Install.

The Install menu is displayed.

21. Under the Inventory Server heading, select Install.

The installation wizard is invoked, and checks your system for prerequisites, as well as for content that
must not be present. Depending on the results of these tests, you may be asked to perform various
functions before you can progress with the installation. When the checks are satisfactorily completed, the
wizard displays its welcome page.

22. Step through the installation wizard.

Tip: If you prefer step-by-step guidance through the wizard, open UpgradeGuide.pdf from the
documentation folder of your existing Inventory Manager installation, and in chapter 3, Upgrading
administration servers, find the process To upgrade an administration server. Detailed documentation
of the wizard starts from step 4 of this process.

23. When installation wizard is complete, enable the following scheduled tasks (steps described below):

• Generate ManageSoft system status information

• Generate ManageSoft Wake on LAN jobs
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• Import ManageSoft application usage logs

• Import ManageSoft discovery information

• Import ManageSoft distribution logs

• Import ManageSoft installation logs

• Import ManageSoft inventories

• Import ManageSoft remote task status information

• Import ManageSoft system status information

• Merge ManageSoft policies

• Process ManageSoft remote execution actions.

Three other Inventory Manager schedules are created:

• Process ManageSoft distribution jobs —This task is always ‘Running’ and does not need to be

enabled.

• Reconcile ManageSoft directory tables with AD —This task is disabled by default. If you do

want to enable this task, ensure that its timing will not clash with the Merge ManageSoft policies task
as it also performs reconciliation.

• Service the ManageSoft database —This task is disabled by default, but can be manually enabled

or run if and as appropriate for your environment.

To enable the scheduled tasks in the list above:

a. Navigate to Scheduled Tasks (for example, Start > Settings > Control Panel).

b. For each of the scheduled tasks listed above, right-click the task and select Properties.

c. Select the Enabled (scheduled task runs at specified time) check box.

d. Click OK, and repeat for the remaining scheduled tasks in the list.

24. Decide when to upgrade some of your distribution servers, and which ones to target for removal:

• There is no urgency: the upgraded central Inventory Manager server is backward-compatible with
earlier distribution servers.

• Some of your distribution servers may shortly face decommissioning, or re-purposing as inventory
beacons. There is no value in upgrading these.

• For the time being, use the distribution server hierarchy recorded in Inventory Manager to identify all
distribution servers and their specific purposes (such as "desktop inventory", "machine room
inventory", "Oracle introspection", and the like). From the list, identify the ones that can be targeted
for removal as their managed devices are switched over to FlexNet Manager Suite 2019 R1.

• When you decide to migrate any distribution servers, use the previous UpgradeGuide.pdf, chapter 4,
Upgrading distribution servers, to guide you.
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Prepare Managed Device Self-Upgrade
Package
You have identified the managed devices in your estate that are to migrate to exclusive management using
FlexNet Manager Suite 2019 R1.

Important: Managed devices migrating to 2019 R1 must be covered by server-side policy merging. Any
managed devices for which client-side policy merging remains important must not be migrated, and must
continue under Inventory Manager 9.2. The switch to server-side policy merging is incorporated in the self-
upgrade package provided.

You have further identified how to target these devices, whether by operating system, security group, or other
techniques. You also have ready your block diagram of all servers, including inventory beacons and which of
these will be used for bootstrapping managed devices into the new system (see Design the Final Topography).
And you have completed the upgrade of your central Inventory Manager Server to 9.2 SP3 (or thereabouts).

Warning: You must NOT upgrade the managed devices until after your central server has been upgraded.

Now prepare the self-upgrade package for the target managed devices.

Tip: This procedure covers Windows-based managed devices. For non-Windows managed devices, see your
previous UpgradeGuide.pdf from the documentation folder of your existing Inventory Manager installation,
and refer to chapter 5.

This procedure corresponds to step 11 in the flow-chart in Process Overview.

To prepare a self-upgrade package:

1. In your 9.2 implementation of Inventory Manager:

a. Expand Managed Device Settings, and choose a managed device configuration.

You may have only the Managed Device Default Configuration, in which case open that. But if
you have another settings package that you normally issue as standard to the majority of your
managed devices, open that settings package instead.

b. In the groups list, scroll down to (and select) the NetSelector Agent.

c. In the Settings in package list, record the current value of the Selector algorithm.

You will use the values as input to your new system, later in the process.

2. Copy Inventory Agent 92 Upgrades to 2019 R1.zip to this server, and unzip to a convenient
location (such as C:\Temp).

You downloaded this archive in the process under Download the Materials.

3. If your migration of Inventory Manager has not taken you all the way to 9.2 SP3, locate the files
linuxdpkg and linuxrpm from the unzipped archive, and copy them to warehouse-

folder\Repository\Environments (the default value for warehouse-folder is C:\ManageSoft).
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4. Open a Command Prompt and navigate to install-dir\Common.

Replace install-dir with the installation directory for Inventory Manager 9.2 SP3.

5. Execute the following command:

mgsreceive.exe -N extracted-archive-folder\Flexera -d Flexera -o pack=FALSE

where extracted-archive-folder is the folder (such as C:\Temp) where you unzipped the upgrade
packages. This loads the upgrade and settings packages into your 9.2 software library, visible in the
MMC.

6. Open your upgraded Inventory Manager.

We must customize the settings package before distribution and targeting.

7. Under the Flexera Software node, expand the Software Library node, and continue expanding it
(Flexera > FNMS 2019 R1 Migration Settings > 1.0.0 > Rev 1.0 ) until the FNMS 2019 R1 Migration
Settings project is visible. Right-click the package and select Edit....

8. In the navigation bar, expand Registry Entries > All Registry Entries > HKEY_LOCAL_MACHINE >
SOFTWARE > ManageSoft Corp > ManageSoft > Common > DownloadSettings > InventoryBeacon

node.

9. In the right-hand pane, double-click the Host entry.

The Host Properties dialog appears.

10. In the Value field, enter the fully qualified domain name of an inventory beacon in your FlexNet Manager
Suite 2019 R1 system that will be used for bootstrapping managed devices across to the new system.

You identified the inventory beacon(s) for bootstrapping as part of your design work in Design the Final
Topography.

Note: If you are not using HTTP protocol on the standard port 80, you may also modify the following
settings in your package:

Location Notes

Port The default value for HTTP protocol is 80, and the default for HTTPS protocol
is 443. If necessary, edit the port value to match the configuration of this
inventory beacon.

Protocol Either accept the default value of http, or you may edit it if you are using
the HTTPS protocol on this inventory beacon. (The value is case insensitive.)

If you wish, you may also identify multiple inventory beacons for bootstrapping managed devices into
the upgraded system by defining additional DownloadSettings. For example, if your NetSelector
algorithms include MgsSubnetMatch, you may wish to include an inventory beacon in each of your
subnets for maximum network efficiency in inventory uploads from the managed devices. You can
identify all such inventory beacons here: each managed device will choose the one within its own subnet
(or the one that gets top priority according to your selected algorithms).

11. In the navigation bar, expand Registry Entries > All Registry Entries > HKEY_LOCAL_MACHINE >
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SOFTWARE > ManageSoft Corp > ManageSoft > NetSelector > CurrentVersion node.

12. In the right-hand pane, double-click the SelectorAlgorithm entry.

The Selector Algorithm Properties dialog appears.

13. In the Value field, replace $(ExistingSelectorAlgorithm);MgsInventoryBeaconMatch with your
current choices of net selector algorithms, with the new MgsInventoryBeaconMatch value appended on
the end.

Use the list of algorithms you noted down at the start of this process. On targeted managed devices, the
settings package also modifies the PolicySource registry value to the value Server. Only server-side
policy management is supported in 2019 R1.

14. Click OK on the properties dialog, and click Save on the project.

15. Optionally, customize setup.ini.

Use this file to add transforms to the installation of the managed device, suppress installation of the
application usage agent, or prevent users cancelling the upgrade process on their computer (managed
device). For details, see Configure setup.ini.

Your self-upgrade package and settings package are now ready to distribute to your distribution servers. Even
though FlexNet Manager Suite 2019 R1 is not yet in place, you may distribute the packages now, as we have a
separate step to apply these packages; and even thereafter, the managed devices will update, and fail over to
their current fail-over locations until they are targeted by an inventory beacon in the new system. Distributing
(and optionally applying) the packages now gives time for the upgrade and settings to percolate through your
managed devices while you are completing the next stages of the central upgrade. Or, if you prefer, distribute
the packages later, if that better suits your processes. Whenever you are ready, you'll find details in Distribute
Self-Upgrade and Settings Packages.

Configure setup.ini
This file modifies the installation of the managed device.

Use this optional procedure if you wish to:

• Control the level of end-user feedback and control for the managed device upgrade

• Add a transform to the MSI package

• Switch off the installation of the application usage agent.

Each of these options is independent.

Tip: Be aware that there are two .ini files available. This is the one for the MSI, and is called just
setup.ini (not mgssetup.ini).

To configure setup.ini (optional):

1. On your 9.2 Inventory Manager application server, in the flat text editor of your choice, open
C:\ManageSoft\Repository\Packages\Flexera\Upgrade for managed devices\10.2.0\Rev
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1.0\Upgrade for managed devices\setup.ini.

2. Within the setup.ini file, locate the section [Startup].

3. To prevent users from manually cancelling the managed device upgrade, under that heading enter

UserInteractionLevel=/q

This quiet-mode setting suppressed the default user interface (which includes a Cancel button) during
the upgrade.

4. To prevent installation of the application usage agent, in the same section of the file, locate CmdLine and
append:

REMOVE=aua

5. To attach your transform files to the MSI, to the same CmdLine, append a list of your transform files,
separating multiples with semi-colons(;), as in the following example:

Transforms=custom1.mst;custom2.mst

6. Save and close the file.

Your modified setup.ini is automatically included in the upgrade package to be distributed shortly.

Distribute Self-Upgrade and Settings
Packages
You have prepared, validated and (preferably) tested your self-update and settings packages for managed
devices that are to migrate out of Inventory Manager control and into management through FlexNet Manager
Suite 2019 R1. You now wish to distribute these packages to distribution servers accessible to those selected
devices. In fact, the first level of targeting that may be applicable in your enterprise is to restrict the packages
to certain distribution servers. For example, suppose that one distribution server exclusively manages inventory
from a machine room, and you wish to preserve this machine room under Inventory Manager control. You
should exclude that distribution server from the list that receive the upgrade package.

Tip: The upgrade package causes managed devices to self-update to 2019 R1 inventory clients. These clients
are compatible with both the 2019 R1 system and the previous 9.2 Inventory Manager system. You may like
to send this package to all your managed devices to get the latest client functionality. The switch from 9.2 to
2019 R1 is controlled exclusively by the settings package. Therefore, when targeting managed devices to
migrate, include the settings package; and when deciding on managed devices that should remain in the 9.2
system, exclude the settings package from these devices.

This procedure is part of step 11 in the flow-chart in Process Overview.

You can distribute the packages from the Software Library node of Inventory Manager. This will distribute the
packages for all managed device platforms:
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To distribute self-upgrade and settings packages:

1. Right-click the Software Library node and select Distribute....

The Package Distribution Wizard page is displayed.

2. Click Next.

The Assign Packages page is displayed.

3. Select (by checking the boxes) Flexera\FNMS 2019 R1 Migration Settings and Flexera\Upgrade for
managed device\1.0.0, and click Next.

The Select Distribution Locations page is displayed.

4. Select each of the servers to which you will distribute, and click Add.

5. If required, select the Force distribution option.

It is not compulsory to force distribution. This is used to overwrite packages on distribution locations,
even if they are not listed as needing the update. Use this option if you are not certain that your
distribution database is an accurate reflection of the state of your distribution servers.

6. Click Next.

The Distribution Priority page is displayed.

7. Select a priority for the package.

Normal is the default setting).

8. Click Next.

The Selection Summary window is displayed.

9. Click Next.

The Completing the Package Distribution Wizard page is displayed.

10. Click Finish.

The package(s) is/are now sent to the selected distribution servers.

11. After allowing adequate time for the distribution and reporting traffic, verify delivery by clicking on
Reports > Distribution > Packages > All.

Targeting the Inventory Agent Upgrades
and Migration
The update and settings packages are distributed. Now determine which devices should act on which of these
packages.

This procedure corresponds with step 13 in Process Overview.

You are already familiar with targeting upgrades in your previous implementation, and with the options for
policy-level filtering or package-level filtering available in Inventory Manager 9.2. If your goal is that selected
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managed devices will migrate to FlexNet Manager Suite 2019 R1, and that another group of managed devices
do not migrate but continue (at least for the time being) under Inventory Manager 9.2, it is mandatory that you
target the settings package only to those devices that should migrate. (The inventory agent upgrade package
is compatible with either system for both client-side policy merging and server-side policy merging, and may
be sent to all inventory clients if you so wish.)

This targeting in Inventory Manager creates a pool of managed devices primed for migration (because they are
both upgraded, and received the settings package). Later, on the FlexNet Manager Suite side, you can at first
apply additional targeting to this group to allow only a test device, or a pilot group of devices, from the pool to
migrate. But in due course, as you move out of the testing phase, that filtering is removed, and then every
device in the migration pool will automatically switch over to FlexNet Manager Suite 2019 R1 and its hierarchy
of inventory beacons. At that time, it is critical that the managed devices intended to continue under Inventory
Manager 9.2 have not received the settings package, or they will be 'lost' by switching over to the new system.

You may have already applied a first line of control by excluding certain distribution servers from even hosting
the settings package (see Distribute Self-Upgrade and Settings Packages).

Whether or not that is the case, you now need to exert further control, for which your options include policy-
level filtering and package-level filtering. Your enterprise has most likely fixed on one or other of these
approaches to use. Both are applied through the Add to Policy wizard in Inventory Manager. Below is a
summary of the process, and more detail is available in your 9.2 documentation (including the
SoftwareDeploymentGuide.pdf chapter 3, Best practice for a discussion of options, and chapter 5,
Deployment policies for details of the wizard).

Tip: If none of your existing Active Directory security groups allow for the appropriate targeting of this
upgrade, consider creating purpose-specific security groups before starting this wizard. Two sample groups
are discussed in the procedure below: read ahead for details.

Note: If you are not using Active Directory and instead use ManageSoft policy, adapt the principles below for
your corporate practices. For example, you can first assign the upgrade package to your pilot policy, and after
verification, assign the same package to your production policy. Then, if you have some managed devices
that you want to switch to the new system, target those devices for the client settings package. Remember
that only those devices that are both upgraded to the 2019 R1 inventory client and have the updated client
settings package can switch to the new system.

You may choose to do package targeting now, or later. If you do it now, the updated managed devices check
for an inventory beacon, and for as long as they do not succeed, fail over to their existing hierarchy of
distribution servers. If you do it later, you introduce a further delay while you wait for the update package and
settings package to be applied. Doing it now allows plenty of time for the managed devices to self-update and
collect the new settings package while you work on other things. The device upgrade package and the settings
package must be targeted separately.

To target inventory devices for upgrade:

1. In Inventory Manager 9.2.x, navigate through the Software Library to select the upgrade package you have
prepared and distributed.

2. Either right-click the package in the console tree and select Add to Policy, or in the right-hand page click
the Add this package to policy action button.

The Add to Policy Wizard is displayed.
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3. Click Next.

For the path described here, the Select Deployment Policy page is displayed. By choosing the
appropriate policy, you are using policy-level filtering. You need to be aware of where in the Active
Directory hierarchy this policy is attached, as it will be applied to all managed devices in this group and all
its descendents. At this stage, keep in mind that the inventory agent upgrade is applicable to all managed
devices, if you so choose.

4. Expand the relevant domain and browse to the policy to which you want to assign your upgrade package.
With the policy selected, click Next.

The Create or Choose Group page is displayed.

5. Select one of the following radio buttons:

• Create a new, empty filter group
Accept the default name proposed, or type a unique name that better reflects the group's purpose
(such as ManagedDeviceUpgrade). This is often a good option for providing highly customized
targeting for your upgrade package.

Note: After completing this wizard, you must add members to this new security group, either in the
Group Policy Object Editor, or using the Package Allocation wizard. Save effort at this stage by
including in this security group only those devices that you wish to upgrade to the latest inventory
client, but to continue under management with Inventory Manager 9.2. (We use a different security
group for devices that are migrating to the new system, next time through the wizard, as noted
below.)

• Select an existing filter group, applying the package to all group members
Use the Browse for Filter Group page to select the relevant container or security group, and select its
check box before clicking OK. Keep in mind that this adds your upgrade package to whatever other
packages and policy the members of this group receive.

• Apply this package without filtering to all members of the selected policy
This allows pure policy-level filtering (by your choice of policy in the previous page), with no package-
level filtering applied.

6. Click Next.

The Package Applicability page is displayed.

7. Ensure that the default All users on targeted computers (computer policy) is selected, and click Next.

Note: Only computer policy is supported going forward. If you need any user policies, these policies
and their users and machines must be preserved for operation in Inventory Manager 9.2.

The Deployment Conditions page is displayed.

8. Accept the default (This application must be installed. (Mandatory)) and leave both Removal options
unchecked. Click Next.

The Postponement Options page is displayed.

9. Set the options to suit your corporate practices for allowing users to delay the update package, and click
Next.
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Since this update package only changes the behavior of the inventory agent and does not involve
rebooting the device, it may be quite acceptable to leave all options deselected so that the end-user may
not delay your migration process.

The Package Lifetime Options page is displayed.

10. Accept the default As soon as policy becomes effective, and click Next.

The Summary page is displayed.

11. Review the details, and if everything is as intended, click Next.

The wizard creates a policy and (if required) security group as specified. This may take a few moments.
Then the Completing the Add to Policy Wizard page appears.

Tip: If you created a new security group, there is a check box Begin allocating this software package
to end-users or computers displayed on the page. Leave this checked to start the Package Allocation
wizard and target the individual machines you want in the group. (For details about the Package
Allocation wizard, see the section To allocation a package to users or computers in chapter 5,
Deployment policies, of the SoftwareDeploymentGuide.pdf.)

12. Click Finish to complete this wizard.

13. Repeat from step 1 for the settings package, being careful to target this package exclusively to those
managed devices which you intend to migrate to the new system. Use a separate security group as noted
here:

Note: The second time through the wizard, create a second security group such as MigrateTo2014R3.

• Later, in group policy, insert as members of this group all the managed devices that you want to
migrate to the new system. This means that they receive the settings package.

• Also in group policy, make the group MigrateTo2014R3 also a member of the earlier group

ManagedDeviceUpgrade. This means that the migrate targets also receive the device upgrade

package.

14. To monitor progress on self-updating of the managed devices:

a. Select the Reporting node.

b. In the right-hand details panel, locate the Package Installation table.

c. Locate the Managed Devices group, and select the link for All.

All information on distributed packages is displayed.

d. Locate the required package in the list, and click the graph icon to its left. Use the dynamically-
updated graph to track the distribution and installation of the self-update package.

Once the next policy merge is run, the updated policy is applied to the target groups. Managed devices in
those groups will self-update, and wait for an inventory beacon to be available to them.
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Splitting a Shared Database
The migration process requires separate databases because of schema incompatibility from Inventory Manager
to FlexNet Manager Suite 2019 R1.

In Identify and Update Inventory Manager Server, you clarified whether your previous implementations of
Inventory Manager and your compliance product shared a common database. If that was NOT the case, so that
they already had separate databases, skip this topic.

The previous, shared database will roll forward as your Inventory Manager database (at least for the time
being). In this process you will split off a copy to convert into the FlexNet Manager Suite 2019 R1 database,
and clean up both databases following the separation.

As already noted, your new database can share the same server, subject to software version and adequate disk
space (and remembering the additional databases required for the new release). In Design the Final
Topography, you identified (and recorded) your database server for FlexNet Manager Suite 2019 R1.

This procedure corresponds to step 5 in Process Overview.

To split a shared database:

1. Backup the existing shared database (its default name was ManageSoft).

For details about backing up, see http://msdn.microsoft.com/en-us/library/ms187510(v=sql.100).aspx.
(This is in addition to the protective backup at the start of the entire process. This time you are backing
up the updated database.)

2. Did your previous implementation include the data warehouse database (then used for reports prepared
in Flexera Analytics)? If so:

a. Also back up this database (its default name was FNMPDataWarehouse).

b. Copy this database to the SQL Server database identified for the data warehouse database in your
server plan.

Upgrade of this relocated database follows in Upgrade/Create Databases.

3. Use the previously-shared (ManageSoft) backup file you just created, and restore it on the SQL Server
database identified for FlexNet Manager Suite 2019 R1 in your server plan. The default database name
(used in this document) is FNMSCompliance.

For details about restoring, see http://msdn.microsoft.com/en-us/library/ms177429(v=sql.100).aspx. You
will resume working on this database in Upgrade/Create Databases.

4. Using SQL Management Studio:

a. Connect to the SQL database server where your current Inventory Manager database is located
(the default name was ManageSoft), and select that database.

b. Choose File > Open, navigate in the database migration folder in your downloaded archive (such
as C:\Temp\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal), and
open IM92SchemaCleanup.sql.

c. Execute this SQL script on the ManageSoft database (or equivalent if you renamed this).
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This script removes tables, views, and functions that are related only to FlexNet Manager Suite, and
not needed for the continued operation of Inventory Manager.

You have now separated your previously combined databases, such that the previous one (default name
ManageSoft) carries forward for Inventory Manager data only, and the new copy (default name
FNMSCompliance) is used for FlexNet Manager Suite 2019 R1.
If, as well as the shared database, your previous implementation also had your compliance product
(Compliance Manager or FlexNet Manager Platform) and Inventory Manager installed on the same server, you
also need to remove the compliance product from this server, allowing it to roll forward as your Inventory
Manager server.
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3
Upgrading FlexNet Manager Suite

You have completed all the prerequisites in Prerequisites and Preparations (and its subsections). Depending on
your starting conditions, you have also separated any previously combined databases and cleaned up any co-
installation of FlexNet Manager Platform (or Compliance Manager) from what is now your Inventory Manager
server. Only when all these tasks are complete should you move forward to the upgrade of FlexNet Manager
Suite to 2019 R1.

Upgrade/Create Databases
Any existing compliance databases must be upgraded, and 2019 R1 uses additional mandatory databases.

Tip: Previously you have been working on Inventory Manager preparations. Now clear your mind of
anything to do with Inventory Manager. Keep in mind that FlexNet Manager Suite 2019 R1 also separately
manages its own inventory information in its own inventory database. In this procedure, we are concerned
solely with the databases for FlexNet Manager Suite 2019 R1, including its own inventory database. (Later, we
will configure Inventory Manager to be a data source feeding into the FlexNet Manager Suite inventory
database.) For the moment, then, nothing to do with Inventory Manager.

Important: If you are using Microsoft SQL Server 2016, ensure that at least SP1 has been installed. This
update addresses a defect in SQL Server that triggers a fatal error, as documented in
https://support.microsoft.com/en-au/help/3173976/fix-fatal-error-when-you-run-a-query-against-the-sys-
sysindexes-view-in-sql-server-2016.

Important: All database scripts use Unicode character sets to allow for necessary localization. This means
that:

• Any FTP transfer of these files must be in binary mode (not ASCII mode)

• The files must be edited only in editors that support Unicode character sets.

Failure to observe these precautions may result in failures in script operations.

Take note of all the database names you create with the -d parameter in the following steps. You need the
names later (if database setup is done by a separate DBA, the database names must be handed off to the
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installing administrator). While it is possible to create your own database names, using the default names
makes it easier to follow the rest of the documented processes.

Tip: There may be several accounts needing to log in directly to the application server for tasks related to
FlexNet Manager Suite, such as manipulating log files, scheduling tasks, and the like (this excludes access
through the web interface, which is not relevant to this discussion.) It is often convenient for these accounts to
have the same database permissions as the services account on all components of the operations databases:
compliance data, warehouse data, snapshot data, and inventory data. A suggested method is to create either
a local or Active Directory security group (such as FNMS Administrators) and add all such accounts to this
group. Then you can, for example, set these permissions by opening each database in Microsoft SQL Server
Management Studio, and granting the appropriate privileges to the security group. The procedures are
detailed in the topics covering database creation. Accounts to list in the security group minimally include:

• The operational service account (suggested: svc-flexnet)

• The installing administrator account (suggested: fnms-admin) for post-installation on-going administration

(remembering that db_owner membership is required temporarily during installation, as described in

Identify (or Set Up) Accounts)

• Any operational account needing to log in to a central inventory beacon installed on your batch server
(remember that, since the inventory beacon requires administrator privileges to run, this account is both a
local administrator on the batch server and a db_owner)

• Any future back-up administrator accounts needed for the application server.

Tip: Because you are migrating content from a previous 9.2 implementation (or earlier), it is mandatory that
you install an inventory beacon on the batch server component of your FlexNet Manager Suite central
servers. As mentioned above, the account that will access that central batch server also needs to be included
in this security group. For more about inventory beacons, see Deploy Inventory Beacons.

Note: If your databases are to run on Microsoft SQL Server 2016 SP1 or later, set the database compatibility
to a lower level for each database. If upgrading from an earlier version of a database, preserve its
compatibility level (100 or later, such as 110 for SQL Server 2012). For new database installations, set the
compatibility level for each database to SQL Server 2014 (120).

Important: If you have been using Flexera Analytics (powered by Cognos), be aware that Cognos may
acquire schema locks on objects within the operations databases of FlexNet Manager Suite. For this reason it
is important to stop the Cognos server before updating databases, and to restart it afterwards.

This procedure assumes that you are updating a previous database from 9.2. This may either be one that was
always separate, or one that you split in the procedure Splitting a Shared Database.

To upgrade (or create) databases as appropriate:

1. If your previous implementation included Flexera Analytics (powered by Cognos), stop the Cognos server.

2. Create a security group (suggested: FNMS Administrators), and (optionally) add to it all accounts
directly logging into the central application server (or you can add accounts later).
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3. In SQL Server Management Studio, ensure that the AD security group (suggested: FNMS
Administrators) has a secure login:

a. Under Security > Logins, create a new login.

The Select User, Service Account or Group dialog appears.

b. Use the Object Types... button to ensure that User, Group, or Built-in security
principal is selected as the object type.

c. Use the Locations... button to select your Active Directory domain.

d. As the object name, enter the name of your security group (suggested: FNMS Administrators),
and use Check Names to validate that the group name is found.

e. Click OK.

The newly added group is visible under the Security > Logins node. (You will use this group
after the creation of each database.)

4. Back up any customized files to a temporary location, (for example, C:\temp).

Customized files may include compliance importer procedures (XML files located by default in
installation_dir\Compliance\ImportProcedures from 8.0 onwards, or for earlier releases, check in
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sourceprocedures.xml).

5. Ensure that the target database instance is set for case-insensitive and accent-sensitive collations (as
required by all databases in this system). To check the collation settings at the server level:

a. In SQL Server Management Studio, locate the SQL Server instance in the Object Explorer pane.

b. Right-click the server, and select Properties from the context menu.

c. On the server Properties dialog, select the General tab, and check the current collation sequence.

If the collation sequence includes the codes _CI_AS (for example, SQL_Latin1_General_CP1_CI_AS),
you may proceed with the installation.

Tip: Other suffixes like _KS or _WS are optional.

If the server's default collation does not include _CI_AS, you can set the collation sequence for each
database, as you create it, by right-clicking the new database, selecting Properties from the context
menu, and choosing the collation on the Options tab. Remember that the collation sequence must be
identical for:

• The compliance database (suggested name: FNMSCompliance)

• The reporting snapshot database (suggested: FNMSSnapshot)

• The data warehouse database (suggested: FNMSDataWarehouse).

For example, if the first of these has the collation sequence called SQL_Latin1_General_CP1_CI_AS,
then all of them must have the exact same collation sequence. In contrast, the inventory database, when
separate (suggested: FNMSInventory), and the Cognos content store may have different collation
sequences, provided that these also include the same _CI_AS codes. The tempdb database (alone) may
have any collation sequence, since FlexNet Manager Suite creates the required tables here with the
appropriate collation sequence.

6. Wherever possible, use SQL Server Management Studio to ensure that the database Recovery model is
set to Simple (first recording its current value before changing it if necessary).

a. In SQL Server Management Studio, right-click the database, and select Properties from the
context menu.

b. Select the Options tab.

c. Check that Recovery model is set to Simple (or note its current value, change it to Simple, and
click OK).

Especially for large databases, this prevents the transaction log from growing to excessive proportions.
Because of this growth, for databases of all sizes, the migration process will truncate the transaction log
at the end of the process, and this truncation relies on the simple Recovery model. If the model is not
currently Simple, note the existing value — there is a reminder below to restore this value after a
successful database migration.

Note: In some cases it is not possible to set the Recovery model to Simple, such as when you are
using Availability Groups. In these cases, it is critical to allow sufficient space for the transaction logs to
expand dramatically — as a general guideline, to 2-3 times the disk space currently used by your
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FlexNet databases. It is also important to remain vigilant during database migration, monitoring both
the remaining available space as well as the rate at which the logs are growing. Finally, after
processing each individual database, consider truncating the transaction logs before proceeding to the
next one; and truncate again after the final database is processed.

7. Ensure that you have sufficient disk space on the database server for a complete second copy of your
database during migration.

Tip: When considering disk space, keep in mind that FlexNet Manager Suite 2019 R1 requires the
following mandatory databases, at least two of which are new since your 9.2 implementation:

• Its own inventory database, suggested name FNMSInventory

• FNMSSnapshot, used for performance improvement particularly relating to reports

• FNMSDataWarehouse (this may have been present in the 9.2 implementation, where it was an

option; but in 2019 R1 it is a requirement).

If space seems tight, before starting migration you can use Microsoft SQL Server Management Studio to
allow for additional data files on a different drive (for details, see https://msdn.microsoft.com/en-

us/library/ms189253.aspx). If this is done and the primary drive runs out of space during the
upgrade, Microsoft SQL Server automatically uses space on the second drive to complete the process.

8. If you have not already done so, login to the central application server with a privileged account
(suggestion: db-admin) that has the privileges described in Identify (or Set Up) Accounts.

9. If you cannot access your downloaded and unzipped archives from your current login on this application
server, copy Database Migration to FNMS 2019 R1.zip to this server and unzip it to a convenient
location, such as C:\temp\FNMSUpgrade.

10. Create the database for FlexNet native inventory collection.

Remember: If you plan to collect both inventory data and compliance data in a single database, use
the same -d FNMSCompliance name parameter for this and the compliance databases; or for a
separate inventory database (recommended), use a different name as shown below.

Tip: To avoid typos, you may want to copy all five of the following command lines into your ASCII text
editor, globally search for and replace the placeholders DBserver-name\instance name with the name
of your SQL Server and your database instance (where that is not the default instance), and then copy/
paste each modified command line when required.

Important: Be very careful with copy and paste. Some tools "helpfully" convert a pasted minus (dash,
or hyphen) character to something else, perhaps from an extended character set. Such substitutions will
cause the command line to fail.

a. On the database server (or the application server for a single-server implementation), open a
command prompt.

Tip: If your console window is in QuickEdit mode (visible in the Properties for the window),
simply clicking in the window when it already has focus puts it into Mark or Select mode. In
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such a mode, a process that is writing to the window is paused, awaiting your input. Beware of
unintentionally pausing database migration by extra clicking in this command prompt. A
process that has been paused in this way is resumed when the window already has focus and
you press any key.

b. Navigate in the unzipped archive to the FlexNet Manager Suite\Database\Normal\FlexNet

Manager Platform folder. (The database creation scripts can be run from a mapped network
drive.)

c. Execute the following (replacing the placeholders DBserver-name\instance name with the name of
your SQL Server and your database instance):

Note: The command-line switches (as usual), and the WindowsNT argument, are case sensitive.

mgsDatabaseCreate -a WindowsNT -s DBserver-name\instance name -d

FNMSInventory -i InventoryManagerDatabaseCreation.xml

Wait for completion before proceeding.

d. Open this database in Microsoft SQL Server Management Studio, expose the Security > Users

node, right-click and choose to create a new user.

e. In the Database User - New dialog, set the User type to SQL user with login, and enter a User
name (for example, call it FNMS Administrators as well).

f. Next to the Login name field, click the ellipsis (...) button, and use the Select Login dialog to
select your Active Directory security group (suggested: FNMS Administrators). Click OK to close
both dialogs.
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g. For your newly-added user, right-click and select the properties, and select the Membership page.
Check the db_owner role, and click OK .

h. Strongly recommended for SQL Server 2016 SP1 or later: Set the compatibility level on this
database to SQL Server 2012 (110) or SQL Server 2014 (120).

11. In the Command Prompt window, navigate to your working copy of the migration folder (such as
C:\Temp\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal).

This folder contains the mgsDatabaseUpdate.exe program that you now use to create your new
compliance database (suggested name: FNMSCompliance) by migrating from the old database.

12. Run the mgsDatabaseUpdate.exe program, using the following syntax:

mgsDatabaseUpdate.exe -i ComplianceMigration.xml -nsu -l <logFile>

[-s <serverName>[\<instanceName>]] [-d <databaseName>] [-u <userName>] [-p

<password>]

where:
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-d <databaseName> The name of the database to connect to. A suggested name is
FNMSCompliance.

Note: If you are currently operating from a new application
server that has not previously connected to the database server,
this parameter is mandatory. If you are upgrading an existing
application server that has separately run your compliance
product (not in co-location with Inventory Manager), the registry
entry listed below for the -s option is normally set. In this case, if
you omit the -d option, the database name is taken from the
registry key.

-i ComplianceMigration.xml This is the configuration file describing the migration tasks, and is
of course mandatory.

-l <logFile> Identifies the path and name of the file to receive a log of the
migration tasks that occurred. If this option is not specified, a log
file called ComplianceMigration.log is created in the same
folder where the executable is running.

-nsu Run the database update without putting the database into single
user mode. (The steps to perform migration require that multiple
connections are made.)

-p <password> The password for the username specified with -u. This is only
required if the database server is configured to use SQL Server
authentication.

-s <serverName>

or
-s

<serverName>\<instanceName>

The name of the database server to connect to. If -s is not
specified, the value at HKEY_LOCAL_MACHINE\SOFTWARE\
Wow6432Node\ManageSoft Corp\ManageSoft \Reporter\

CurrentVersion\DatabaseConnectionString is used. The
registry key is present on the compliance and inventory servers. (If
you have chosen to run this script on the database server itself, the
registry entry is not available, and you must therefore specify the
server name, or use the dot notation [.] to refer to the current
server.)
If the database is in a named instance (and not in the default
database on the server), the instance name must be specified as
well.

-u <userName> The username with which to connect to the database. This is only
required if the database server is configured to use SQL Server
authentication. If not specified, Windows Integrated Authentication
is used to connect to the database server using the current user’s
credentials.

Tip: It is normal for the migration to appear to "pause" at about the 80% mark. At this point the
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database is busy restructuring for local evidence for applications, and it requires time.

Example: The following command performs the migration using the standard configuration file. Instead
of recording the log in the default log file, it will be written to the mig.log file specified in the command.
Because the upgrade is running on a new server, the database server name (and, if required, instance
name) and database name must be specified, and Windows Authentication is used to log in as the
account name running the executable.

mgsDatabaseUpdate.exe -i ComplianceMigration.xml -nsu -l mig.log -s MyDBServer\

thisInstance -d FNMSCompliance

Check messages on the command line to confirm that the database migration was successful. If any error
messages occur, check the log file to troubleshoot the problem. Do not proceed to the next step until the
database migration is successful. For more information about database validation and remedies, see
Database Validation.

Tip: If, after migration is complete, the database size still seems much larger than before, ask your
database administrator to check whether there is a significant amount of unused space in the database
files (using Microsoft SQL Server Management Studio). If so, a database shrink operation can reclaim
this unused space.

13. If you are processing a copy of a previously-shared database that you split, open your newly-migrated
compliance database in Microsoft SQL Server Management Studio, and complete the following steps.

Warning: Do NOT start this until after you have completed the database migration described in the
previous step. If you run this prematurely, your migration will fail (because expected database elements
are missing after these clean-up steps). Migrate first (step 12), and only after that, clean up the result.

a. Grant db_owner privileges to the security group (suggested: FNMS Administrators).

b. Choose File > Open, navigate in the database migration folder in your downloaded archive (such
as C:\Temp\FNMSUpdate\Database Migration\FlexNet Manager Platform\Normal), and
open FNMP92SchemaCleanup.sql.

c. Execute this SQL script on the FNMSCompliance database.

This script removes tables, views, and functions that are related only to Inventory Manager, and not
needed for the upgrade of this database to FlexNet Manager Suite 2019 R1.

d. If you previously changed the setting for the database Recovery model, restore the original value
now.

14. Strongly recommended for SQL Server 2016 SP1 or later: Set the compatibility level on this database to
SQL Server 2012 (110) or SQL Server 2014 (120).

15. Optionally, re-index the compliance database.

For details, see Re-Indexing a Database.

Note: Up until (and including) release 9.2 of FlexNet Manager Platform, it was an option to have the
data warehouse database for trend-based reporting (reports built in Flexera Analytics, powered by
Cognos). While Cognos remains optional, the data warehouse database is now mandatory, and is used
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by new reporting functionality within FlexNet Manager Suite 2019 R1.

16. Do one of the following:

• If your prior implementation included the data warehouse database (you copied it to the planned SQL
Server in Splitting a Shared Database), migrate it now on its new SQL Server instance (running the
mgsDatabaseUpdate.exe program again with different parameters):

mgsDatabaseUpdate.exe -i DataWarehouseMigration.xml -nsu -d FNMSDataWarehouse
[-l logFile]

[-s serverName\instanceName]

[-u userName]

[-p password]

Important: In this instance, the database name (-d parameter) is mandatory. (The suggested value
is shown, which you should customize if your database name is different.)

Check messages on the command line to confirm that the warehouse migration was successful. If any
error messages occur, check the log file to troubleshoot the problem. Do not proceed to the next step
until the migration is successful. For more information about database validation and remedies, see
Database Validation.

• If your prior implementation did not include the data warehouse database, it is now mandatory,
whether or not you are using Cognos at this time. In the same archive folder, execute:

mgsDatabaseCreate -a WindowsNT -s DBserver-name\instanceName -d

FNMSDataWarehouse -i DataWarehouseCreation.xml

17. Open the data warehouse database in Microsoft SQL Server Management Studio, and grant db_owner
privileges to the security group (suggested: FNMS Administrators).

18. Strongly recommended for SQL Server 2016 SP1 or later: Set the compatibility level on this database to
SQL Server 2012 (110) or SQL Server 2014 (120).

19. Create a snapshot database (used for performance optimization):

a. In the same archive folder, execute:

mgsDatabaseCreate -a WindowsNT -s DBserver-name\instance name -d

FNMSSnapshot -i SnapshotDatabaseCreation.xml

b. Open this database in Microsoft SQL Server Management Studio, and grant db_owner privileges to
the security group (suggested: FNMS Administrators).

c. Strongly recommended for SQL Server 2016 SP1 or later: Set the compatibility level on this
database to SQL Server 2012 (110) or SQL Server 2014 (120).

20. If you began this process by stopping your Cognos server, you may restart it now.

For more information about database validation and remedies, see Database Validation.
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Re-Indexing a Database
When updating the databases used by FlexNet Manager Suite, consider whether this is also the time to re-
index the databases. Take into account the following factors:

• Re-indexing increases data access speed and recovers wasted disk space.

Tip: It is a good idea to re-index your database at least once a year. In SQL Server, tables that do not
have clustered indexes do not automatically reclaim space from deleted records. Re-indexing will reclaim
this space.

• Re-indexing is especially important if you have a lot of records in history tables. For example, in the
inventory database, check the Installation and InstallationHistory tables.

• Re-indexing is very demanding for SQL Server. You should only ever attempt a re-indexing of one database
at a time. It is also good practice to schedule this out of production times, such as overnight or on a
weekend.

• On large databases, this process can take more than 24 hours.

There is no requirement that you must re-index at this time: you may prefer to complete the current processes
and schedule re-indexing at appropriate times soon. However, your current process is an excellent trigger for
planning a regular schedule for re-indexing, say one or twice a year.

FlexNet Manager Suite provides a re-indexing script that can be applied to the following databases:

• The compliance database (suggested name: FNMSCompliance)

• The inventory database (suggested name: FNMSInventory)

• The data warehouse database (suggested name: FNMSDataWarehouse).

(There is little benefit in re-indexing the snapshot database (suggested name: FNMSSnapshot), as this is
effectively cleaned up each time a snapshot is saved.)

Important: Do not apply the script to the Report Writer Content Store. This is a database designed by
Cognos and not aligned with the reindexing script from Flexera.

To re-index one of the FlexNet Manager Suite operations databases (optional):

1. Start SQL Server Management Studio.

2. Open the appropriate copy of ReIndexAll.sql ( File > Open... and browse to the appropriate file listed
below).

• For the inventory database, look in Database Migration\Inventory Manager

• For the compliance database, look in C:\temp\FNMSUpate\Database Migration\FlexNet

Manager Platform\Normal.

3. Click the Execute Query tool, or press F5 to run the script.

Keep in mind that the re-indexing may take a considerable time, depending on the size of your database.
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Database Validation
Database migration includes a number of checks on the quality of the resulting database.

The first of these is a check of database constraints that may have been either enabled or disabled without
data checks. If constraint errors are detected, the migration process corrects them. Where a constraint is
enabled, the process also attempts to ensure that the data it covers is appropriate for the constraint.
Generally, this succeeds without issue, and the change is simply noted in the migration log. However, if it fails,
the migration process also fails with an error similar to:

ERROR: One or more constraints cannot be enabled (step number 99).

If this occurs, the names of the constraints that cannot be enabled are listed in the migration log. Restarting
the migration at this time does not help this issue, and the database is unusable for production work. First, a
database administrator or a Flexera support engineer must manually correct the issue with the underlying
data. Once the data has been corrected, the migration process will be able to be restarted safely.

At the end of the migration process, there is a final schema check of the upgraded database to ensure that
the upgrade has been successful. Messages from this database check may appear in your console towards the
end of the process, after the migration itself is completed.

This check is included for the three main system databases: the compliance database, the inventory database,
and the data warehouse database.

When these checks are run, the upgrade has already been completed without errors, and the database is
likely to be usable. These are additional checks to look for irregularities in the database that may cause future
operational problems. These kinds of irregularities may occur because:

• The earlier database had previously been changed (either by database administrators or by a Flexera
consultant) in ways that are not supported by the product

• A previous migration updated the database in ways that were not entirely correct, but not previously
detected

• Something has occurred in the present migration that did not raise an error in the migration, but leaves the
database in a less than perfect condition.

Such causes can produce a range of possible issues, including:

• Missing tables, indexes, columns, or foreign keys

• Extra indexes, columns or foreign keys

• Incorrectly configured columns (the size differs, or their nullability)

• An index configured in unexpected ways, either in its uniqueness, its clustering status, or in the columns it
covers.

For the above cases, assistance from a database administrator or Flexera support engineer is also required to
correct the schema. In many cases, the issues described in the log can be remedied in place, without requiring
that the database migration process is restarted.
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Authorize the Service Account
The account used to run processing services requires permission to run as a service. Prior to installing anything,
perform this process on:

• Your batch server/reconciliation server (in a large-scale implementation with three servers)

• Your processing server (in a two server application implementation)

• Your application server (in a single server implementation).

To authorize the service account:

1. On the appropriate server, log in as an administrator (suggested: fnms-admin).

2. Go to:

• On Windows Server 2012, Start > Administrative Tools > Local Security Policy

• On earlier releases of Windows Server, Start > All Programs > Administrative Tools > Local
Security Policy.

3. Select the Local Policies node, and choose User Rights Assignment.

4. Open the policy Log on as a service, and add the service account (example: svc-flexnet).

5. Open the policy Log on as a batch job, and add the service account (example: svc-flexnet).

6. Click OK.

Tip: A Microsoft error dialog Security Templates - An extended error has occurred.

Failed to save Local Policy Database. may appear. This error is described at
http://support.microsoft.com/kb/2411938, and may safely be ignored.

Install the Web Interface
The web interface provides the user interface to manage your inventory and license position. Continue this
process as administrator (fnms-admin) on either your:

• application server (for a single server installation); or

• web application server (in a multi-server installation).

Note: Are you installing on the same server that was previously a separate administration server for FlexNet
Manager Platform 9.2 (or an earlier compliance product), where Inventory Manager was not co-located on
the same server? If so, you should now uninstall the previous version of the product so that you remove the
MMC interface, deprecated from version 2014 R2. To do so:

1. On the application server, open Program and Features (Control Panel > Uninstall a Program).

2. Uninstall FlexNet Manager Platform (or your earlier compliance product, such as Compliance Manager),
and then close Program and Features.
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3. Open Windows Task Scheduler and delete the scheduled task called Execute business importer

connections.

Tip: The web interface transfers high volumes of HTML data, which may have noticeable performance
impacts for operators with slow links (such as across a WAN) between their web browsers and the web
application server. To maximize performance, the web.config file installed on this web application server
turns on both static and dynamic content compression, with a setting of this form:

<urlCompression doStaticCompression="true" doDynamicCompression="true" />

These settings turn on compression settings for IIS, where these are available on the web application server:

• Static compression is installed by default for IIS.

• Dynamic compression requires a standard Microsoft installation to enable it. (Without this setup, the
dynamic compression setting in the web.config file remains latent, having no possible effect.)

If you have operators on slow (WAN) links, check whether dynamic compression is already available on your
web application server by examining the Server Manager, using the Add Roles and Features wizard. If it is
not yet configured, see https://docs.microsoft.com/en-us/iis/configuration/system.webServer/
urlCompression#setup for installation details.

To install the web interface for FlexNet Manager Suite:

1. On the (web) application server, open Windows Explorer.

2. Copy the downloaded archive FlexNet Manager Suite 2019 R1 Installer.zip from your staging
location to a convenient location on this server (such as C:\temp), and unzip it.

Tip: Unzipping the archive locally on each of your servers simplifies running the configuration scripts
later in the process. After running the installers, PowerShell scripts need to be Run as

Administrator. Notice that the entire archive must be present, as scripts reference other elements
from the archive.

3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager

Suite folder.

4. Start (double-click) setup.exe.

Tip: You must start the installation by running setup.exe, rather than running the MSI by any other
means. The setup file also installs Visual C++ 2010 Redistributable (if it is not already present), which is
a prerequisite for integration with FlexNet Manager for SAP Applications.

5. Step through the installer until asked for the Setup Type, and do one of the following:

• For a small, single server installation combining the web application, the inventory collection, and the
batch processing functionality in one server, select the Complete option, and follow the instructions in
the installation wizard to complete the standard installation.
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Tip: In the page where you are asked for the batch process credentials, for Server type, choose
either Production for your main server installation, or Failover if this is a stand-by or testing server.
On your Production server, the batch scheduler and batch processor are automatically started as
part of the installation process, while on a Failover server, both are disabled by default. If you need
to switch between your production and stand-by servers, you must manually:

◦ Disable the batch scheduler and processor on the product batch server

◦ Enable the batch scheduler and processor on the standby batch server.

These adjustments are made in the Microsoft Services control panel.

• For a multi-server installation, select the Custom installation path, and select the Web application
server for this installation. (If this is the only functionality on this server, also ensure that Inventory
server, Batch scheduling server, and Batch server are all deselected; but in fact you can combine
most servers in the way that best suits your enterprise, so make the selection that matches your server
plan.)

Take note of the installation location for future reference.

6. If this is a separate installation of the web application server in a multi-server implementation, ensure that
from this server you can access the network shares that you configured in Configure Network Shares for
Multi-Server.

7. If this server includes the batch server functionality, you are prompted for the credentials used for batch
processes. Be sure that the account you enter already has Logon as a service permission (see
Authorize the Service Account).

8. When successful, close the installation wizard.

Install the Inventory Server
The inventory server processes all inventory collected (or augmented) by the FlexNet inventory agent.

In a single server implementation, this step is already completed and you should skip ahead to Configure the
System.

For a multi-server implementation, continue this process as administrator (fnms-admin) on either your:

• processing server (in a two server application installation); or

• inventory server (in a three or more server application installation).

To install the inventory server software:

1. On the inventory (or processing) server, open Windows Explorer.

2. Copy the downloaded archive FlexNet Manager Suite 2019 R1 Installer.zip from your staging
location to a convenient location on this server (such as C:\temp), and unzip it.

3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager

Suite folder.
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4. Start (double-click) setup.exe.

Tip: You must start the installation by running setup.exe, rather than running the MSI by any other
means. The setup file also installs Visual C++ 2010 Redistributable (if it is not already present), which is
a prerequisite for integration with FlexNet Manager for SAP Applications.

5. Select the Custom installation path, and do one of the following:

• For a two server installation, now installing your processing server, select all of the Inventory server
and the Batch scheduling server for this installation, and ensure that the Web application server is
deselected (displaying a cross).

• For an installation using three or more servers, now separately installing your inventory server, select
only the Inventory server for this installation, ensuring that the other options are deselected.

Take note of the installation location for future reference.

6. If this server includes the batch server functionality, you are prompted for the credentials used for batch
processes. Be sure that the account you enter already has Logon as a service permission (see
Authorize the Service Account).

7. When successful, close the installation wizard.

Install the Batch Server
The batch server is the integration point that correlates all your entitlement records and your consumption
revealed in inventory to work out your reconciled license position.

You do not need this process if you have either of:

• A single-server implementation combining the web application server, the batch server, and the inventory
server in one; or

• A two-server application implementation where you have combined the batch server and inventory server
functionality on one computer and kept the web application server as a second server.

In these two cases, this step is already completed and you should skip ahead to Installing a Free-Standing
Studio.

For a three server implementation, continue this process as administrator (fnms-admin) on your batch server.

Tip: Currently MSMQ limits the hostname of the batch server to 15 characters (excluding the domain
qualifier).

To install the batch server:

1. On the batch server, open Windows Explorer.

2. Copy the downloaded archive FlexNet Manager Suite 2019 R1 Installer.zip from your staging
location to a convenient location on this server (such as C:\temp), and unzip it.
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3. Navigate in the unzipped archive to the FlexNet Manager Suite\Installers\FlexNet Manager

Suite folder.

4. Start (double-click) setup.exe.

Tip: You must start the installation by running setup.exe, rather than running the MSI by any other
means. The setup file also installs Visual C++ 2010 Redistributable (if it is not already present), which is
a prerequisite for integration with FlexNet Manager for SAP Applications.

5. Select the Custom installation path, and select only the Batch scheduling server for this installation,
ensuring that the other options are deselected (displaying a cross).

Take note of the installation location for future reference.

6. When asked to enter the credentials to be used for running batch processes, be sure that the account you
enter already has Logon as a service permission (see Authorize the Service Account).

7. On the same page of the wizard, for Server type, choose either Production for your main server
installation, or Failover if this is a stand-by or testing server.

Tip: On your Production server, the batch scheduler and batch processor are automatically started as
part of the installation process, while on a Failover server, both are disabled by default. If you need to
switch between your production and stand-by servers, you must manually:

• Disable the batch scheduler and processor on the product batch server

• Enable the batch scheduler and processor on the standby batch server.

These adjustments are made in the Microsoft Services control panel.

8. For the batch processor, you are asked to identify the folder where intermediate packages (uploaded from
inventory beacons) are saved prior to processing. The default location is %ProgramData%\Flexera
Software\Beacon\IntermediateData. This default is formed by appending IntermediateData to the
value of the base directory saved in HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ManageSoft Corp\

ManageSoft\Beacon\CurrentVersion\BaseDirectory. This base location is also used by other
processes, and should be changed only with care.

Tip: A second folder, a network share, is used for handing off files uploaded through the web interface
(such as inventory spreadsheet imports) for processing by the batch server. For this share, the default
path is %ProgramData%\FlexNet Manager Platform\DataImport, and the path is saved in the
registry at HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ManageSoft Corp\ManageSoft\
Compliance\CurrentVersion\DataImportDirectory. There is also a parallel folder for data
export. For implementations that separate the web application server from the batch server, these
shares must also be configured and accessible from both servers. For more information, see Configure
Network Shares for Multi-Server.

9. When successful, close the installation wizard.
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Installing a Free-Standing Studio
You can install additional copies of the Business Adapter Studio.

There are two kinds of Studio. Adapters can be created or modified using either the Inventory Adapter Studio
or the Business Adapter Studio (each for its appropriate type of adapter). Each time that you install an
inventory beacon, copies of each of the Business Adapter Studio and the Inventory Adapter Studio are installed
ready for use on the inventory beacon. These versions are configured exclusively for disconnected mode,
where they cannot directly access your central database.

However, sometimes you want to work in connected mode, with direct access to your central database (for
example, to write data into staging tables and manipulate it). For these cases:

• The Inventory Adapter Studio is also available on the web application server (or, in smaller implementations,
the server providing that function). This works in connected mode.

• You can co-install an inventory beacon on your web application server. As always, this also installs the
Business Adapter Studio, giving it (and adapters built there) additional privileges to access your central
database in connected mode.

In addition, it is also possible to install a free-standing copy of the Business Adapter Studio (only) on your
central application server. (If you have scaled up to several central servers, such an installation can be on
whichever server suits you. The default location is indicated below.) Business adapters installed directly on your
central server(s) operate in connected mode, with full access to your central database. Obviously, attempt this
only if you are very confident and well informed about details of the database schema.

Tip: It is not possible to install addition free-standing copies of the Inventory Adapter Studio.

Start this procedure using a web browser on the server where you will install the Business Adapter Studio, or a
computer that provides easy and fast network access from your central server.

To download and install an additional instance of the Business Adapter Studio:

1. Use your browser to access the Flexera Customer Community.

a. On https://flexeracommunity.force.com/customer/CCLanding, use the account details emailed to
you with your order confirmation from Flexera to log in (using the Login link in the top right).

Tip: Access requires your Customer Community user name and password. If you do not have
one, use the Request Community Access link on the login page to request one. Your
credentials are configured for access to content you have licensed.

b. Select the Downloads tab from the row across the top of the page.

A routing page appears to let you Access Product and License Center, displaying lists of
products from Flexera.

c. In the lists of products, identify FlexNet Manager Platform, and click the Access Above Products
button that is below that product name.

The Product and License Center site is displayed.
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d. In the Your Downloads section of the Home page, click the link for FlexNet Manager Platform.

e. In the Download Packages page, click the link for FlexNet Manager Platform 2019 R1 to access
the downloads. (You may need to repeat this action on a second page to access the downloadable
files.)

2. In the list of components to download, select Business Adapter Studio releaseNumber.zip, and
download and save it to a convenient location (such as C:\Temp).

3. In Windows Explorer, navigate to the downloaded archive, right-click, and choose Extract All.

4. Navigate into the unzipped archive, and double-click setup.exe, following the instructions in the
installation wizard.

The Business Adapter Studio may be installed on any of your central servers (in a multi-server implementation).
The installer assesses the installation paths, and installs itself in the installation folder of FlexNet Manager Suite.
The defaults are as follows:

• The Business Adapter Studio executable: BusinessImporterUI.exe

• Default installation path (in connected mode on central server): C:\Program Files (x86)\Flexera

Software\FNMP Business Adapter Studio

• No template file storage is required for the Business Adapter Studio in connected mode, as it validates the
database schema directly. Your custom business adapters may be saved in the folder(s) of your choice.

When you have completed the remainder of your product installation, the Business Adapter Studio can be run
from the Windows start menu on this server; and the Business Importer, which is also installed automatically
with the Business Adapter Studio, is also available for execution on the command line. For details about the
Business Adapter Studio, see online help or the FlexNet Manager Suite 2019 R1 System Reference PDF; and for
details about the Business Importer, see the Using FlexNet Business Adapters PDF. Both PDF files are available
through the title page of online help.

Installing Flexera Analytics
Flexera Analytics provides interactive reporting for software and hardware asset management.

Important: Flexera Analytics uses IBM Cognos version 11.0.11 (or later) as the underlying technology for
these reports. Your license for FlexNet Manager Suite includes terms for Flexera Analytics, by default
authorizing one Analytics Administrator and 60 Analytics Users (for license installation, see (Re-)Activate the
Product).

See the FlexNet Manager Suite 2019 R1 Release Notes for supported platforms and database versions.

Flexera Analytics has the following components:

• Analytics — Flexera Analytics is an interactive means for you to explore and create customized reports and
dashboards, and easily share these with anyone in your organization.

• Content Store Database — The Content Store is a relational database used by the Flexera Analytics to store
information about reporting models, folders, reports, and saved results. You should have already completed
setting up this database (see Create Databases).
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Once you have confirmed that all pre-requisites have been met, installation of Flexera Analytics is performed
using the following steps:

1. Install and configure a supported web server

2. Copy the Flexera Analytics installation media, and install Flexera Analytics

3. Configure Flexera Analytics by populating an answer file with settings appropriate to your environment,
and then implement the configuration, using PowerShell

4. Configure your web server to connect with Flexera Analytics

5. Update your Roles to enable access

6. Ensure that your web browser(s) include your web server in the list of trusted web sites

7. Optionally, you may need to configure your Security Assertion Markup Language settings.

Prerequisites

The IBM Cognos Analytics installer installs Flexera Analytics to the designated host as a service. Therefore, the
account used to install this component must have administrator permissions.

Make sure of the following points:

• The installing account must have administrative privileges on the Cognos server (the server hosting Flexera
Analytics).

• The Flexera Analytics server must be accessible by its host name, rather than just its IP address. Do not use
IP addresses anywhere in the Flexera Analytics settings.

• For performance reasons, Flexera Analytics is best installed on a separate server (it has high memory use
requirements). (Refer back to Prerequisites and Preparations for server design details.) When Flexera
Analytics is installed on a server other than the database server running the content store database,
Microsoft SQL Server Native Client must be installed on the server hosting Flexera Analytics. To download
and install the Microsoft SQL Server Native Client installer (subject to changes in the Microsoft website):

1. In your web browser, navigate to https://www.microsoft.com/en-us/download/details.aspx?id=29065.

2. Expand Install Instructions to display the available components of the Microsoft SQL Server® 2012
Connectivity Feature Pack.

3. Scroll approximately half-way down the page to the heading Microsoft® SQL Server® 2012 Native
Client and install the X64 (64-bit) version of the Native Client found there.

• The Flexera Analytics server must be in the same time zone as your database server(s).

• When you install Flexera Analytics, the required usernames and passwords can be encrypted, using a
credential store. Refer to Installing Flexera Analytics for further information. Alternatively you may choose to
use clear text usernames and passwords in the answer file.

• Flexera Analytics can be configured to use https, however you will need to use http for installation and
configuration.

• The password for the SQL Server login account used by Flexera Analytics must not contain any of the
greater-than, less-than, or ampersand characters (< > &).

• Do not attempt to use Flexera Analytics (nor any related reports saved in FlexNet Manager Suite) before
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importing the correct license file from Flexera (see (Re-)Activate the Product).

Important: Do not allow consultants to use their 'normal' login when they develop reports on your behalf. A
common user account should not be switched from one Flexera Analytics tenant to another. Otherwise, any
reports saved under My Folders for that account are automatically removed by Flexera Analytics as the user
account switches between tenants (or customers). For details, see http://www-01.ibm.com/support/
docview.wss?uid=swg21682369. "For safety, ensure that each consultant uses a login that is unique to your
company (such as johnEnterprise); or as a workaround, save their developed reports under Public Folder".

Before you start, decide whether you want the benefit of content compression for your Flexera Analytics server.
By default, the web.config file installed on this server turns on both static and dynamic content compression,
with a setting of this form:

<urlCompression doStaticCompression="true" doDynamicCompression="true" />

Static compression is installed by default for IIS, but dynamic compression requires a standard Microsoft
installation to enable it. (Without this setup, the dynamic compression setting in the web.config file remains
latent.) You can check whether dynamic compression is available in the Server Manager, using the Add Roles
and Features wizard. If it is not yet configured, see https://docs.microsoft.com/en-us/iis/configuration/
system.webServer/urlCompression#setup for installation details.

Installation

To install Flexera Analytics:

1. Install, configure, and test a supported web server.

• Refer to the FlexNet Manager Suite 2019 R1 Release Notes for a list of supported web servers. Refer to
the installation, configuration, and testing documentation provided by the web-server vendor.

• If you choose to use Microsoft IIS as your web server, the installer for Flexera Analytics includes a
PowerShell script to apply appropriate configuration. (You need access to the downloaded unzipped
archive of the FlexNet Manager Suite installer to access this PowerShell script.)

2. Flexera Analytics Installation

a. If you are installing FlexNet Manager Suite and Flexera Analytics on separate servers, first copy the
<FNMS Media>\FlexNet Manager Suite\Support directory from the application server to
C:\FNMSCognosAnalytics on the Flexera Analytics server. If you are performing a single server
installation, then the support folder should already be located on the application server.

b. From the support folder, copy the file ca_server_win64_11.0.11.exe to your Flexera Analytics
server.

c. Double-click on this executable file to launch it, and work through the installation wizard panels as
described in the following table.

Tip: The executable automatically installs 32-bit software on 32-bit systems, and 64-bit software on
64-bit operating systems.
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Panel Details

Splash screen Select Installation language, then click Next.

Product Install Select the IBM Cognos Analytics radio button option, then click Next.

License Agreement • If you agree to be bound by its terms, select the I accept the terms of
the license agreement check box.

• If you do not accept the terms of the license, you must stop the
installation process. Do not proceed further in this case.

Location Specify the installation folder for the Flexera Analytics. You can enter a path
manually in the Installation Folder field, or browse for a location using the
Choose... button. If you make a mistake and wish to return the initial folder
suggested by the installer, click the Restore Default Folder button.

Once an installation folder has been specified, click Next. If the folder does
not exist a popup dialog will appear asking if you want to create it during
the installation.

Click Yes to process or No to specify a different installation location.

Note: Spaces in the installation path are acceptable in the command
line; but if you are scripting the installation, be sure to enclose the entire
path-with-spaces in double quotation marks.

Install type Select the Custom radio button, and click Next.

Note: The Custom option is required so that the Gateway component is
installed.

Custom install Select First install, and click Next.

Choose components Select the following options:

• Content repository

• Application services

• Optional gateway

Credentials Create a Flexera Analytics administrator account, and keep a record of the
user ID and password that you create.

Note: The password must contain a minimum of 1 uppercase character,
1 lowercase character, 1 digit, 1 special character among !@#$ and the
length is between 8 and 20 characters.
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Panel Details

Pre-installation
summary

Review the choices you made, and click Previous to move back through the
wizard and make any amendments. Once all seems correct, click Install to
begin the installation process.

A progress bar illustrates the status of the installation. Once the installation
is complete, click Done to close the wizard.

3. You will now configure Flexera Analytics by editing the file C:\FNMSCognosAnalytics\Support\

CognosConfigProperties.xml using Notepad (or an equivalent text editor). Fill out the values for the
parameters listed in the following table, using the guidance from the description and examples provided.

Property/Example Description

CredentialStoreLocation

C:\user\customstore.xml

A custom credential store location.

If this parameter is omitted, the value defaults to
fnms.password.store.xml under the logged in
user profile directory.

FNMSBatchServerLocation

http://BatchServer1.company.com

The URL of the FlexNet Manager Suite batch
server.

ContentStoreDatabaseLocation

DBServer1\Instance1

When using TCP, the format for this value is
hostname:port. Alternatively, the hostname\

instancename format (without a port) can be
used. Flexera Analytics does not allow the instance
name to be Default or MSSQLServer. The SQL
Server Browser service needs to be started if using
the instance name format.

ContentStoreDatabaseName

ContentStore

This is the name of your Cognos content store
database.
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Property/Example Description

ContentStoreDatabaseUsername

Typically empty

Optional setting when providing credentials for
SQL Server authentication. Leave this value blank
to use Windows Authentication.

Note: If you have restored a backup of your
existing content store to use with a new
version of Flexera Analytics, ensure that this
user has the following permissions on the
database:

• Create and Drop table privileges.

• Member of the db_ddladmin,

db_datareader, and db_datawriter

roles.

• Must be the owner of the default schema on
this database.

Tip: This schema usually is named
FlexNetReportDesignerSchema.

ContentStoreDatabasePassword

Typically empty

Optional setting when providing credentials for
SQL Server authentication. Leave this value blank
to use Windows Authentication.

ContentStoreDatabaseStoreReference

flexera://storeUser

The credential store reference for ContentStore
database user identity.

If the ContentStoreDatabaseStoreReference

property is specified then the
ContentStoreUserName and
ContentStorePassword properties are not
required in the answer file, any value provided for
these fields is overridden.

CognosInstallationPath

C:\Program Files\ibm\cognos\analytics

Flexera Analytics installation directory. Update
this path to change the default installation path.

CognosServerURI

http://$(ServerName):80

Note: The $(ServerName) text should not be
altered. It will be translated to the host name
by the installation code.
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Property/Example Description

CognosServerDispatcherURI

http://$(ServerName):9300

Note: The $(ServerName) text should not be
altered. It will be translated to the host name
by the installation code.

AppPoolUserName

Company\svc-fnms

The service user, used by IIS.

AppPoolPassword

(clear text)

A clear text password.

AppPoolStoreReference

flexera://serviceUser

The credential store reference for App Pool user
identity.

If AppPoolStoreReference property is specified
then the AppPoolUserName and
AppPoolPassword properties are not required in
the answer file. Any value provided for these
fields is overridden.

CognosServiceUserName

Company\svc-fnms

The service user for the IBM Cognos service. This
must have read access to the
FNMPDatawarehouse database, as well as being
a member of the local Administrators group.
Ensure that the account you enter already has
Logon as a service permission (see Authorize
the Service Account).

CognosServicePassword

(clear text)

A clear text password.

CognosServiceStoreReference

flexera://serviceUser

The credential store reference for Cognos service
user identity.

If CognosSerciceStoreReference property is
specified then the CognosServiceUserName and
CognosServicePassword properties are not
required in the answer file. Any value provided
for these fields is overridden.
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Property/Example Description

CognosServiceMaxMemory

4096

IBM recommends a minimum of 4GB (4096MB)
for Cognos Analytics. This number is a starting
point and should be adjusted upwards based on
the memory usage of your system.

Note: This value determines the amount of
memory used by the Java Virtual Machine and
depends on how much memory is available. If
this value is too high, the process will fail to
start and no log information will be
generated.

MachineKeyValidationKey

ABCDEFGHIJKLMNOPQRSTUVWXYZ0123456789

This is taken from the web.config file on the
FlexNet Manager Suite presentation server. For
example: C:\Program Files (x86)\Flexera
Software\FlexNet Manager Platform\

WebUI\web.config.

The required value is present in the
<machineKey> element.

MachineKeyDecryptionKey

0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZ

This is taken from the web.config file on the
FlexNet Manager Suite presentation server. For
example: C:\Program Files (x86)\Flexera
Software\FlexNet Manager Platform\

WebUI\web.config.

The required value is present in the
<machineKey> element.

SmtpStoreReference

flexera:\\smpt

The credential store reference for SMTP user
identity.

If SmtpStoreReference property is specified
then the SmtpUserName and SmtpPassword

properties are not required in the answer file. Any
value provided for these fields is overridden.

FNMSConfiguration
op

This value defines the FlexNet Manager Suite
environment configuration. This value is pre-
populated based on the installation media and
does not require the user to change it.

Modifying this value will cause the Flexera
Analytics installation to fail.

Note: If the CognosConfigProperties.xml file contains passwords in clear text, after installation
this file should be cleared of passwords; or kept in a file path that is only accessible to Administrators
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and copied to a secure location off the host server. The file should be preserved for use in future
upgrades.

a. Open a PowerShell command-line window with Administrator privileges.

b. Navigate to the directory where you copied the support directory. For example
C:\FNMSCognosAnalytics\Support

c. If you have not done so already, set the PowerShell permissions with the following command:

set-ExecutionPolicy AllSigned -Force

Respond to the warning text with the default Y.

d. Run the following command:

.\InstallCognos.ps1

Tip: This may take some time to complete. After updating the configuration with the details
you provided, the PowerShell script restarts the IBM Cognos service. If the script reports any
difficulties restarting the service, it may be because of environmental issues, such as memory
pressure. In this case, it is not necessary to run the PowerShell script again: you can try
restarting the IBM Cognos service manually in Windows Service Manager.

4. Your web server needs to be configured for use with Flexera Analytics. The externally visible URL of the
Flexera Analytics server needs to be set on the web application server so that FlexNet Manager Suite
knows where to go when opening Flexera Analytics from Reports mode.

a. Log into your web application server.

b. Open a PowerShell command-line window with Administrator privileges.

c. Navigate to the <FNMS Media>\FlexNet Manager Suite\Support directory.

d. Execute the commands

Set-ExecutionPolicy AllSigned -Force

and

.\Config.ps1 ".\Config\FNMS Cognos Config.xml" updateConfig

You will now be asked to enter the externally visible URL of the Flexera Analytics server, in the
format http://{servername}.

Tip: If your Flexera Analytics server is using encrypted communication over the HTTPS
protocol, specify https: as part of this value.

Press Ok.

5. Before any operator can access any part of Flexera Analytics, you must have created and assigned a Role.
This is only possible after you have imported the correct license file from Flexera):

a. Create a role to which you have assigned the Analytics User privilege, and a second role that
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has the Analytics Administrator privilege (in the web interface for FlexNet Manager Suite,

navigate to the system menu ( in the top right corner), select Accounts, select the Roles tab,
use the Business reporting portal section, and click the help button for further details).

b. Assign the appropriate operator(s) to these roles.

If you do not complete this step before accessing Flexera Analytics, you may experience an error after
you sign in.

Important: By default, no more than 60 operators may be linked to the role that grants the
Analytics User privilege (or to all roles that grant this privilege). If you assign more than 60
operators to these roles, all operators are locked out until you reduce the count of operators to the
licensed limit. If you need more than 60 operators with this privilege, contact your Flexera Consultant
with your request to increase the licensed count.

6. For security reasons, a browser will not provide a user's credentials to the Flexera Analytics server unless
the site (or subdomain) is on a list of trusted websites. Extra steps are required to enable silent Windows
authentication.

• Internet Explorer or Chrome on Windows

a. The Flexera Analytics server must be added under Local Intranet Zone in Internet Options. If
not, the credentials will not be passed to the site and the user will be prompted to enter their
credentials every-time they navigate to Flexera Analytics from within FlexNet Manager Suite. You
can either add the Flexera Analytics URL to trusted websites locally on the workstation or
through your corporate group policy.

• Firefox on Windows

a. Launch FireFox.

b. In the address bar type about:config and click Enter.

c. If prompted with the security warning choose "I'll be careful, I promise".

d. After the configuration page loads, in the filter box, type: network.automatic.

e. Modify network.automatic-ntlm-auth.trusted-uris by double-clicking the row and enter
the fully qualified URL of the Flexera Analytics server. For example http://cognos11.domain.

7. If you wish to configure Security Assertion Markup Language (SAML) authentication for Flexera Analytics,
please refer to the Authentication chapter in the FlexNet Manager Suite Systems Reference guide. Here you
will find the instructions to run the Flexera Report Designer Package Import Utility to update your
SAML authentication configuration.

8. If you wish to use the HTTPS protocol with your preferred certificates (rather than the default certificates
supplied with IBM Cognos), or to configure the Transport Layer Security (TLS) 1.2 protocol for Flexera
Analytics, please continue with the following topics:

• Configuring IIS to Use SSL/TLS Encryption

• Reconfigure Cognos to Use Third-Party SSL Certificates.

Optional for reinstallation

If you are ever reinstalling Flexera Analytics, you can use one of the following switches to skip specific
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segments of the installation process, but these cannot be used during a new installation.

Parameter Description Syntax

SkipApplyFiles Skips the extraction of the
authenticator, OAuth module,
logging configuration and web
content, as well as copying of some
configuration files.

.\InstallCognos.ps1 -SkipApplyFiles

SkipConfigureIIS Skips the IIS settings configuration
segment of the script.

.\InstallCognos.ps1

-SkipConfigureIIS

SkipConfigureService Skips the Cognos service
configuration segment of the script.

.\InstallCognos.ps1

-SkipConfigureService

Configuring IIS to Use SSL/TLS Encryption
Before completing the following process, you must have all your SSL certificates in place to create the chain of
trust on all servers.

Important: If you are using a Certificate Authority (CA) that is not one listed by default in Windows
certificate stores, the CA's root certificate need to be imported into all user's computers to ensure secure
communication between their web browsers and the Flexera Analytics server.

All servers in your FlexNet Manager Suite implementation must be configured to use Secure Sockets Layer for
communication. This includes your Flexera Analytics host, and your application server for FlexNet Manager
Suite itself. If you have a larger, multi-server implementation, these changes must be configured on your web
application server, your batch server, and your inventory server (or the servers on which you are hosting these
areas of functionality). Those FlexNet Manager Suite servers are assumed to be already configured following
your installation or most recent upgrade.

To configure IIS on your Flexera Analytics server to use SSL:

1. Import all relevant certificates into the Windows Local Machine certificate stores.

Save the certificates as follows:

• If you have an unusual root certificate from a Certificate Authority (CA) not already known in the
Microsoft Windows Trusted Store, save it under Trusted Root Certification Authorities.

• Your SSL certificate (usually .pfx) is saved under Personal (this is your public key certificate issued

by the CA).

• Any intermediate certificates not already trusted in Windows are saved under Intermediate

Certification Authorities.

2. Launch IIS on your Flexera Analytics server and configure it as follows:

a. Select the web server for Flexera Analytics.
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b. Open the SSL Certificates feature and import your SSL certificate (usually .pfx).

c. Add the HTTPS binding for the Flexera Analytics website (usually, this is the default website), and
select the displayed SSL certificate to use for encryption.

d. Open SSL Settings for the default website, and turn on the Require SSL option.

e. Under the same website, navigate to ibmcognos/bi, and open its URL Rewrite feature.

f. Update the Reverse Proxy rule to use HTTPS as part of Rewrite URL.

g. Restart the web server.

With IIS suitably configured on your Flexera Analytics server, you must now reconfigure Cognos to use your
preferred certificates in place of the default certificates installed with it. Continue on to Reconfigure Cognos to
Use Third-Party SSL Certificates.

Reconfigure Cognos to Use Third-Party SSL
Certificates
This process switches Cognos over from using the default certificates provided by IBM to using the certificates
you have saved for your servers. IBM refers to this process as "recrypting" Cognos. The process restores the
chain of trust, enabling SSL communication between various Cognos components, as well as between Cognos
and the others servers for FlexNet Manager Suite.

Commence this process while logged in to your Flexera Analytics server, using an account with administrator
privileges.

To recrypt Cognos to use third-party certificates:

1. Navigate to the Cognos installation directory (usually C:\Program Files\ibm\cognos\analytics).

2. Take a protective backup copy of the configuration folder.

3. Launch the IBM Cognos Configuration tool as administrator, and stop the Cognos service if it is running.

4. Navigate to File > Export As and export the decrypted content to cogstartup.xml on your Desktop.

5. Without restarting the Cognos service, close the IBM Cognos Configuration tool.

Important: Do not re-open the IBM Cognos Configuration tool until instructed to do so.

6. Open a command prompt as administrator, and run the following commands to delete existing content.

If you have a non-standard installation path, replace the default Cognos installation path shown here
with the one from your environment.

cd "C:\Program Files\ibm\cognos\analytics"

del .\configuration\cogstartup.xml

del .\configuration\caSerial

del .\configuration\certs\CAMCrypto.status

del .\configuration\certs\CAMKeystore
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del .\configuration\certs\CAMKeystore.lock

del .\temp\cam\freshness

rd .\configuration\csk /S /Q

7. Copy the exported cogstartup.xml file from your Desktop to the
CognosInstallationPath\configuration directory.

8. Copy all certificate files to the CognosInstallationPath\bin64 directory.

9. Register all certificates individually to the Cognos trust store, using commands like the following,
updating your Cognos installation path and the names of individual certificates as required for your
context:

cd c:\Program Files\ibm\cognos\analytics\bin

ThirdPartyCertificateTool.bat -i -T -r anybase64.cer -p NoPassWordSet

ThirdPartyCertificateTool.bat -i -T -r mycabase64.cer -p NoPassWordSet

10. Import your certificates into the Cognos keystore as follows:

a. Navigate to CognosInstallationPath\jre\bin, and launch the IBM Key Management tool,
ikeyman.exe.

b. Open the key database file CAMKeystore from CognosInstallationPath\configuration\

certs with password NoPassWordSet.

c. In the Key database content drop down, select Personal Certificates.

d. Import your wildcard certificate in PKCS12 format with correct password, and apply a new label to
it: encryption.

e. In the Key database content drop down, select Signer Certificates.

f. Add the CA root certificate and label it as ca. 

g. Add any other intermediate certificates that may be required to complete the chain of trust,
giving each one an arbitrary label.

h. Close the key management tool.

Best practice is to once again step through these import steps and validate that the certificates have
been imported with the correct labels.

11. In your preferred text editor, open CognosInstallationPath\configuration\FLEXnet.properties,
and update the protocol in the URL to read HTTPS.

12. Launch the IBM Cognos Configuration tool as administrator.

13. Navigate to Cryptography, and:

a. Change Common symmetric key store password to NoPassWordSet.

b. If your enterprise policy does not allow versions of TLS prior to 1.2, edit SSL
Protocols accordingly.

14. Navigate to Cryptography > Cognos, and:
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a. Change Key store password to NoPassWordSet.

b. Change Server common name to the fully-qualified domain name (FQDN) of your Analytics
server.

c. Change Country or region code to match the country code of your saved certificates.

d. Set Use third party CA? to True.

e. Change Certificate Authority service common name to match the Common Name (CN) of the
CA root certificate.

f. Change Certificate Authority password to NoPassWordSet.

g. Change the Certificate lifetime in days figure to reflect time until the expiry date of the wildcard
certificate.

15. Navigate to Environment, and change all URIs to use the HTTPS protocol. In Gateway
URI and Controller URI for gateway, also replace port 80 with 443.

16. Save the updated configuration.

17. Start the Cognos service.

18. Close the configuration tool.

Flexera Analytics, powered by Cognos, is now using the certificates in your preferred chain to certify SSL
communications.

Configure the System
PowerShell scripts are provided to complete configuration of the central application server(s), including the
connections to the databases, and then store appropriate values in the database.

Important: For a single server implementation, run the PowerShell scripts on the application server (if you
have a separate database server, you do not run the PowerShell scripts on that.) If the logical application
server has been separated into multiple servers, the PowerShell scripts must be run on each of these servers,
and must be run in the following order:

1. Your web application server

2. Your batch server (or processing server, for a two-server application implementation)

3. Your inventory server(s).

On each applicable server in turn, as administrator (fnms-admin), complete all the following steps (noticing
that on different servers, different dialogs may be presented). Before executing the PowerShell scripts, you
should first ensure that:

• Your administrator account is a member of the db_owner fixed database role (at least temporarily, as

described in Identify (or Set Up) Accounts)

• The scripts themselves have sufficient authorization to execute, as described in the following process.

Also notice that, to complete this configuration process, you restore IIS, the scheduled tasks, and the batch
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processing service to prepare your system for operations.

To configure the system using supplied PowerShell scripts:

1. On your web application server, batch server, or inventory server, ensure that Microsoft IIS is running
again:

a. Ensure that your Server Manager dialog is still open.

b. In the left-hand navigation bar, expand Roles > Web Servers (IIS), and select Internet
Information Services.

The IIS page is displayed.

c. In the Actions panel on the right, select Start.

A message like Attempting to start... appears. Note that it can take some time before the
service is started. When the service is running, the PowerShell scripts can update the IIS
configuration as required.

2. If you require that the URLs for your central server(s) use the HTTPS protocol, confirm that site bindings
have been configured to allow this:

a. Open IIS Manager.

b. In the Connections pane, expand the Sites node in the tree, and then click to select the site for
which you want to add a binding.

c. In the Actions pane, click Bindings.

d. In the Site Bindings dialog box, click Add.

e. In the Add Site Binding dialog box, add the binding information and then click OK.

For more information (including the set up of the required certificate), see http://www.iis.net/
learn/manage/configuring-security/how-to-set-up-ssl-on-iis.

3. Run PowerShell as administrator (use the 64-bit version where available):

a. Locate PowerShell. For example:

• On Windows Server 2012, Start > Windows PowerShell.

• On earlier releases, in the Windows Start menu, find All Programs > Accessories > Windows
PowerShell > Windows PowerShell (this is the 64-bit version; the 32-bit version is Windows

PowerShell (x86). ).

b. Right-click, and choose Run as Administrator.

Important: It is critical that you run the PowerShell scripts with administrator privileges.
Otherwise, scripts will fail.

4. If you have not already done so, in the PowerShell command window, execute:

set-executionpolicy AllSigned
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Respond to the warning text with the default Y.

5. In the PowerShell command window, navigate through the unzipped downloaded archive to the Support
folder.

6. On each server, execute:

.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" updateconfig

(This script determines the type of server installation, and applies appropriate configuration. See also
server-specific comments below.)

Tip: If your PowerShell window is in its default QuickEdit mode (visible in the Properties for the
window), simply clicking in the window when it already has focus puts it into Mark or Select mode. In
such a mode, a process that is writing to the window is paused, awaiting your input. Beware of
unintentionally pausing the configuration scripts by extra clicking in this PowerShell window. A process
that has been paused in this way is resumed when the window already has focus and you press any
key.

On each server, on first run PowerShell asks whether to trust the publisher of this script. You may allow
Run always for a certificate signed by Flexera LLC.

7. In each case, allow the script to run once, completing the requested details.

Tip: Helpful notes:

• Use the service account details you created earlier (example: svc-flexnet).

• Separately on each dialog, the check box Use the same credentials for all identities copies the
account details from the upper section to the lower section of the dialog.

• For externally visible URLs, you can specify either HTTP or HTTPS protocol, and either the flat server
name or the fully qualified domain name is supported. Any port number is optional. Remember that
site bindings may be required if you are using the HTTPS protocol (see above). Valid examples:

http://servername

https://www.servername.mydomain:8080

• If you have a single-server implementation, when asked for the hostname of the different server
functionality, use localhost.

• Remember that in a multi-server implementation, MSMQ limits the hostname of the batch server to
14 characters. Of course, this limit applies to the hostname itself, and not to the fully-qualified
domain name of the host. (If your batch server is already implemented with a longer hostname,
consider using a DNS alias that satisfies this limitation.)

Important: Remember to use the fully-qualified domain name (in the style of
serverName.example.com) when identifying servers in a multi-server implementation. Do not
use a URL.

• The PowerShell script asks for appropriate database connection details, depending on the
configuration of the current server (for example, if the current server includes inventory server
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functionality, the script asks for the Inventory Management database). In each case, supply the host
server name (and, if the database instance is not the default instance, the instance name, separated
by a backslash character); and the database name for each kind of database. In a small-to-medium
implementation, all the operations databases may be on the same host and instance combination;
but in larger implementations may be separated onto distinct servers. In either case, each database
has a distinct database name, for which the suggested values are:

◦ The main compliance database: FNMSCompliance

◦ The database for inventory collected by the FlexNet inventory agent: FNMSInventory

◦ The data warehouse for trend reporting: FNMSDataWarehouse

◦ The snapshot database for performance improvement: FNMSSnapshot.

8. Close the PowerShell command window.

9. If this is your batch server (or the server hosting that functionality), ensure that the services for FlexNet
Manager Suite Batch Process Scheduler are running:

a. Navigate to Start > Control Panel > Administrative Tools > View local services.

The Services dialog opens.

b. In the list of services, ensure that both FlexNet Manager Suite Batch Process Scheduler and
FlexNet Manager Suite Batch Processor are both running. If not, right-click each stopped
service in turn, and from the context menu, select Start.

Note: These services are critical to the operation of FlexNet Manager Suite. It is best practice to
set up your service monitoring to alert you any time either of these services is stopped.

10. On your batch server or inventory server, enable all Windows scheduled tasks related to FlexNet Manager
Suite.

The scheduled tasks are different on the two different types of servers. On your batch server (also known
as reconciliation server), change all tasks in the FlexNet Manager Platform folder:

• Data warehouse export

• Export to ServiceNow

• FlexNet inventory data maintenance

• Import SAP inventories

• Import SAP package license

• Inventory import and license reconcile

• Recognition data import

• Regenerate Business Import config

• Send contract notifications.

On your inventory server, change all tasks in the FlexNet Manager Platform folder:
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• Import Active Directory

• Import application usage logs

• Import discovery information

• Import installation logs

• Import inventories

• Import Inventory Beacon activity status

• Import Inventory Beacon status

• Import remote task status information

• Import security event information

• Import system status information

• Import VDI access data.

An example process to change these tasks on Windows Server 2008:

a. Open your Computer Management dialog (for example, clickStart, right-click on Computer, and
select Manage from the context menu).

b. In the left-hand navigation bar, expand Configuration > Task Scheduler > Task Manager
Platform, and select the FlexNet Manager Platform folder.

c. Select all of the relevant tasks in the list (click the first, shift+click the last), and in the Actions pane,
in the Select Item section, click Enable (or right-click the selection, and click Enable).

d. Close the dialog.

Configuration by the PowerShell scripts is now complete. Although not needed now, at other times it is
possible to re-run the PowerShell scripts with the following flags for the use cases shown. You do not need to
re-run the scripts unless, at some later stage, one of these use cases applies to you:

• Use without a flag to add a configuration file to a new installation; or on an existing implementation, to
remove all customizations and replace the %ProgramFiles(x86)%\Flexera Software\FlexNet Manager

Platform\WebUI\web.config file with the default version:

.\Config.ps1 "Config\FNMS Windows Authentication Config.xml"

• Add the updateConfig flag to insert any new parameters added by Flexera, leaving all settings (including

customizations) unchanged for existing parameters:

.\Config.ps1 "Config\FNMS Window Authentication Config.xml" updateConfig

• Add the forceUpdateConfig flag to insert any new parameters added by Flexera, and restore the default

values for all factory-supplied settings, but leaving any custom parameters unchanged:

.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" forceUpdateConfig

• Add the removeConfig flag to remove the %ProgramFiles(x86)%\Flexera Software\FlexNet Manager
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Platform\WebUI\web.config file before using Windows Programs and Features to uninstall FlexNet

Manager Suite:

.\Config.ps1 "Config\FNMS Windows Authentication Config.xml" removeConfig

(Re-)Activate the Product
You need to reimport your license for FlexNet Manager Suite.

The migration process requires that the license is reimported on the batch server, or, in smaller
implementations, the server hosting that functionality:

• The application server (in a single server implementation)

• The processing server (in a two server application implementation).

Tip: FlexNet Manager Suite 2019 R1 (and onwards) requires an entirely new license, compared with your 9.x
version. If you have not already received this license from Flexera, contact the Orders Support team (o-
support@flexerasoftware.com) to request the new license file, which will be emailed to you.

To activate FlexNet Manager Suite:

1. On the appropriate server, save a copy of your license in a convenient folder (such as your installation
folder), where it is accessible for this activation process.

2. From the Windows Start menu, run Flexera Software > FlexNet Manager Suite Activation Wizard.

3. Import your license to use FlexNet Manager Suite.

Populate the Downloadable Libraries
FlexNet Manager Suite comes with an Application Recognition Library, and a SKU (Stock Keeping Unit) Library.
You may also have the End of Service Life (EOSL) product, and additional Product Use Rights Libraries
(depending on whether you have licensed FlexNet Manager for Datacenters). The various libraries are updated
regularly by Flexera and normally downloaded automatically.

Tip: Some product functionality updates are also delivered through the library downloads (for example, the
latest version of the InventorySettings.xml file, containing extended functionality for the FlexNet
inventory agent).

Note: If your server has Internet access controlled through a proxy server, the following URLs must be
accessible:

• For the ARL: https://www.managesoft.com/support/Compliance/RecognitionAfter82.cab

• For the EOSL library: https://www.managesoft.com/support/Compliance/EOSL.cab

• For the SKU library: https://www.managesoft.com/support/Compliance/PURL.cab
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• For the PURLs: https://update.managesoft.com:443/ProductUseRights, including access to any

sub-directories of this that may be returned to your server in response to its initial request.

For backward compatibility, the HTTP protocol is also supported, with a server-side redirect being issued to
the relevant HTTPS address. If you choose to use HTTP protocols, the corresponding addresses must also be
authorized through your proxy server; but HTTPS support remains a requirement.

If neither direct access nor access through a proxy server can be provided, you can use an alternative process
to manage library updates manually, as described in Manual Updates of Library Data.

At installation time, you need to trigger download of the libraries to create a baseline ready for product use.
Library downloads check the terms of your Flexera license. That is why this task cannot be attempted before a
current license is installed (see (Re-)Activate the Product), and must occur on the same server where your
license was imported to activate the product.

In summary, the process downloads several different files to which you are entitled, saving them into staging
locations on your batch server (or the server hosting that functionality). When the downloads are all completed
successfully, the files are imported into the compliance database as required. The staging locations are
subdirectories of %PROGRAMDATA%\Flexera Software\FlexNet Manager Platform\DataImport\Content.
If necessary, you may customize this by saving your preferred path in the registry at HKEY_LOCAL_MACHINE\
SOFTWARE\WOW6432Node\ManageSoft Corp\ManageSoft\Compliance\CurrentVersion\Recognition\

ContentImportDirectory.

For details of log files, see the end of the following procedure.

Complete this procedure as administrator (fnms-admin), having database rights as described in earlier sections.

To trigger a download of the current libraries:

1. On the batch server (or application server for a single-server implementation), open the Microsoft Task
Scheduler.

2. On the batch server (or application server for a single-server implementation), open the Microsoft Task
Scheduler.

3. Manually trigger the Recognition data import scheduled task.

Given that no other processes are running at this stage of your implementation, it executes almost
immediately. By default this task is run at 1am daily.

Tip: You can save considerable download time and bandwidth by editing the schedule for this task to
be 1am on Sunday morning, for example. Since ARL updates are made weekly, and less frequently for
other libraries. more frequent downloads are of little benefit, other than perhaps recovering from
networking issues.

Whenever it is triggered, the task places a request for download in the queue of the internal batch
scheduler. A utility downloads all libraries according to the terms of your license, and, when all
downloads are successful, imports the contents into FlexNet Manager Suite. Depending on your network
speeds, a typical download may take in the order of one-two hours, followed by the import.

Tip: Since all downloads must succeed before the import starts, a failure in any of the downloads
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means that the import is not attempted on this occasion. However, the process is resilient in that each
download is automatically retried up to five times where necessary to work around transient network
issues.

4. Thereafter, in the web interface for FlexNet Manager Suite, navigate to the system menu ( in the top
right corner), select System Health > System Health Dashboard, and check the cards for:

• ARL

• SKU Library

• PURL.

Tip: The cards do not refresh automatically. Use F5 to refresh the display from time to time.

Each card shows the currently installed version of the relevant library, and the date of the last successful
download and import of these libraries. Errors display an additional alert icon with some explanatory text.

In case of errors, check the following log files, located in %ProgramData%\Flexera Software\Compliance\

Logging\Content (where the asterisk in each file name is replaced with the appropriate date):

• mgsImportRecognition*.log

• recognition*.log (for the Application Recognition Library)

• importPURL*.log.

Tip: Each log file is configured through a matching .config file saved in the same directory. Note that by
default, 30 dated copies of each log file are preserved, and thereafter the oldest file is automatically removed
to make room for the next log file (see maxSizeRollBackups in the .config files). You cannot modify the
file path for logging within the .config files, but you could if necessary customize the file name(s). If you
really need a different file path for these logs, you can change the value used for
%property{ComplianceLoggingPath} in the .config files by creating a REG_SZ registry key at
SOFTWARE\WoW6432Node\ManageSoft Corp\ManageSoft\Compliance\CurrentVersion\

LoggingBaseDirectory on your batch server (or in smaller implementations, the server hosting this
functionality), and setting the registry key to your preferred path. (Removing this key again restores the
default value.)

Manual Updates of Library Data
The downloadable Application Recognition Library, Product Use Rights Library, EOSL library, and SKU Library
are intended for automated updates delivered directly to your application server (or, in a multi-server
implementation, the server hosting the batch server functionality). This automated process naturally relies on
the server having direct Internet access.

However, in some secure environments, the applicable server may not be permitted to have Internet access.
For such environments, the process of updating these critical libraries must be maintained manually. The
manual process is outlined below; but first there are the following preparations.

• Subscribe to the Content Library Updates email list through the webpage http://learn.flexerasoftware.com/
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SLO-FMS-Software-Content-Library-Updates. List members receive email notifications when updates to
library data are published.

• On your applicable server, navigate to the Microsoft Task scheduler and disable the Recognition data
import task (in the FlexNet Manager Platform group).
This prevents the server from attempting to connect to the Internet to start downloads.

• Ensure that you have a user name and password for the Flexera Customer Community. If you do not yet
have these credentials, you can apply as noted in the process below. (There is a delay for account
validation.)

When these preparations are completed, you can use the following process to manually update each of the
downloadable libraries for your new installation, and again as new editions are released (as advised in your
email notifications).

In summary, in this process you download several different files to which you are entitled, saving them into
staging locations on your batch server (or the server hosting that functionality). When the downloads are all
completed successfully, you import the files into the compliance database as required. The staging locations
are subdirectories of %PROGRAMDATA%\Flexera Software\FlexNet Manager Platform\DataImport\
Content. This default pathway is referenced throughout the description below. If necessary, you may
customize the default path by saving your preferred path in the registry at HKEY_LOCAL_MACHINE\SOFTWARE\
WOW6432Node\ManageSoft Corp\ManageSoft\Compliance\CurrentVersion\Recognition\

ContentImportDirectory.

For details of log files, see the end of the following procedure.

To manually download and deploy current libraries:

1. Log into a computer where you are permitted to access the Internet and download files.

2. Download the ARL from https://www.managesoft.com/support/Compliance/RecognitionAfter82.cab and
save it temporarily.

Its eventual destination is %PROGRAMDATA%\Flexera Software\FlexNet Manager Platform\
DataImport\Content\ARL on your batch server.

3. If you have licensed the EOSL (End of Service Life) product, also download https://www.managesoft.com/
support/Compliance/EOSL.cab.

This is eventually saved in %PROGRAMDATA%\Flexera Software\FlexNet Manager Platform\

DataImport\Content\EOSL on your batch server.

4. Download the SKU library from https://update.managesoft.com/ProductUseRights/PURL.cab (despite the
name, this is not a typographical error).

Later you will save this in %PROGRAMDATA%\Flexera Software\FlexNet Manager Platform\

DataImport\Content\SKU on your batch server.

5. To collect your PURL entitlements, navigate to the appropriate download page in the Flexera Customer
Community website:

a. On https://flexeracommunity.force.com/customer/CCLanding, use the account details emailed to
you with your order confirmation from Flexera to log in (using the Login link in the top right).
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Tip: Access requires your Customer Community user name and password. If you do not have
one, use the Request Community Access link on the login page to request one. Your
credentials are configured for access to content you have licensed.

b. Select the Downloads tab from the row across the top of the page.

A routing page appears to let you Access Product and License Center, displaying lists of
products from Flexera.

c. In the lists of products, identify FlexNet Manager Platform, and immediately below it, click
Access Above Products.

The Product and License Center site is displayed.

d. In the Your Downloads panel, select one of the products that you have licensed to open the
Download Packages page (for example, FlexNet Manager for Datacenters).

e. Click on the productName Content link to download the related PURL file.

f. If necessary, loop back and repeat the download for each of the products you have licensed for
FlexNet Manager Suite.

All downloaded PURL files are eventually to be saved in %PROGRAMDATA%\Flexera Software\FlexNet

Manager Platform\DataImport\Content\SKU (again, not a typo) on your batch server.

6. Log in to your batch server (or the server hosting that functionality, such as your application server in a
single-server implementation) as a user in the FNMS Administrators security group.

This is the security group recommended during installation. A suggested account to use is fnms-admin.

7. If this is not the first time you have downloaded the libraries, run the following command to clean out
the disk cache on your batch server (or equivalent):

cd InstallDir\DotNet\bin

ShadowHostWin.exe BatchProcessTask.exe run ARLCleanup

8. On your batch server (or equivalent), navigate to %PROGRAMDATA%\Flexera Software\FlexNet

Manager Platform\DataImport and create the Content directory and its subdirectories ARL, SKU, and
EOSL.

Use exactly these names to allow for subsequent automated tasks. (These folders are all removed each
cycle by the ARLCleanup task.)

9. Copy the downloaded files to your batch server, placing each one in the appropriate subdirectory under
the \Content path, as identified in the downloading steps described earlier.

10. Still on your batch server, navigate to the Microsoft Task scheduler, and in the FlexNet Manager
Platform group:

a. Validate that the Recognition data import scheduled task has indeed been disabled.

b. Create a new import scheduled task with the following command line to execute in the
InstallDir\DotNet\bin directory:
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ShadowHostWin.exe BatchProcessTask.exe run ARLImport

It is appropriate to schedule this daily at 1am. This schedules an import from the disk cache
where you have placed the files into the compliance database (and on the daily schedule, if there
is nothing new in the cache, exits quickly). The import is scheduled as soon as possible, and run
when there are no conflicting tasks. You can also trigger this scheduled task manually if need be,
without needing to memorize a command line.

When the import scheduled task is triggered, all the downloaded libraries are loaded into the compliance
database by the ARLImport task. When the process is complete, you can log into the web interface of FlexNet

Manager Suite, and navigate to the system menu ( in the top right corner) and choose System Health >
System Health Dashboard. The summary cards there display the versions and date/time of the last
successful updates to the ARL, PURL, and SKU library. (The cards do not update automatically once the page is
open. Use F5 to refresh the display.) Errors display an additional alert icon with some explanatory text.

Troubleshooting:
In case of errors, check the following log files, located in %ProgramData%\Flexera Software\

Compliance\Logging\Content (where the asterisk in each file name is replaced with the appropriate
date):

• mgsImportRecognition*.log

• recognition*.log (for the Application Recognition Library)

• importPURL*.log.

Tip: Each log file is configured through a matching .config file saved in the same directory. Note
that by default, 30 dated copies of each log file are preserved, and thereafter the oldest file is
automatically removed to make room for the next log file (see maxSizeRollBackups in the .config

files). You cannot modify the file path for logging within the .config files, but you could if necessary
customize the file name(s). If you really need a different file path for these logs, you can change the
value used for %property{ComplianceLoggingPath} in the .config files by creating a REG_SZ

registry key at SOFTWARE\WoW6432Node\ManageSoft Corp\ManageSoft\Compliance\
CurrentVersion\LoggingBaseDirectory on your batch server (or in smaller implementations, the
server hosting this functionality), and setting the registry key to your preferred path. (Removing this key
again restores the default value.)

Import the Sample Reporting Package
This section is only for those using Flexera Analytics (powered by Cognos).

First, be aware that much of what used to be published in the Report Designer environment in the 9.2 product
is now moved into the web interface for FlexNet Manager Suite itself. Compare the functionality of the two
releases:
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Release 9.2 Release 2019 R1

A product dashboard was available within the
Reports Designer.

The product dashboard is now one of the main
management tools in the web interface.

A number of business reports were available in
Report Designer.

Business reports are now centered in the reports area
of the web interface (switch to reporting mode using
the large button in the header bar).

Trend analysis reporting was provided only through
Report Designer.

Trend analysis reporting is available directly through
the web interface.

Reports provided through Report Designer were
available through a web portal, providing click-
through access.

There is no longer any direct link from the web
interface of FlexNet Manager Suite to reports
prepared in Report Designer. Users must be given a
direct link to those reports, external to the product.

Tip: Custom reports in Report Designer can still
retrieve data from the FlexNet Manager Suite
database.

Reports in Report Designer were central to the
operation of the system.

Many reports are still provided in Report Designer,
but these are intended as examples to help you build
your own reports.

If you wish to continue with custom reporting through Flexera Analytics, use the following process to update
your reports package for the new release. In overview, you need to:

• Position the sample reports package ready for import

• Authorize the service account to complete the import

• Perform the import itself

• Restore normal operational permissions to appropriate accounts.

To import the sample reports package:

1. Log in to your Flexera Analytics (Cognos) server, and navigate to the following folder:

C:\Program Files\ibm\cognos\analytics\deployment

The folder should contain two zip files named Flexera Analytics.zip and FlexNet Manager

Platform Data Warehouse Reports and Dashboard.zip. These zip files should have been placed in
this directory as part of the Cognos Analytics installation and configuration process. If they are not there,
you can copy them from your web application server from the installation media located in the directory
<FNMS Media>\FlexNet Manager Suite\Support\Media

2. You may log out of the Flexera Analytics (Cognos) server now.

Shortly you will log into your batch server, but first there are permissions required to authorize the
installation process.
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3. In the web interface for FlexNet Manager Suite 2019 R1, add your service account (suggested: svc-flexnet)
as an Analytics Administrator for the business reporting portal as follows:

Tip: You need to have administrator privileges within FlexNet Manager Suite to make these changes.

a. Navigate through the system menu ( in the top right corner) > Accounts.

The Accounts page opens.

b. Select the Roles tab, and check for the existence of the Business Reporting Portal Admin

role.

If the role does not already exist, you can create it.

c. Click the edit (pencil) icon at the right-hand end of the card for this role.

The properties page for this role appears.

d. Expand the Business reporting portal tab of the accordion, and from the Privileges drop-down
list, ensure the Analytics Administrator feature has Allow permissions.

e. Switch to the All Accounts tab, locate your service account (suggested: svc-flexnet) in the list, and
click the account name hyperlink.

The page switches to show Account Properties for your account.

f. Under the Permissions section, check whether your Business Reporting Portal Admin role is
already listed against the service account. If so, you are set for upload permissions, and should
continue with the next step.

g. Click the + button to the right of the current Role to add this account to another role.

A duplicate line appears with another drop-down list of all the roles defines so far.

Tip: Each enterprise is licensed for only a single operator in the Analytics Administrator role. If
one has already been assigned this privilege, you need to move that account out before you can
add the service account.

h. From the duplicate drop-down list, select your Business Reporting Portal Admin role.

The Business reporting portal tab of your resulting list of privileges is updated. If you expand this
tab of the accordion, you see that Analytics Administrator now displays Allowed access.

i. Scroll to the bottom of this page, and click Save.

Your services account is now the (only) Analytics Administrator for use of the Flexera Analytics.

Tip: Flexera Analytics also requires that this account is valid in Active Directory.

This privilege level allows the account to complete the import of the sample reports package. Keep
this web page available for further use shortly.

4. Using the service account (suggested: svc-flexnet), log into your batch server directly.

Refer to your block diagram of servers to identify this machine. If you have combined servers, this may
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be your processing server, or your application server.

Note: The following 6 steps can be completed using a package import utility as described here, or
using a command-line interface (for which see the note at the end of the process).

5. Navigate in Windows Explorer to installation-folder\Cognos\

BusinessReportingAuthenticationService\bin.

Example:

C:\Program Files (x86)\Flexera Software\FlexNet Manager Platform\Cognos

\BusinessReportingAuthenticationService\bin

6. Right-click CognosPackageImport.exe and click Run as Administrator.

A window appears for the Flexera Report Designer Package Import Utility.

7. Click Update....

An Update Value dialog appears.

8. In the Value field, enter the value for your Cognos Analytics' Dispatch URL.

In a typical installation, this has the following form:

http://RD-Server:9300/p2pd/servlet/dispatch

where you change the placeholder RD-Server to the name of your server hosting Cognos Analytics.

Tip: If your Flexera Analytics server is using encrypted communication over the HTTPS protocol,
specify https: as part of this value.

9. Click Update.

The value entered is written into the registry on this server, and the additional dialog disappears.

Tip: If you run this import utility on the same machine in future, it displays the value stored in the
registry in its read-only Dispatch URL field.

10. Click Install Reports Package.

Progress is logged in the text window of this dialog as the package is imported into the Cognos database.
When successfully completed, the last line displays Finished publishing the Report Designer
package.

Important: Do not close the utility until it has finished the import! This process may take several
minutes.

11. Restore the Analytics Administrator privilege to an appropriate interactive operator account.

a. Back in the web interface for FlexNet Manager Suite 2019 R1 (in the Accounts tab of the same
page), remove your service account (suggested: svc-flexnet) from the Business Reporting

Portal Admin role that includes the sole Analytics Administrator privilege (do this in the account
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properties, by deleting the appropriate line in the Roles group). Save the account properties that
you have changed.

b. Switch to the appropriate administrator account (suggestion: fnms-admin), and for this account
add the Business Reporting Portal Admin role. Save the changed account properties.

Flexera Analytics dashboards and reports are now available as baselines for your own customization and
extension as required. The dashboards and reports can be accessed in a web browser through the web
interface for FlexNet Manager Suite: select Reports in the modal bar at the very top, then select Analytics in
the menu bar. Selecting Analytics will provide you with three options:

• Software Asset Management — This dashboard, provided by Flexera, displays information about
applications, installations, and licenses

• Hardware Asset Management — This dashboard, provided by Flexera, displays information about assets,
discovered devices, and inventory

• My Analytics home — This is a personal dashboard enabling the creation of a customized dashboard,
populated using a variety of supplied widgets, for each operator’s specific needs.

As well, the appropriate administrator's account is configured to manage Cognos rights for other users.

Remember that Flexera Analytics requires that you allow pop-ups, and that the URL for your reports (where this
is separate from the URL for your web interface) must be a trusted site for your web browser. See step 6 in
Installing Flexera Analytics for more details.

Note: Rather than using the Flexera Report Designer Package Import Utility as described above, you
can use the following command-line interface:

1. Open a command line as Administrator.

2. Navigate to installation-folder\Cognos\BusinessReportingAuthenticationService\bin.

3. Run the following commands, replacing the RD-Server placeholder with the name of your server
hosting Cognos Analytics:

CognosPackageImportConsole.exe set -d "http://RD-Server:9300/p2pd/servlet/

dispatch"

CognosPackageImportConsole.exe import

Note: If you are using single sign-on using either a SAML-compliant identity provider or Google
OAuth, change the second command by adding the --saml (or -s) switch:

CognosPackageImportConsole.exe import -s

Important: If you choose to use the command-line interface, please be advised that the following options
are not supported for an on-premises installation, and will not work if they are specified as part of the install:

• add — Add system administrator login

• remove — Remove system administrator login

• sync — Synchronize tenants.
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Configure Web Browsers
Efficient use of FlexNet Manager Suite may required adjusting your web browser settings (especially for
Microsoft Internet Explorer).

Assumption: Microsoft IIS is running on your central web application server.

To locate instructions for configuring various web browsers:

1. In your preferred web browser, navigate to the URL server-name-or-IP-address/Suite/Help/
webhelp/index.html.

2. Expand the table of contents on the left by clicking the book icon to the left of the title.

3. Click Configuring Your Web Browser, and follow the guidelines in the column for your preferred web
browser.

Link to Flexera Service Gateway
Flexera Service Gateway allows interaction between separate products from Flexera.

The ability to link FlexNet Manager Suite to the Flexera Service Gateway is subject to a separate license option.
If you have licensed this option (you can check using the process below), you need to configure the connection
as part of your configuration process.

To complete this process, you must know credentials that can log into your Flexera Service Gateway server with
administrator privileges.

To link to Flexera Service Gateway:

1. Log into the web interface for FlexNet Manager Suite.

Tip: Either log in from a computer other than your web application server; or if running on that server,
ensure that you access the full server name (and not localhost) in the URL. The URL in your web
browser is taken into account in preparing the integration file, and should not include localhost if
you want to integrate with other products from Flexera.

2. Optionally, check that you have licensed the option to link to Flexera Service Gateway:

a. Navigate to the system menu ( in the top right corner) > FlexNet Manager Suite License.

The Your FlexNet Manager Suite License page appears.

b. Check the License details section.

If you have licensed this option, FNMP API integration enabled: Yes appears in the list. If it
is not visible, you cannot continue with this procedure.

3. Navigate to the system menu > System Settings, and select the Web API tab.
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Note: This tab is available only if your enterprise has licensed the FNMP API integration option.

4. Click each of the links in turn to download the two files, and save them to a convenient location (such as
C:\temp).

There must be network access to your Gateway server from the location where you save the files.

5. Either, in your web browser's list of recent downloads, click the registration tool to open it; or

a. Open a Command Window, and navigate to the location where you downloaded the files.

b. Run RegisterFlexeraServiceGateway.exe.

The Flexera Service Gateway Registration dialog appears.

6. Identify the Flexera Service Gateway host, the server in your enterprise where the Gateway is installed,
and the Port number.

You may use an IP address, a fully qualified domain name, or (if your DNS is correctly configured and
accessible) the server's host name. The default port number is 9443.

7. Provide the credentials for administrator access to the Gateway account.

In the absence of any better information, try the account admin with the password password.

8. Use the Import button to browse to the other downloaded file, webapi.config, and import it into the
registration tool.

9. Click OK.

Registration is complete. (You do not need to repeat this registration on others of your central servers.)

Update Access Rights
Through your processes of database migration, all the access rights that applied in your earlier compliance
product are carried forward into FlexNet Manager Suite 2019 R1.

In addition, if you created a new account for installation (suggested: fnms-admin), this account defaults to
having administrator privileges in your new implementation, in addition to the migrated access rights. This
account has adequate rights to modify access rights for other operators.

To modify access rights:

1. Log in to the web interface to FlexNet Manager Suite 2019 R1.

2. Navigate to the system menu ( in the top right corner), choose Accounts, and select the Roles tab.

3. For each unique set of access rights that you need to assign to operators, ensure that there is (or create) a
distinct role, and set its rights by expanding the various headings in the accordion and using the controls
inside. (For advanced combinations, start by selecting Custom from the drop-down list in each section.)
Remember to scroll down and click Save (or Create) when you make any changes.

For more information, click the help button at the top left.
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4. When appropriate roles are defined, switch to the All Accounts tab.

5. Find each account in the list in turn, and click the hyperlinked account name to open its properties.

6. Change the roles assigned, or add additional roles, to each account as required.

The net effect of all roles on permissions for this account is displayed in read-only mode in the accordion
below as you make changes. (Remember that a 'deny' in one role over-rides an 'allow' in another role
when the same account is assigned to both roles.)

7. Remember to Save each changed account.

Managing Device Migration by Subnet
Controlling migration at the level of subnets makes for a greatly simplified process.

Use this process if, in the Process Overview, you chose the simpler path of controlling migration at subnet
granularity. (If, instead, you chose to control migration down to the level of individual computers, instead see
the process in Managing Device Migration by Individual Device).

This process has the smallest overheads beyond the deployment, installation, and configuration of the
inventory beacon for each subnet (these latter three being the tasks that are common to all approaches). The
only additional step is switching over the DNS alias that is referenced by managed devices as the download
location to use within this subnet.

To migrate managed devices by subnet:

1. If you choose to update your managed devices while they are still within the 9.2 infrastructure, start with
that process.

However, there is no requirement to do any device updates or other preparations within the 9.2 system.
Updates of the managed devices to a distinct version can be specified for FlexNet Manager Suite 2019
R1. This controls the upgrade immediately after each managed device switches over to the new system.
For full details, see Configure Updates to Inventory Agents. You may complete this configuration before
migrating over your first subnet; or you may change the authorized version at a convenient future time.

2. In the first (or next) subnet that you wish to migrate, install the server that is to act as the inventory
beacon for this subnet.

3. While logged in with administrator privileges to this future inventory beacon server, install FlexNet
Beacon:

a. Start a web browser, and access the URL server-name-or-IP-address/Suite/ (replacing the
placeholder with the URL to access your central application server).

b. In the Discovery & Inventory menu, under the Network group, select Beacons.

c. Click Deploy a beacon.

The Deploy a Beacon page appears. Ensure that the default Download a beacon section of the
page is open.

d. Click Download a beacon.
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e. Use the web browser dialog to save the installer to a convenient directory (such as C:\temp).

f. In Windows Explorer, navigate to the saved file on your inventory beacon, and double-click it to
run the installer.

g. Step through the installation wizard, using the summaries in the accordion section Beacon setup
or the more detailed online help available through the web interface to assist as necessary.

Important: If this inventory beacon will import inventory collected by ILMT, or collect data
from Oracle servers, follow the links provided in the wizard to ensure that the appropriate
drivers are installed on the inventory beacon. In addition, if this inventory beacon is to collect
inventory from an Office 365 connection, the following prerequisites must be satisfied (and
noting that the order of installation of prerequisite software may be significant):

• You have licensed the FlexNet Manager for Datacenters product (visible only on the central
application server)

• The inventory beacon that will collect inventory for Office 365 in the cloud has a 64-bit
operating system: Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later
(prerequisite software is not available for 32-bit architectures)

• Microsoft .NET Framework version 4.7.0 or later

Tip: If this is not already installed, the Skype for Business Online, Windows PowerShell
Module (below) automatically installs it. Installation of this .NET version requires that the
server is rebooted afterward.

• PowerShell 5.1 or later, with the PowerShell execution policy set to RemoteSigned

Tip: Run PowerShell with administrator rights to execute the following commands:
To check the currently-installed version of PowerShell:

$PSVersionTable.PSVersion

To set PowerShell execution policy:

Set-ExecutionPolicy RemoteSigned

• Microsoft Azure Active Directory Module for Windows PowerShell is installed (Office 365 uses
Azure Active Directory to manage user identities behind the scenes):

a. Install the 64-bit version of the Microsoft Online Services Sign-in Assistant (available
from https://go.microsoft.com/fwlink/p/?LinkId=286152).

b. Install the Microsoft Azure Active Directory Module for Windows PowerShell with these
steps:

a. Open an administrator-level PowerShell command prompt.

b. Run the Install-Module MSOnline command.

c. If prompted to install the NuGet provider, type Y and press ENTER.

d. If prompted that the installer is not signed, type Y and press ENTER.
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e. If prompted to install the module from PSGallery, type Y and press ENTER.

f. After installation, close the PowerShell command window.

• Microsoft Visual C++ 2017 Redistributable is installed on the inventory beacon

Tip: This may be automatically installed by the installation of the PowerShell module
above.

• Skype for Business Online, Windows PowerShell Module 64-bit version
(https://www.microsoft.com/en-us/download/details.aspx?id=39366)

• An active Internet connection with JavaScript enabled allowing connection to the Microsoft
Office 365 Portal at https://portal.office.com/admin/default.aspx.

4. Ensure that this subnet is recorded within FlexNet Manager Suite. You may:

• Import the sites and subnets (visible to this inventory beacon) from Active Directory (for details, open
the online help in the web interface and navigate to FlexNet Manager Suite Help > What Is an
Inventory Beacon? > Importing from Active Directory)

• Manually edit the list of sites and subnets available in the web interface for FlexNet Manager Suite
2019 R1 at Discovery & Inventory > Subnets (in the Network group).

Subnets must be recorded, and assigned to inventory beacons, before inventory beacons can target any
devices for migration.

5. Ensure that the subnet is assigned to your newly-installed inventory beacon:

a. In FlexNet Manager Suite, navigate to Discovery & Inventory > Unassigned Subnets.

b. From the list, select the subnet you are migrating now.

(You can also select multiple subnets, if you are migrating several at once.)

c. Click Assign to a beacon.

A new list opens above that button, showing available inventory beacons for your selection. To
help with logical groupings of subnets, each inventory beacon also displays subnets already
assigned to it. The status of each inventory beacon also displays on the right of the list, so that
you do not accidentally assign any subnets to a disabled inventory beacon.

d. Select one inventory beacon from the list, and click Save.

The list of inventory beacons closes, and the assigned subnet is removed from the list of
unassigned subnets.

The inventory beacon is now prepared to respond to all managed devices within its subnet that ask it for
a policy.

6. Identify the 9.2 distribution server that has been managing devices in this subnet, and identify the alias by
which that distribution server is identified in the relevant domain name server (DNS).

7. At the DNS, redirect the alias to point instead to the newly-established inventory beacon.

On their regular schedule, all managed devices request a policy update from the same download location
URL that they have always used. As this URL has now been redirected to the new inventory beacon,
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FlexNet Beacon (subject to migration mode being off) supplies each managed device with a revised policy
that switches it over to operate with FlexNet Manager Suite 2019 R1. If the current version of the FlexNet
inventory agent on each managed device is not as authorized (see Configure Updates to Inventory
Agents), the inventory beacon also supplies the appropriate upgrade (or downgrade) package, and the
FlexNet inventory agent self-updates to match requirements.

8. You may decommission the previous distribution server, and optionally repurpose it as an inventory
beacon in another subnet.

Because this method redirects the established URL to the new inventory beacon, it doesn't matter
whether managed devices have updated their policies before or after you remove the old distribution
server.

Repeat this process for each subnet in turn, until all subnets (with their managed devices) have been migrated.
Thereafter, skip forward to Migrating Citrix Inventory Collection (if you have been using the relevant adapter),
or to Finishing Off.

Configure Updates to Inventory Agents
Adjust the database settings that control automatic updates of deployed FlexNet inventory agents.

Note: Advanced inventory functionality often requires you to authorize the latest versions of FlexNet
inventory agent. For example:

• Collecting access evidence for calculating consumption of CALs requires the use of FlexNet inventory
agent for 2016 R1 (12.0.0) or later

• Improved application recognition for Tivoli Storage Manager™ version 7.x and IBM Spectrum Protect™
version 8.x and later require the use of FlexNet inventory agent for 2018 R1 (12.4.2) or later.

By default, an upgrade to your central application server(s) and inventory beacon(s) does not trigger any
automatic updates to the FlexNet inventory agents that you have deployed on target machines for local
inventory collection. In fact, the upgrade mechanism for FlexNet inventory agent is turned off after an
upgrade to the central application servers. This gives you freedom to manage the upgrade of deployed
FlexNet inventory agents independently of the upgrade to the central application server.

Tip: This procedure applies only to FlexNet inventory agents installed locally on inventory targets (either
through 'adoption' or third-party deployment) and collecting policy from an inventory beacon. Other
scenarios are handled differently:

• Copies of the FlexNet inventory core components installed on inventory beacons and used for zero-touch
inventory collection are updated as part of the FlexNet Beacon self-update.

• If you are using copies of the lightweight FlexNet Inventory Scanner, you need to update those copies
using the same techniques by which you deployed it in the first place.

• If you have used other techniques to deploy the FlexNet inventory core components to file shares or other
locations of your choosing (where they are not automatically collecting policy), you need to use your
preferred technique for deploying updated components.

The upgrade of deployed FlexNet inventory agents is controlled by settings stored in the central operations
databases. For that reason, this procedure takes place on your batch server/reconciliation server (or whichever
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server includes that functionality, such as your processing server, or application server in smaller
implementations).

Tip: The database setting grants permission (through policy) to the FlexNet inventory agents to perform
self-upgrades (or even downgrades) to the specified version. The setting, therefore, can only be put into
effect on those platforms where the FlexNet inventory agent includes self-update functionality, and where
new versions of the FlexNet inventory agent are included in the operations databases after the upgrade.
Currently, FlexNet inventory agents on Debian or Ubuntu Linux do not include self-update functionality. On
these platforms, you can do any of:

• Deploy new versions of FlexNet inventory agent manually

• Use your preferred third-party deployment tool to publish updates to FlexNet inventory agents

• Uninstall the old version(s) of FlexNet inventory agent, and once again target the devices for adoption
through FlexNet Manager Suite.

To authorize self-update of FlexNet inventory agent through policy:

1. Log in to your batch server using the installing user account (suggestion: fnms-admin).

Depending on the actions you want to take, the account requires either read or write access to the
database.

2. In a command window, navigate to installation-folder\DotNet\bin.

3. To review a list of the FlexNet inventory agent versions to which you may upgrade:

.\ConfigureSystem.exe list-agent-versions

Note: Managed Service Providers (MSPs) covering multiple tenants must use:

.\ConfigureSystem.exe list-agent-versions --tenantuid tenantIdentifier

This lists all versions of the FlexNet inventory agent that are stored in your database and available for
use as upgrades to your currently deployed agents. The list is typically updated at each release of
FlexNet Manager Suite. Versions are shown by their internal major-minor-update numbering (such as
12.0.0).

4. To identify which version of the FlexNet inventory agent you have currently authorized as the target
version for all upgrades:

.\ConfigureSystem.exe current-agent-upgrade

Note: Managed Service Providers (MSPs) covering multiple tenants must use:

.\ConfigureSystem.exe current-agent-upgrade --tenantuid tenantIdentifier

5. To authorize a new version of the FlexNet inventory agent as the target version for all upgrades:

.\ConfigureSystem.exe select-agent-upgrade --version versionString
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Note: Managed Service Providers (MSPs) covering multiple tenants must use (all on one line):

.\ConfigureSystem.exe select-agent-upgrade --version versionString

--tenantuid tenantIdentifier

Replace versionString with the same major-minor-update numbering as is displayed by the list-

agent-versions action. This value must be an exact match for one of the available versions listed by
list-agent-versions. If not, no action is taken. (Notice that there is no requirement for the new
version to be greater than versions previously installed: you can specify an earlier version from the
available list, which causes any later FlexNet inventory agents to downgrade to the specified earlier
version.)

Tip: The same version (number) of the FlexNet inventory agent is normally installed across all
platforms.

6. To halt all upgrades and downgrades of the FlexNet inventory agents currently deployed in your
enterprise:

.\ConfigureSystem.exe clear-agent-upgrades

Note: Managed Service Providers (MSPs) covering multiple tenants must use:

.\ConfigureSystem.exe clear-agent-upgrades --tenantuid tenantIdentifier

Tip: The result is the default state after the FlexNet Manager Suite application server(s) have been
upgraded.

When your new settings are saved to the central database, they are distributed to your inventory beacons at
the next update, along with the installer for the currently authorized target version of the FlexNet inventory
agent for each platform. The individual FlexNet inventory agents receive the setting and (if necessary) the
installer when they next check in (by default, once a day), and subsequently they self-update to the specified
version.

For more information about the actions available with this utility, use either of these commands:

.\ConfigureSystem.exe help

.\ConfigureSystem.exe help action-name

Managing Device Migration by Individual
Device
Before deploying inventory beacons, choose whether to use additional targeting of inventory devices as part of
your migration strategy.

In the Process Overview, you examined whether to control [parts of] your migration at the granularity of a
subnet, or at finer levels with control potentially extending down to an individual device.
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By far the simpler process is to control migration for each subnet, so that the complete set of managed devices
within an individual subnet switch over together to the new system. As you validate that all is well in this
subnet, you can move on to the next subnet. For more information about this approach, see Managing Device
Migration by Subnet.

The remainder of this topic introduces concepts important to exerting control down to the level of individual
devices.

Production mode accepts all who ask

When FlexNet Manager Suite 2019 R1 is in production (that is, when migration mode is turned off), any
inventory agent (installed on a device) that contacts an inventory beacon receives a response:

• If the device fits within any target specified in the web interface on the application server, it receives the
options defined for that target group (specifically, whether devices within the target group should be
'adopted' by having an inventory agent installed, and whether application usage should be tracked on
devices in the group).

• If the device is not covered by any target, it receives (in production mode) default options (those options are
not to install the agent, and not to track application usage). However, in receiving these default options, the
device also is notified of all known inventory beacons, and the common schedule for any future actions that
may be applied to it in future. From that time on, the inventory agent on these devices reports through the
inventory beacons to FlexNet Manager Suite 2019 R1, and has been migrated.

This last fact is critical for migration. Your existing estate includes many inventory agents that you have
updated and are now looking for a response from an inventory beacon (and, until they receive one, failing over
to the old hierarchy of distribution servers). In production mode, every one of those managed devices would
switch over to the inventory beacon hierarchy in 2019 R1 as soon as it contacted its first inventory beacon. This
may be the desired behavior at the end of a migration process, when you want to sweep up the last few
remaining devices; but early in the process, you may wish to target a pilot group, which requires that we
prevent the sociable behavior of giving every managed device the default response.

Migration mode rejects outsiders

To allow for controlled migration of inventory agents, there is a control in the beacon settings page of the web
interface that switches FlexNet Manager Suite from production mode to migration mode. In migration mode,
devices already identified in target groups within FlexNet Manager Suite still receive their options as always;
but the difference is that those devices not included in any target group receive a "not found" 404 response to
their request, and therefore fail over to their old hierarchy of distribution servers, staying within the 9.2 system.

Choose your timing

Therefore, your timing decision about switching over your managed devices is this:

• Since you have opted for a staged migration using test machines and pilot groups, exercising control
through different sized targets (if required, down to individual machines), ensure that the Migration mode:
Restrict inventory settings to targeted devices check box (Discovery & Inventory > Settings, located in
the Beacon settings group) remains set when you commence your migration.

• At what point are you satisfied that the process is reliable, so that you are happy for all remaining updated
devices to switch to the new system? When that time comes, clear the Migration mode: Restrict inventory
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settings to targeted devices check box.

Accepting the default option (for migration mode) gives you another safety net of staging or targeting your
switch over of managed devices from 9.2 to FlexNet Manager Suite 2019 R1:

1. You may, in Inventory Manager 9.2, have used selection of your old distribution servers to control which
managed devices received the update package that allowed migration (see Distribute Self-Upgrade and
Settings Packages).

2. Still in Inventory Manager, you may have used security policy targeting of the managed devices that were
to receive the same update package.

3. Now, even though large numbers of your managed devices stand ready to make the switch, only those
you specifically target in FlexNet Manager Suite 2019 R1 can do so.

Once you get past the pilot stage and are confident that migrated managed devices are functioning well in the
new system, you simply clear the Migration mode: Restrict inventory settings to targeted devices check
box. This switches your entire system (and all its inventory beacons) into production mode. At that point, any
managed devices that were prepared with the upgrade package but have not yet been targeted can freely and
automatically switch over to the new system.

More about targets

Notice that simply defining targets in FlexNet Manager Suite is the enabling step for the switch-over. If an
upgraded managed device is identified in a target, it can switch. It does not require a specific rule (actions plus
targets plus schedule) to be defined.

The definitions of targets are cumulative: that is, a device identified in any target group is able to make the
switch. For this reason, these upgrade notes suggest starting with a single target in the new system so that it is
simple to maintain control.

The use of targets is also independent of the roll-out of inventory beacons. That is, if you have no targets to
begin with, you may roll out as many inventory beacons as you like, and they will continue to reject managed
devices as long as the Migration mode: Restrict inventory settings to targeted devices check box remains
set.

Set Defaults and Migration Mode
Prepare your inventory settings for deployment of inventory beacons.

These settings are applied to all FlexNet inventory agents reporting to FlexNet Manager Suite through the
hierarchy of inventory beacons. You can fine tune your settings at any time; but right now, you can configure
some settings useful for your migration process.

To set default behavior and migration mode:

1. On a convenient computer, start a web browser and access the URL server-name-or-IP-

address/Suite/.

Tip: Consider doing this from your central batch server, and once you have completed these settings,
you can continue there to install the local inventory beacon on the same server.
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2. Navigate to Discovery & Inventory > Settings.

The Inventory Settings page displays.

3. Expand the File evidence section.

4. Select Do not collect file inventory for all options in the Include file evidence section.

During migration, you do not want your inventory agents undertaking time-consuming work before
reporting to their new inventory beacons. You may change this setting later for operational purposes as
required.

5. In the Agent inventory schedule section, use the controls available to set the schedule for all installed
inventory agents to collect inventory from their managed devices.

You can mimic the same schedule that applied to the majority of your devices under the 9.2 system.
Remember that this same schedule applies to all inventory agents reporting to FlexNet Manager Suite
through inventory beacons.

6. In the Beacon settings group, keep the default values for Interval for beacon updates (minutes) and
Beacon version approved for use. These control the self-updating behavior of the inventory beacons
(not the inventory agents that report to them), and you can adjust these later as required.

7. Still in the Beacon settings group, do one of the following based on your strategy for migrating
managed devices:

• (Recommended) To require specific targeting of managed devices within FlexNet Manager Suite 2019
R1 before those devices can automatically migrate, ensure that the Migration mode: Restrict
inventory settings to targeted devices check box remains selected.

• To allow any managed device that contacts an inventory beacon to immediately switch over to
FlexNet Manager Suite 2019 R1, clear the Migration mode: Restrict inventory settings to targeted
devices check box.

8. Click Save.

Your inventory settings are ready for delivery to any managed device that is accepted by an inventory
beacon.

Deploy Inventory Beacons
Inventory beacons are the data-gathering arms of your compliance system.
Ensure that you have reviewed your policy for migrating inventory agents before deploying any inventory
beacons (see Managing Device Migration by Individual Device), and set migration mode accordingly (see Set
Defaults and Migration Mode).

The process for installing and configuring inventory beacons starts from the web UI for FlexNet Manager
Suite.

Note: Any computer on which you will install an inventory beacon must have at least version 3.0 of
PowerShell installed. For more information, see Upgrade PowerShell on Inventory Beacons.

Important: When you are migrating from 9.2 or earlier, it is mandatory to install an inventory beacon on
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your central batch server (or, for combined servers in smaller implementations, your processing server, or
your application server). This inventory beacon allows you control of content migrated forward from 9.2,
whereas inventory beacons installed on separate servers cannot have similar privileges. This inventory
beacon must be a top-level beacon reporting directly to the neighboring inventory server, and optionally it
may also be the root of your inventory beacon hierarchy (or you may have many peer top-level beacons).
Notice further that the user account that will access this inventory beacon, because it is directly accessing
the batch server that had the central beacon installed, must be a member of the security group (suggested
as FNMS Administrators) that has database owner privileges (see Upgrade/Create Databases). Finally,
notice that its default settings, requiring Basic Authentication for devices to access it, mean that it cannot be
used for bootstrapping new FlexNet inventory agents on managed devices to the 2019 R1 system (because
until they receive their first policy, newly installed FlexNet inventory agents do not know any passwords for
Windows authentication on any inventory beacons that require it). You may either:

• Switch this inventory beacon on the batch server to accept anonymous authentication

• Use other inventory beacons for bootstrapping new managed devices.

Tip: After installation and configuration, the FlexNet Beacon Engine operates as a long-running service to
gather and upload data. During installation, this service is automatically configured to run under the local
SYSTEM account (the default and recommended configuration). If you have reason to manually configure
different credentials (perhaps to manage access through a proxy server), be aware that these manually-
configured credentials for running the service are reset to SYSTEM at each automatic update to an inventory
beacon. (This happens because these manually-configured credentials are unknown to any other elements
in your FlexNet Manager Suite infrastructure.) To manage this, you may take one of the following paths:

• Disable automatic upgrades of all inventory beacons (navigate to Discovery & Inventory > Settings >
Beacon settings, and for Beacon version approved for use, choose a fixed version number). This locks
all inventory beacons at that version, with no (further) automatic upgrades permitted.

• Allow most inventory beacons to automatically upgrade (at the same location, choose Always use the
latest version), but individually manage particular inventory beacons (navigate to Discovery &
Inventory > Beacons [in the Network group], click the edit icon for the target inventory beacon, and in
the General tab of its properties, choose Choose a specific version from the Upgrade mode drop-

down list. This individual setting overrides the setting made for all other inventory beacons.)

• Allow all inventory beacons to automatically upgrade, but manage a manual task after each upgrade to
restore any special accounts that you previously manually configured.

To install the FlexNet Beacon software on an inventory beacon:

1. Log in on the computer where the FlexNet Beacon is to be installed, and start a web browser there to
access the URL server-name-or-IP-address/Suite/.

2. In the Discovery & Inventory menu, under the Network group, select Beacons.

3. Click Deploy a beacon.

The Deploy a Beacon page appears. Ensure that the default Download a beacon section of the page is
open.

4. Click Download a beacon.
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Tip: This button is displayed only to members of the Administrator role.

5. Use the web browser dialog to save the installer to a convenient directory (such as C:\temp).

Tip: If you have not downloaded directly to your intended inventory beacon, you should now move
the downloaded installer to that intended device.

6. In Windows Explorer, navigate to the saved file on your inventory beacon, and double-click it to run the
installer.

7. Step through the installation wizard, using the summaries in the accordion section Beacon setup or the
more detailed online help available through the web interface to assist as necessary.

8. When the configuration of this inventory beacon is complete, log in to the next server where you would
like to install the FlexNet Beacon software, and repeat this process for each beacon.

9. If your sites and subnets are not already recorded in your database, you should either import them from
Active Directory, or enter them manually.

Subnets are visible in the web interface for FlexNet Manager Suite 2019 R1 at Discovery & Inventory >
Subnets (in the Network group). Subnets must be recorded, and assigned to inventory beacons, before
inventory beacons can target any devices for migration. For guidance about importing or entering sites
and subnets, open the online help in the web interface and navigate to FlexNet Manager Suite Help >
What Is an Inventory Beacon? > Importing from Active Directory.

10. In FlexNet Manager Suite, navigate to Discovery & Inventory > Unassigned Subnets.

11. Select one or more of the subnets in the list.

You may select subnets for either of two reasons:

• To disable them so that no managed devices in those subnets can be targeted. To do this, click
Ignore, and they disappear from the list. (Find them again later in the All Sites list.)

• To assign them to inventory beacons so that managed devices in those subnets can be targeted for
switching to the new system, and they can collect inventory directly into FlexNet Manager Suite. In
this case, continue.

12. Click Assign to a beacon.

A new list opens above that button, showing available inventory beacons for your selection. To help
with logical groupings of subnets, each inventory beacon also displays subnets already assigned to it.
The status of each inventory beacon also displays on the right of the list, so that you do not accidentally
assign any subnets to a disabled inventory beacon.

13. Select one inventory beacon from the list, and click Save.

The list of inventory beacons closes, and the assigned subnet is removed from the list of unassigned
subnets.

You are now ready to target managed devices to switch over to the new system.
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Create a Roll-out Target
Create a target group for piloting the switch-over of managed devices to the new system.

Refer back to your switch-over timing decision (see Managing Device Migration by Individual Device and Set
Defaults and Migration Mode):

• If you are currently targeting a pilot roll-out group, so that the Migration mode: Restrict inventory
settings to targeted devices check box is set (checked, ticked), continue from step 1 of this procedure to
identify the target machines to switch to the new system.

• If you are ready to sweep up remaining managed devices without further targeting, you can clear the
Migration mode: Restrict inventory settings to targeted devices check box, and skip down to step 8.
Your managed devices start switching over automatically shortly after that check box is cleared, and you
can start reviewing results as they obtain their updated policy.

Tip: For targeted switch-overs, remember that only targets (not complete rules) need to be defined in
FlexNet Manager Suite at this time, and that any device identified in any target that contacts an inventory
beacon will immediately switch to operations in the new 2019 R1 system. For a staged roll-out, then, it is
convenient to define only one target at first, so that you can assess the results before approving a wider
group.

To create a roll-out target:

1. In the web interface, navigate to Discovery & Inventory > Discovery and Inventory Rules (in the
Discovery group).

2. On the left, select the Targets tab.

3. On the right-hand side, click Create a target.

The page is replaced by the Create an Inventory Target page.

4. Give this target group a helpful Name (suggestion: Device Migration) and in the Description field,
record any notes helpful to other operators, or to yourself after the purpose of this group is forgotten
over time.

5. In Define machines to target, leave the first choice as Include, and from the Select target... drop-
down list, choose a targeting method.

Additional controls appear allowing you to provide details appropriate to your chosen method. For
example, the first time you might choose All machines with a name like... and then identify the
machine name of your first test computer. Later, when the initial test is successful, you can change this
target to define a whole subnet.

Tip: Using the + control at the end of your first definition, you can add additional lines to your
definition of this target. For example, you might have your first line target a subnet, and subsequent
lines Exclude specific servers by name within that subnet.

The other options on this page are not relevant to the purpose of switching over managed devices that
are already deployed (in this case, through Inventory Manager 9.2).
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6. Click Create (in the bottom right of the page).

Your new target is updated to your inventory beacons (by default, every 15 minutes or so).

7. If you have not already targeted your update packages to managed devices through Inventory Manager
9.2 (see Targeting the Inventory Agent Upgrades and Migration), do so now!

Three factors are now aligned:

• Inventory beacons are in place

• Targets in FlexNet Manager Suite identify your pilot machines for switching to the new system

• Existing managed devices (from 9.2) are upgraded with instructions to look for inventory beacons.

Now, the upgraded managed devices attempt to connect to an inventory beacon. Until the inventory
beacon is ready, they receive a 404 not found error, and revert to using the 9.2 hierarchy of distribution
servers (operating as normal in the old system). When the inventory beacon is ready but the individual
managed device is not listed in any target, that managed device also receives a 404 error and fails over.
Only managed devices matching the filters you established for this target group, contacting any
inventory beacon, collect your inventory settings (see Set Defaults and Migration Mode) and switch
permanently to reporting through inventory beacons to FlexNet Manager Suite 2019 R1.

8. To prevent inventory imported through FlexNet Manager Suite 2019 R1 being hidden by old inventory
still being imported from Inventory Manager 9.2, ensure that Inventory Manager is not the primary
inventory source:

a. In the System menu (gear-wheel icon in the top right corner), choose Data Inputs.

b. Select the Inventory Data tab.

The list of inventory connections displays. Most of these are imported from your previous 9.2
implementation. Only one of them is Primary, with all the others showing a Make primary
button.

c. If the connection to Inventory Manager 9.2 (default name: ManageSoft — Flexera) is currently
the primary connection, click the Make primary button for the FlexNet Manager Suite —

Flexera connection.

New inventory imported through the inventory beacons into 2019 R1 will now be displayed in
inventory results.

9. Wait.

Time passes while

• The inventory beacons collect your changed target specification

• Managed devices try to access the inventory beacons, and the pilot group members are now
accepted, receiving their new inventory settings

• On the schedule you configured, inventory agents collect inventory from their local machines, and
upload the results to an inventory beacon

• The inventory beacon, within ten minutes, uploads the results to a web handler on your inventory
server, which stores the results into the inventory database
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• The inventory import and reconciliation that happens by default at 2am daily collects from the
inventory database and imports into the compliance database as required for license calculations.

Some of these processes can be manually triggered; otherwise come back tomorrow, or worst case the
next day.

10. In the web interface, review the inventory results collected from your test device(s) (for example,
Discovery & Inventory > All Inventory (in the Inventory group)).

When satisfied, repeat this process to redefine the target group to include a new or wider range of
devices, and continue until satisfied that everything is working as expected. As machines successfully
switch over to the new system, you may also choose to move them out of the Device Migration target
and into a production target.

Tip: Moving devices is preferable to simply removing them from a target, since removal means that
when the managed device next accesses the inventory beacon to check its settings, it receives a 404 not
found response (it continues to report its inventory on the previously received settings). Once a
successful device is moved to a production target, you are 'finished' with the device, no longer needing
to remember to come back and tidy up later.

Note: If you are not satisfied with your test cases, you may revert these devices to use the old system.
In Inventory Manager 9.2, use remote execution on those devices to do a policy 'update' back to your
last applicable policy for 9.2. You do not need to roll back the FlexNet inventory agent as well, as the
2019 R1 FlexNet inventory agent is backward compatible with your 9.2 system. Switching between the
old and new systems is controlled by the policy applied to the managed device.

11. When you are satisfied with test results and no longer need fine-grained control, navigate to Discovery
& Inventory > Settings, and clear the Migration mode: Restrict inventory settings to targeted
devices check box.

Restricted targeting of managed devices in FlexNet Manager Suite is now turned off. All managed
devices that received the upgrade package quickly switch over to the new inventory beacon hierarchy,
and receive at least a default policy. You may remove the migration target from your list of targets. It is
best practice to ensure that all devices are covered by production target groups, so that you can control
the settings they receive.

Tip: FlexNet Manager Suite 2019 R1 records a list of inventory connections under the system menu (
in the top right corner of the web interface), Data Inputs, on the Inventory Data tab. If you

inspect this now, you see the inventory connection to your old Inventory Manager in the list. You
cannot modify the connection details within the web interface. In the new system, connection details
must be edited on the responsible inventory beacon (shown in brackets on the list). In the case of the
9.2 Inventory Manager connection, the responsible beacon is the one installed on your central batch
server.

12. Return to Inventory Manager 9.2, and monitor the declining traffic as managed devices switch over to
the new system. When you think a distribution server might be finished with (because all its managed
devices have switched over), visit the distribution server and disable uploads. Then in Inventory Manager,
monitor the Distribution Status (click the All link), and the count of Logs (and Delayed Logs) should
remain at zero. If not, it means that managed devices are still uploading content to this distribution
server — you can inspect the log on the distribution server to identify the managed device that has not
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switched over (validate against your plan whether this managed device is intended to migrate or to stay
with Inventory Manager 9.2). Once the count of logs stabilizes at 0, you can decommission the
distribution server, potentially re-purposing the machine as an inventory beacon somewhere in your new
system.

Migrating Citrix Inventory Collection
If your previous implementation collected inventory from XenApp or XenDesktop, it's likely that rework is
required.

If your previous 9.2 implementation was collecting inventory from Citrix XenApp and XenDesktop, the
inventory rules are not carried forward in your new FlexNet Manager Suite 2019 R1 implementation. Citrix has
largely reimplemented these products from version 7, and your new implementation supports version 7.5
(along with versions 6.0 and 6.5). To extend this support, a redesign of the adapters to import XenApp and
XenDesktop inventory has been necessary.

If you are preserving Inventory Manager 9.2 as an inventory source, any existing inventory import from XenApp
or XenDesktop to that system continues to operate. If you wish, you can use your adapter connecting with
Inventory Manager to import the results of those inventory collections to FlexNet Manager Suite 2019 R1.

However, if you wish to import inventory directly from XenApp or XenDesktop to FlexNet Manager Suite,
please follow the appropriate procedures from the following two sections:

• Update the XenApp Adapter

• Update the XenDesktop Adapter.

Update the XenApp Adapter
The updated XenApp adapter requires updates to the XenApp server agent, the staging database, and the
method of collecting Active Directory data.

To update the XenApp server agent:

1. Check the inventory beacon update is complete (see Update and Deploy Additional Inventory Beacons
and sub-sections).

2. Be sure that you have completed an import from Active Directory from all relevant domains.

For set-up details refer to FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.

3. If you did not already update your staging database for this adapter in your central database server (as
described in Upgrade/Create Databases):

a. Locate your downloaded archive Adapter Tools.zip (perhaps in C:\temp\FNMSUpgrade\), and
in your unzipped archive, navigate into the \Citrix XenApp Server Agent subdirectory.

b. Further navigate into the appropriate sub-folder for your version of XenApp:

• XenAppAgent6

• XenAppAgent65
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• XenAppAgent75

• XenAppAgent76

• XenAppAgent78

• XenAppAgent79

• XenAppAgent711

• XenAppAgent712.

c. From your chosen folder, collect a copy of the database creation/update script
SetupXenAppAgentStagingDatabase.sql.

d. Drop this SQL script on the database server hosting your staging database, and execute it in SQL
Server Administration Studio against your chosen database instance.

Tip: If you have more than one of these staging databases, repeat this process until they are all
updated.

4. Ensure that the appropriate inventory beacon(s) has/have a connection configured for the staging
database(s), and that the connection is scheduled for regular operation.

For details, check the Create Connections for Data Upload section of the XenApp Server Adapter chapter
in the FlexNet Manager Suite 2019 R1 Inventory Adapters and Connectors Reference PDF, available
through the title page of online help.

5. On each of your XenApp controlling servers where FNMPXenAppAgent.exe is installed, replace the
executable with the correct version from the unzipped archive.

For details, check the Installing the XenApp Server Agent section in the above-mentioned chapter.

6. As required, create or update a scheduled task to execute the upgraded XenApp server agent.

See the adjacent topic Create a Scheduled Task in the same chapter.

Tip: Pay particular attention to the schedule for the agent, and the schedule of the inventory beacon
import from the staging table. These two activities must not overlap.

The XenApp adapter is now ready for operation. On schedule, the agent populates the staging database; on
the later schedule, the staged data is collected by the inventory beacon and uploaded to the central server;
finally, when the next inventory import and compliance calculation is run, the XenApp applications and the
users who can access them are available, at least as installer evidence and file evidence, within FlexNet
Manager Suite. You may additionally need to link the evidence to applications, and to ensure these
applications are licensed. For more information, see the other online help topics under FlexNet Manager Suite
Help > Adapters Supplied by Default > XenApp Server Adapter.

Update the XenDesktop Adapter
The best practice configuration for the XenDesktop adapter is to allow direct network access from the
appropriate inventory beacon to the XenDesktop broker. (Where this is not permitted, you can copy the
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appropriate PowerShell script to the XenDesktop broker, execute it locally, and copy the generated .vdi and
.ndi files to the Incoming folder on the relevant inventory beacon.)

As this adapter relies on PowerShell scripts run from the inventory beacon and executing on the XenDesktop
broker, both these servers must allow at least RemoteSigned execution policy for PowerShell, as described
below.

If you are upgrading from an earlier version of the XenDesktop adapter, notice that you must run the Active
Directory import separately, and prior to exercising the adapter, as listed below. Failure to do this risks the
removal of previously-gathered inventory of VDI access to applications.

To update the XenDesktop adapter:

1. Check the inventory beacon update is complete (see Update and Deploy Additional Inventory Beacons
and sub-sections).

2. Be sure that you have completed an import from Active Directory from all relevant domains.

For set-up details refer to FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.

3. On each of the inventory beacon and the XenDesktop broker, check the execution policy for PowerShell
scripts:

a. On each machine in turn, open a PowerShell window.

b. At the prompt, enter Get-ExecutionPolicy.

Usable settings include RemoteSigned, AllSigned, or Unrestricted (although the latter is not
recommended).

c. If the current policy setting is Restricted, run the following command to set it to
RemoteSigned:

Set-ExecutionPolicy RemoteSigned

4. Create (or update) discovery and inventory gathering rules to target your XenDesktop brokers:

a. In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery
and Inventory Rules (in the Discovery group).

b. Select the Targets tab, click Create a target, and complete the details to target your XenDesktop
broker(s). Click Save to add your new target to the list of available targets. (If necessary, repeat to
create multiple targets.)

c. Select the Actions tab, click Create an action, and give your new action a useful name and
description.

d. Expand the XenDesktop environments heading in the accordion list, and select both Discover
XenDesktop environments and Also gather XenDesktop environment inventory. Then click
Create to record your new action.

e. Select the Rules tab, click Create a rule, and in the rule builder that appears, click the View

Actions... hyperlink.

f. For the rule you just created, click Add to rule builder, and in the rule builder, click the View
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Targets... hyperlink.

g. For the target(s) you defined, click Add to rule builder, and in the rule builder, click Schedule.

h. Complete the scheduling details, and click Save as.

i. Give your rule a meaningful name, and click Save.

Tip: After a little time (say, 30 minutes) to allow for the relevant inventory beacon to collected
its updated rules, you can inspect the rule on the applicable inventory beacon, in its Rules
page. (If it hasn't updated yet, click Update now.)

5. After the XenDesktop adapter runs (according to the schedule you just created), and after the
subsequent inventory import and compliance calculation, you can inspect the inventory from your
XenDesktop broker:

a. In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > All
Discovered Devices (in the Discovery group).

b. Locate your XenDesktop broker in the list of devices.

Tip: Adding the VDI broker column from the column chooser, and then filtering on Yes, may
help you locate this server.

c. Click the device's name to open its properties, select the Status tab, and expand the XenDesktop
environment inventory section of the accordion.

This is also the location where any PowerShell script errors from the inventory beacon are
reported. Should you need additional troubleshooting:

• Inspect the log file on the inventory beacon for errors relating to XenDesktop discovery. This
file is located at %PROGRAMDATA%\Flexera Software\Compliance\Logging\BeaconEngine.

• Should you need to prepare a trace file to submit to Flexera Support, turn on the
Scheduling/RemoteExecution tracing options by editing this file on your inventory beacon:

InstallationDirectory\Flexera Software\Inventory Beacon\etdp.trace

6. As required, you may need to link the file evidence imported from XenDesktop to application records,
and ensure that those application records are linked to license records. Wherever possible, link the
license records to purchase records to identify the number of your license entitlements.

Once all the links are in place, the next compliance calculation reflects your compliance position for
applications accessible through XenDesktop.

Critical: Perform a Full Import
Naturally, there are many changes to FlexNet Manager Suite since the 9.2 release. Unless you take the
precautionary step described here, some of these changes can produce potential problems in the handling of
inventory records, especially in environments where you gather inventory through multiple tools (for example,
through the FlexNet inventory agent and Microsoft SCCM, or any other combination of inventory tools).

When you have completed the migration, you should ensure that your first inventory import and compliance
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calculation includes a full inventory import, at least for the FlexNet inventory source, rather than the default
differential inventory import. Of course, the full import means that the first compliance calculation after your
migration takes longer than usual, but the investment is well worthwhile.

Tip: If you are using FlexNet Manager Suite as a replacement for ILMT in calculating subcapacity
consumption for IBM PVU licenses, this first full import and license reconciliation is also critical for creating
the baseline data and 'seeding' the automated processes that maintain special targets for the appropriate
inventory rules. For more details, see the chapter Sub-Capacity Licensing with IBM PVU in the FlexNet
Manager Suite 2019 R1 System Reference PDF, available through the title page of online help.

Take careful note of the following:

• The full import is triggered from your batch server (or, in smaller implementations, the server hosting that
functionality).

• You must be logged in as a user with administrator privileges on that server.

• The following command must be entered at the Windows Command Prompt (and specifically, this is not for
use within a PowerShell window).

• Identify the connection name used for your 9.2.3 Inventory Manager database (either the one that was
always separate, or the one that you split off in Upgrade/Create Databases). The default connection name is
FlexNet Manager Suite, and the Source Type is ManageSoft.

• Take careful note of the format of the command line shown below. The three dashes and the tripled double-
quotation marks are not typographical errors, and are required. However, the command line has been
broken over multiple lines for publication, and you should enter it all on one line.

• When all conditions are met, use the following command line (all on one line), replacing the placeholder
connectionName with the name you gave the connection to your FlexNet inventory database:

BatchProcessTaskConsole.exe

run InventoryImportReaders ---f

-it Readers

-s """connectionName"""

Depending on the size of your inventory database, this import may take some time. In this process, the data
from the 9.2.3 inventory is cleaned and updated, so that subsequent merging of records from multiple
inventory sources can function correctly.

Enhancement for Purchase Records
Enhanced functionality in the Unprocessed Purchases page (if you are upgrading from a release prior to 2016
R1) may require that you re-process some purchase records. The process is described below. These prior notes
provide background understanding of causes and impacts.

The enhancement is:

• In prior releases, a purchase (of an appropriate type) appeared in this Unprocessed Purchases listing only
when it was not linked to a license. The test did not take any account of quantities that were linked from the
purchase to one or more licenses — as long as there was at least one link between the purchase record and
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a license, the purchase was counted as 'processed'.

• From release 2016 R1, FlexNet Manager Suite better supports splitting purchases of relevant types
(including maintenance) across multiple licenses. As part of this improved functionality, it now examines
each purchase to compare the quantity purchased with the quantity assigned to one or more licenses. Any
time that the quantity assigned is less than the quantity purchased, the purchase is included in the
Unprocessed Purchases listing. This allows you to use this listing as a work center for purchase processing,
especially when you are splitting purchases across multiple licenses. The purchase is automatically removed
from the listing as you assign the last of its purchased quantity to a license.

Depending on your previous work practices, this enhancement may cause some purchases previously
processed to reappear in the Unprocessed Purchases listing after upgrade. This is more likely to occur for
purchases of type Software Maintenance, and will occur if your previous practice has been to manually set
the purchase quantity for a maintenance purchase to zero as you linked it to a license.*

In those cases where you had manually set the assignment from a maintenance purchase to a license to zero,
there is an ongoing mismatch between the quantity purchased and the quantity assigned to the relevant
license(s). After your upgrade, this mismatch correctly causes the purchase to appear in the enhanced
Unprocessed Purchases listing. (The same is true of any other cases of historical purchases where, for any
reason, the purchased quantity does not match the total assignments to licenses.) Since every purchase record
is checked for this listing (no matter how old), you may rely on it catching all historical cases where the
mismatch between purchased quantity and assigned quantity exists.

To identify and reprocess purchases if required:

1. In the web interface for FlexNet Manager Suite, navigate to Procurement > Unprocessed Purchases (in
the Purchases group).

The listing includes all historical purchases for which there is an Available quantity (which is the
difference between the purchased quantity and the total assigned to all linked licenses).

2. Select one or more rows from the listing.

3. Click Recalculate.

After a moment, unprocessed purchases may show updated values for Recommended licenses. In the
cases described above, the recommendation is most often to link (once again) to the same license(s) you
had previously linked to each purchase. Review all recommendations.

4. Select only those purchases with recommendations that you find acceptable, and click Accept.

Tip: The Accept button is enabled only when you select purchases with recommended licenses. You
cannot include any rows where the Recommended licenses column displays No recommendation
calculated,

FlexNet Manager Suite creates the appropriate links to the recommended licenses (including correcting
the link types of those purchases that had been incorrectly linked before, so that their maintenance had
been wrongly counted towards entitlements).

5. If there are remaining historical purchases that still require processing, select one at a time and click
Process.

A blue wizard area appears above the listing to assist with your processing choices. For details, click the
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online help button in the top right of the Unprocessed Purchases page.

6. Repeat as required until all the historical purchase records have been reprocessed.

The necessary reprocessing is completed, and entitlement counts and maintenance coverage correctly reflect
your input data.

Tip: For Software Maintenance purchases, be sure to record the effective date and the expiry date on
each maintenance purchase. This allows the system to automatically calculate coverage, alert you to
forthcoming renewals, and so on.

* One reason you may have used this approach is because of an early defect, since repaired, that incorrectly
counted maintenance purchases toward license entitlements. This error only occurred when:

• The purchase was manually linked to the license (it did not occur when purchase automation was used)

• The link was manually made from the purchase properties (it did not occur when the link was made from the
license end of the relationship).

(Historical purchase records affected by the old defect are visible in the Purchases tab of the license
properties, where you can examine the Purchase type and License entitlements columns. Any linked
purchase of type Software maintenance should have no value shown for License entitlements. Cases where
you had adjusted the assigned quantity manually are detected and repaired as described here; and any cases
where you did not notice this old error are now likely to be flagged in license listings with an alert that there is
a mismatch between the software entitlements and the maintenance coverage.)

Updating the ADDM Adapter
The ADDM adapter now offers increased support for BMC Atrium Discovery and Dependency Mapping.
Additional features introduced with ADDM release 11 require that, if you have previously been using this
adapter, you need to update the staging database used for data import.

Note: If you are continuing to use ADDM release 10 or earlier, you do not need to update the staging
database schema, and may skip this process. However, if you do apply this update to the staging database
schema and continue to use ADDM release 10 or earlier, be sure to also use the latest version of the
FnmpADDMStage.exe executable from the same Adapter Tools for FlexNet Manager Suite 2019 R1.zip
archive. This executable transfers to ADDM data (for any ADDM version) to the staging database, and is
schema-aware for the upgraded staging database.

The update is a straight-forward task, once you have the latest copy of the appropriate script.

To update the ADDM adapter:

1. Download the Adapter Tools for FlexNet Manager Suite 2019 R1.zip archive from the Flexera
Customer Community knowledge base:

a. Access https://flexeracommunity.force.com/customer/articles/en_US/INFO/Adapter-Tools-for-
FlexNet-Manager-Suite.
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Tip: Access requires your Customer Community user name and password. If you do not have
one, use the link on the login page to request one.

b. Click the link Adapter Tools for FlexNet Manager Suite.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet
Manager Suite 2019 R1.zip commences.

c. In your browser dialog, choose to save the file, and if the browser allows it, direct the saved file to
a convenient working location (such as C:\Temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy
it to the appropriate working location when the download is finished.

2. Right-click the downloaded zip archive, and choose Extract All....

3. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2019 R1.zip >
BMC Atrium Discovery and Dependency Mapping Tools > SQL.

4. If necessary, copy the script ADDM_staging.sql from the SQL\ folder of your unzipped adapter archive to
a temporary folder on your staging server.

5. Open a command prompt on the staging server.

6. In the command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\ADDM_staging.sql

where:

• The database ADDM_Staging is created with all necessary tables, indices, and so on.

• ServerName is the name of the database server hosting the staging database, or its IP address, or “.”

(dot) if you are running the staging script on the same server as the database instance

• InstanceName is the name of the instance to use for the database staging tables (this parameter may

be omitted if the instance is the default instance)

• TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S 192.100.0.20\Development -i C:\temp\ADDM_staging.sql

The schema of your staging database is updated. For more information about the latest ADDM adapter, see
the relevant chapter in the FlexNet Manager Suite 2019 R1 Inventory Adapters and Connectors Reference PDF
file, available through the title page of online help.

Finishing Off
Congratulations! You have achieved a lot.

• You separated previously co-located installations of two products, and split a shared database.
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• You upgraded your Inventory Manager implementation to 9.2.3 so that it can continue operations.

• You separated your existing managed devices into two groups:

◦ One group to continue on under Inventory Manager, because they needed customized settings or
schedules for their installed inventory agents

◦ A second group to migrate to management by FlexNet Manager Suite 2019 R1.

• You implemented FlexNet Manager Suite 2019 R1 in such a way that:

◦ All intended managed devices automatically switched over to the new system, and are immediately
reporting their inventory directly to the new inventory database within FlexNet Manager Suite

◦ Your continuing implementation of Inventory Manager 9.2 is already set up as an inventory feed into the
new system, in the same way that Microsoft SCCM or IBM's ILMT or other inventory tools can feed your
compliance calculations.

• Reports have been optimized in the new system, and you may find some in new locations. As well, the
system no longer uses Microsoft Reporting Services for factory-supplied reports, so that some of those
reports are no longer available. If you have custom reports you developed in Reporting Services, you may
need to redirect those to link to your new compliance (or if combined, operations) database.

If your plan is to continue parallel operations of FlexNet Manager Suite with Inventory Manager continuing as a
data source, your work is complete.

If (on the other hand) you wish to migrate all operations Inventory Manager 9.2 across to FlexNet Manager
Suite, some tasks remain to be completed manually, including these:

• Scheduled tasks you had established for Inventory Manager are not migrated into FlexNet Manager Suite
2019 R1. In the new system, you establish rules that combine actions, targets, and schedules. Navigate to
Discovery & Inventory > Discovery and Inventory Rules (in the Discovery group) and click Create a
rule.

• Of the many specialized remote execution tasks available in Inventory Manager 9.2, only three have
equivalent rules available in FlexNet Manager Suite 2019 R1 (and there is other rule-based functionality not
present in Inventory Manager). If you wish to transfer these three remote execution tasks from Inventory
Manager to FlexNet Manager Suite, you must manually set up the appropriate rules (on the same Discovery
and Inventory Rules page mentioned above) to suit your preferred use of these remote execution tasks:

◦ Generate Inventory

◦ Generate VMWare Infrastructure Inventory

◦ Generate Oracle Database Inventory.

• If you have a regular process of network discovery to ensure that any new devices are automatically brought
under management, and you want this to transfer to FlexNet Manager Suite, you need to set up matching
discovery rules (once again, on the same Discovery and Inventory Rules page).

• When you are no longer using Inventory Manager as a data source for FlexNet Manager Suite, you can
remove the connection. Do this (only) on the inventory beacon that is installed on the batch server (or server
hosting that functionality), opening the Inventory systems page and deleting the connection, by default
called ManageSoft. Be sure to do this ONLY when Inventory Manager is no longer required, and every
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inventory target has transferred and is actively managed through FlexNet Manager Suite. This is because
removing this connection will also remove from the database any inventory records still coming exclusively
from that source.

In addition to things that require manual effort, there are some other apparent 'gaps' that you may wonder
about, but which are as expected, and do not require manual effort:

• Historical raw Computer Inventories belong in Inventory Manager and are not transferred to the new
system. As managed devices switch over to 2019 R1, the Discovery & Inventory > All Inventory list (in the
Inventory group) is now populated from their current inventory reports, as expected.

• Discovered Devices (the list of devices found by Inventory Manager in previous discovery tasks) are all
migrated into FlexNet Manager Suite 2019 R1, with the exception of the following (these are consistent with
the normal behavior of 2019 R1):

◦ Virtual machines identified in ESX host inventory but which have not yet reported their own hardware and
software inventory

◦ Computers with a blank name

◦ Computers with a domain name that is blank, or equal to MANAGESOFT or WORKGROUP

◦ Computers that have a MAC address that is not unique across your computing estate

◦ Remote devices, mobile devices or VDI templates (these are placeholders created for attaching inventory
detected as use of virtualized applications and virtual desktops)

◦ Computers awaiting inventory (that is, records added as assets but not linked to an inventory record).

Your implementation of FlexNet Manager Suite 2019 R1 is now production ready.
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4
Notes on Issues

This chapter includes a few brief guidelines for dealing with common issues. If you discover additional issues not
described here, please contact Flexera Support for assistance.

For help on problems uploading inventory data, access the online help through the web interface for FlexNet
Manager Suite, and navigate to FlexNet Manager Suite Help > Inventory Beacons > Inventory Beacon
Reference > Troubleshooting: Inventory Not Uploading.

Password Maintenance
When a password on the service account expires, services cease to operate. At password refresh time, ensure
that the password is updated for all of the following.

Note: For accuracy, the changes are listed for distinct servers. In smaller implementations:

• If you have only a web application server and a processing server, then combine the lists for the batch
server and inventory server for use on your processing server

• In a single server implementation, combine all three lists on your application server.

The configuration scripts used during product installation cannot be re-run simply to update passwords. The
following passwords must all be maintained manually.

On the web application server
• The identity configured on the following IIS application pools:

◦ FlexNet Manager Platform

◦ ManageSoftWebServiceAppPool

◦ SAP Optimization

◦ SAPServiceAppPool
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On the batch server
• The identity configured on the IIS application pool: Flexera Beacon

• In Services:

◦ FlexNet Manager Suite Batch Process Scheduler

◦ FlexNet Manager Suite Batch Processor

• In the FlexNet Manager Platform folder for Microsoft Scheduled Tasks:

◦ Data warehouse export

◦ Export to ServiceNow

◦ FlexNet inventory data maintenance

◦ FNMP database support task

◦ Import Active Directory

◦ Import application usage logs

◦ Import discovery information

◦ Import installation logs

◦ Import inventories

◦ Import Inventory Beacon activity status

◦ Import Inventory Beacon status

◦ Import remote task status information

◦ Import security event information

◦ Import SAP inventories

◦ Import SAP package license

◦ Import SAP user and activity information

◦ Import system status information

◦ Import VDI access data

◦ Inventory import and license reconcile

◦ Recognition data import

◦ Regenerate Business Import config

◦ Send contract notifications.

On the inventory server

• The identity configured on the following IIS application pools:
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◦ Flexera Importers

◦ Flexera Package Repository

• In the FlexNet Manager Platform folder for Microsoft Scheduled Tasks:

◦ Import Active Directory

◦ Import application usage logs

◦ Import discovery information

◦ Import installation logs

◦ Import inventories

◦ Import Inventory Beacon activity status

◦ Import Inventory Beacon status

◦ Import remote task status information

◦ Import security event information

◦ Import system status information

◦ Import VDI access data.

On the Cognos server

The password on the IBM Cognos service also needs to be maintained.

On the inventory beacon
By default, the FlexNet Beacon Engine service and scheduled tasks run as the local SYSTEM account. If these
defaults have been modified:

• The following service in the Services (local) folder of Component Services (this may have been modified to
run as a service account with administrator privileges):

◦ FlexNet Beacon Engine.

Note: The following services are also present, but must be running as the local SYSTEM account:

◦ Flexera Inventory Manager installation agent

◦ Flexera Inventory Manager managed device vversionNumber

◦ Flexera Inventory Manager security service.

• In the FlexNet Inventory Beacon folder for Microsoft Scheduled Tasks (by default, these tasks run as the
local SYSTEM account, but you may have modified the installation to run these as a named user account in
order to manage proxy access):

◦ Upload Flexera logs and inventories

◦ Upload third party inventory data.
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Identifying IIS Application Pool Credential
Issues
A password change on (any of the) application server(s) may require an update of the IIS configuration.

Background

During installation of an on-premises implementation, PowerShell scripts run on the application server (or, in a
multi-server implementation, on each of the component servers in turn) ask you to provide credentials for the
application pools used within IIS for FlexNet Manager Suite. The scripts save these as part of the IIS
configuration.

Note: If, as recommended, you have used a service account (suggested: svc-flexnet) for this purpose, it is very
unusual to require a password change for such an account. If you used a normal user account, you require
this additional maintenance each time that the password on that account is changed.

If, at any time after installation, the password for this user account is updated, the IIS configuration is now out
of date, and IIS will refuse to run the application pools for FlexNet Manager Suite.

Tip: In this case, as well as IIS configuration, you may also need to update passwords on scheduled tasks and
on services. For a complete list, see Password Maintenance.

Diagnosis

First symptom: The web interface for FlexNet Manager Suite will not load, producing the following error:

HTTP Error 503 - Service unavailable

Investigation: If you examine the Microsoft IIS application pools, you will find that the application pool for
FlexNet Manager Platform is disabled after any attempt to run the web interface. An examination of the IIS log
file shows entries like the following:

server-name 5057  Warning Microsoft-Windows-WAS  System date time

Application pool FlexNet Manager Platform has been disabled. Windows Process

Activation

Service (WAS)did not create a worker process to serve the application pool because the

application pool identity is invalid.

server-name 5059  Error  Microsoft-Windows-WAS  System date time

Application pool FlexNet Manager Platform has been disabled. Windows Process

Activation

Service (WAS) encountered a failure when it started a worker process to serve the

application pool.

server-name 5021  Warning Microsoft-Windows-WAS  System date time

The identity of application pool FlexNet Manager Platform is invalid. The user name or

password that is specified for the identity may be incorrect, or the user may not have
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batch logon rights. If the identity is not corrected, the application pool will be

disabled when the application pool receives its first request.  If batch logon rights

are causing the problem, the identity in the IIS configuration store must be changed

after rights have been granted before Windows Process Activation Service (WAS) can

retry the logon. If the identity remains invalid after the first request for the

application pool is processed, the application pool will be disabled. The data field

contains the error number.

Repair

Update the credentials for the applications pool on each of your application servers, using the process in
Update Credentials in IIS Application Pools.

Update Credentials in IIS Application Pools
To update the password for the FlexNet Manager Suite application pools within Microsoft IIS, complete the
following process on each of your servers in turn:

Tip: Servers are here named in a series from most specific (in large scale implementations) to most general
(for small scale implementations). Use the first-listed server type that applies to you. For example, if the list
item says 'on the inventory server/processing server/application server', and you have a separate inventory
server, make the change there. If you do not have a separate inventory server, but you have scaled to a
separate processing server (that combines your inventory server and your batch server), make the change on
your processing server. For a single-server implementation, you make this change on your application
server.

To update credentials in IIS Application Pools:

1. Open IIS Manager (Start > Administrative Tools > Internet Information Service (IIS) Manager).

2. In the navigation area on the left, expand the SERVER-NAME (account-name) node, and select
Application Pools.

Any application pool accessed since the user account password was changed displays a status of
Stopped. On each server type, the relevant application pools are:

• Flexera Beacon on the batch server/processing server/application server

• Flexera Importers on the inventory server/processing server/application server

• Flexera Package Repository on the inventory server/processing server/application server

• FlexNet Manager Platform on the web application server/application server

• ManageSoftWebServiceAppPool on the web application server/application server

• SAP Optimization on the web application server/application server

• SAPServiceAppPool on the web application server/application server.

3. Select the appropriate application pool, and in the Actions list on the right, click Advanced Settings.
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The Advanced Settings dialog appears.

4. In the Process Model section, select Identity, and click the ellipsis button next to the account name.

5. Next to Custom Account, click Set.

The Set Credentials dialog appears.

6. Enter the full User name for the account and enter the updated password in the two required fields.

7. Click OK to close all the open dialogs and save the new settings.

8. With the appropriate application pool still selected, in the Actions list on the right, click Start.

IIS Roles/Services
Below are the Microsoft Internet Information Services (IIS) roles and services utilized by FlexNet Manager Suite.
In the event of misbehavior, it is often helpful to validate that all of the following are enabled on all your
central servers (depending on the scale of your implementation, the ones that you have implemented from the
application server, the web application server, the processing server, the batch server, and the inventory
server). The process for checking whether the services are enabled is summarized below the list.

• Web Server > Application Development > .NET Extensibility

• Web Server > Application Development > ASP.NET

• Web Server > Application Development > CGI

• Web Server > Application Development > ISAPI Extensions

• Web Server > Application Development > ISAPI Filters

• Web Server > Common HTTP Features > Default Document

• Web Server > Common HTTP Features > Directory Browsing

• Web Server > Common HTTP Features > HTTP Errors

• Web Server > Common HTTP Features > HTTP Redirection

• Web Server > Common HTTP Features > Static Content

• Web Server > Health and Diagnostics > HTTP Logging

• Web Server > Performance > Dynamic Content Compression

• Web Server > Performance > Static Content Compression

• Web Server > Security > Basic Authentication

• Web Server > Security > Request Filtering

• Web Server > Security > Windows Authentication
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To check available services in the Windows Server operating system:

1. Starting from the Windows start menu, navigate to Control Panel > Administrative Tools > Server
Manager.

2. In the navigation bar on the left, under the Server Manager node, select the Roles node.

3. Locate the Web Server (IIS) section, and within that, identify the Role Services section.

This section lists the status for each service. All of those in the list above should be both installed and
enabled on all your central servers.
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